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Safety

This chapter contains:

NOLICES AN SAOLY ..ot e e e e e 14
COMVENEIONS ...ttt ettt ettt e e e 15
BLECEIICAL SAFELY ...t 19
OPEratioNAl SAFELY ... e 21
MAINEENANCE SAFELY ... e e e 23
Environmental, Health and Safety Contact Information ............cooouiiiiiiiii e 24
PrOAUCE SYMIDOIS ...t 25

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements.
Attention to the following information ensures the continued safe operation of your Xerox printer.
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Safety

Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to ensure the
continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These include safety
agency evaluation and certification, and compliance with electromagnetic regulations and established
environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials
only.

{-:'-"' Note: Unauthorized alterations, which can include the addition of new functions or connection of external
devices, can affect the product certification. For more information, contact your Xerox representative.
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Safety

Conventions

{':'-". Note: A note identifies information that could help you.

Warning: A warning identifies something that could damage the product hardware or software.

A5, Caution: A caution indicates a potentially hazardous situation that could injure you.

Different types of statements include:

."'.-!h"'- CAUTION—POTENTIAL INJURY: Indicates a risk of injury.

i CAUTION—SHOCK HAZARD: Indicates a risk of electrical shock.

&% CAUTION—HOT SURFACE: Indicates a risk of burn if touched,

,ﬂ'i, CAUTION—TIPPING HAZARD: Indicates a crush hazard.

_,-'f'.,_ CAUTION—PINCH HAZARD: Indicates a risk of being caught between moving parts.

ﬁ CAUTION—MOVING PARTS: Indicates a risk of laceration or abrasion injuries from rotating parts.

PRODUCT STATEMENTS

ﬁ"-. CAUTION—POTENTIAL INJURY: To avoid the risk of fire or electrical shock, connect the power cord
to an appropriately rated and properly grounded electrical outlet that is near the product and easily
accessible.

."'.-!h"'- CAUTION—POTENTIAL INJURY: To avoid the risk of fire or electrical shock, use only the power cord
provided with this product or the authorized replacement from the manufacturer.

A1, CAUTION—POTENTIAL INJURY: Do not use this product with extension cords, multioutlet power

' strips, multioutlet extenders, or UPS devices. The power capacity of these types of accessories can be
easily overloaded by a laser printer and may result in a risk of fire, property damage, or poor printer
performance.

#1h CAUTION—POTENTIAL INJURY: Do not use this product with an inline surge protector. The use of a
surge protection device may result in a risk of fire, property damage, or poor printer performance.

rﬁl CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock, do not place or use this product
near water or wet locations.
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Safety

. CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock, do not set up this product or make

any electrical or cabling connections, such as the power cord, fax feature, or telephone, during a lightning
storm.

AT

CAUTION—POTENTIAL INJURY: Do not cut, twist, bind, crush, or place heavy objects on the power
cord. Do not subject the power cord to abrasion or stress. Do not pinch the power cord between objects
such as furniture and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect
the power cord regularly for signs of such problems. Remove the power cord from the electrical outlet
before inspecting it.

. CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock, make sure that all external

connections, such as Ethernet and telephone system connections, are properly installed in their marked
plug-in ports.

. CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock, if you are accessing the controller

board or installing optional hardware or memory devices sometime after setting up the printer, then turn
the printer off, and unplug the power cord from the electrical outlet before continuing. If you have any
other devices attached to the printer, then turn them off as well, and unplug any cables going into the
printer.

. CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the

printer, unplug the power cord from the electrical outlet and disconnect all cables from the printer before
proceeding.

i

CAUTION—POTENTIAL INJURY: If the printer weight is greater than 20 kg. (44 |b.), then it may
require two or more people to lift it safely.

16
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Safety

I_.-"!“'-._ CAUTION—POTENTIAL INJURY: When moving the printer, follow these guidelines to avoid personal
injury or printer damage:

Make sure that all doors and trays are closed.
Turn off the printer, and then unplug the power cord from the electrical outlet.
Disconnect all cords and cables from the printer.

If the printer has separate floor-standing optional trays or output options attached to it, then
disconnect them before moving the printer.

If the printer has a caster base, then carefully roll it to the new location. Use caution when passing
over thresholds and breaks in flooring.

If the printer does not have a caster base but is configured with optional trays or output options, then
remove the output options and lift the printer off the trays. Do not try to lift the printer and any
options at the same time.

Always use the handholds on the printer to lift it.
Any cart used to move the printer must have a surface able to support the full footprint of the printer.

Any cart used to move the hardware options must have a surface able to support the dimensions of
the options.

Keep the printer in an upright position.
Avoid severe jarring movements.
Make sure that your fingers are not under the printer when you set it down.

Make sure that there is adequate clearance around the printer.

|"£_.;._||i.- CAUTION—TIPPING HAZARD: Installing one or more options on your printer or MFP may require a
caster base, furniture, or other feature to prevent instability causing possible injury. For more information
on supported configurations, contact the place where you purchased the printer.

|"£_.;._||i.- CAUTION—TIPPING HAZARD: To reduce the risk of equipment instability, load each tray separately.
Keep all other trays closed until needed.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a
hot component, allow the surface to cool before touching it.

_-"i"-_ CAUTION—PINCH HAZARD: To avoid the risk of a pinch injury, use caution in areas marked with this
label. Pinch injuries may occur around moving parts, such as gears, doors, trays, and covers.

.".-!h"'- CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or
performance of procedures other than those specified in the User Guide can result in hazardous radiation
exposure.
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/15, CAUTION—POTENTIAL INJURY: The lithium battery in this product is not intended to be replaced.

' There is a danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or
incinerate a lithium battery. Discard used lithium batteries according to the manufacturer instructions and
local regulations.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.

Refer service or repairs, other than those described in the user documentation, to a service representative.

Ozone and Ventilation Information

Refer to Facts about ozone and Facts about ventilation at Health and Safety of Our Work Environment - Xerox.

SAVE THESE INSTRUCTIONS.
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Safety

Electrical Safety

GENERAL GUIDELINES

A1 Caution:

e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a
part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing optional
equipment and are instructed to do so. Power off the printer when performing these installations.
Disconnect the power cord when removing covers and guards for installing optional equipment. Except
for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

e The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e The printer is exposed to water.

e The printer emits smoke, or the surface is unusually hot.

e The printer emits unusual noise or odors.

e The printer causes a circuit breaker, fuse, or other safety device to activate.
If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

POWER CORD

Use the power cord supplied with your printer.

_.-'?'-._ Caution: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power plugs.

e Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is
connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.

e Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground
connection terminal.

o Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the
electrical specification of the printer with an electrician if necessary.

e Do not place the printer in an area where people can step on the power cord.
e Do not place objects on the power cord.

e Do not plug or unplug the power cord while the power switch is in the On position.
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e If the power cord becomes frayed or worn, replace it.
e To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

EMERGENCY POWER OFF

If any of the following conditions occur, power off the printer immediately and disconnect the power cord from the
electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

e The equipment emits unusual odors or makes unusual noises.

e The power cable is damaged or frayed.

e Awall panel circuit breaker, fuse, or other safety device has been tripped.
e Liquid is spilled into the printer.

e The printer is exposed to water.

e Any part of the printer is damaged.

BATTERY SAFETY

One or more circuit boards in this printer contain a lithium battery. Do not attempt to repair or replace the lithium
battery. If there is a problem with the battery, contact an authorized service representative to correct the problem.

A5, Caution: If the battery on a circuit board is installed incorrectly, there is a risk of explosion.

The lithium battery in this printer contains Perchlorate Material. For information about the special handling
procedures associated with Perchlorate Material, refer to https://dtsc.ca.gov/perchlorate/.
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency
examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

OPERATIONAL GUIDELINES

¢ Do not remove any trays when the printer is printing.

¢ Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

e Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

e Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the
protective covers.

e Do not override any electrical or mechanical interlock devices.

e Do not attempt to remove paper that is jammed deeply inside the printer. Switch off the printer promptly and
contact your local Xerox representative.

£1, Caution:

e The metallic surfaces in the fuser area are hot. Always use caution when removing paper jams from
this area and avoid touching any metallic surfaces.

e To avoid a tip hazard, do not push or move the device with all the paper trays extended.

PRINTER LOCATION

o Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the
weight for your printer configuration, refer to Physical Specifications section of the User Guide.

e Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to
prevent overheating of the printer.

e Place the printer in an area where there is adequate space for operation and servicing.

e When installing an office printer in a hallway or similar restricted area, additional space requirements can apply.
Ensure that you comply with all workspace safety regulations, building codes, and fire codes for your area.

e Place the printer in a dust-free area.

e Do not store or operate the printer in an extremely hot, cold, or humid environment.

e Do not place the printer near a heat source.

e Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

e Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.

e Do not place the printer in locations susceptible to vibrations.

Xerox® VersaLink® B620 Printer User Guide 21



Safety

e For optimum performance, use the printer at the elevations specified in the Environmental Specifications section
of the User Guide.

PRINTER SUPPLIES

e Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a
possible safety hazard.

e Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
e Store all consumables in accordance with the instructions given on the package or container.
e Keep all consumables away from the reach of children.

e Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

_.-"!“'-._ Caution: When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact
can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase
the risk of skin or eye contact.

Warning: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and
Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by
use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please
contact your Xerox representative for details.

CONSUMABLE INFORMATION

ﬁ"-. Caution: When handling cartridges such as ink/toner or fuser, avoid skin or eye contact. Eye contact can
cause irritation and inflammation. Do not attempt to disassemble the cartridge. This can increase the risk
of skin or eye contact.

e Store all consumables in accordance with the instructions given on the package or container.
e Keep all consumables away from the reach of children.
e Never throw dry ink/toner, print cartridges, or dry ink/toner containers into an open flame.

For information on Xerox® supplies recycling programs, go to www.xerox.com/recycling.
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Maintenance Safety

Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with
your printer.

o Clean with a dry lint-free cloth only.

e Use supplies and cleaning materials only as directed.

A1, Caution: Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on
electromechanical equipment.

e Do not remove the covers or guards that are fastened with screws. Customer service items are not located
behind these covers.

o Incase of a Dry Ink or Toner Spill, use a broom or a wet cloth to wipe off spilled dry ink/toner. Sweep slowly to
minimize generation of dust during clean up. Avoid using a vacuum. If a vacuum must be used, the unit should
be designed for combustible dusts, with an explosion rated motor and non-conductive hose.

.".-!h"'- Caution: The metallic surfaces in the fuser area are hot. Use caution when removing paper jams
from this area and avoid touching any metallic surfaces.

e Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling
programs, go to www.xerox.com/gwa.
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Environmental, Health and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact:
e United States and Canada, only: 1-800-ASK-XEROX (1-800-275-9376)

e Web address: Environmental Health & Sustainability - Xerox

e Email request (world-wide): EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.
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Product Symbols
SYMBOL DESCRIPTION

Caution:

Indicates a hazard that can result in serious injury or death if not avoided.

Hot Surface:

Hot surface on or in the printer. To avoid personal injury, use caution.

Warning:

Moving parts. To avoid personal injury, use caution.

> b b

[No symbol] Warning:

Indicates a mandatory action to take to avoid damage to the property.

Do not touch the part or area of the printer.

Do not touch this part of the printer.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the item.

Do not burn the toner cartridges.

Do not burn the drum cartridges.

@R B G
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SYMBOL DESCRIPTION

Do not burn the toner waste cartridge.

Pinch Hazard:

To avoid personal injury, use caution in this area.

Pinch Hazard:

To avoid personal injury, use caution in this area.

Do not remove the paper forcefully.

Hot Surface:

Before handling, wait for the time indicated.

On

Off

Standby

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not load or use inkjet paper.

Do not reload paper that is used or printed previously.

@Oe@®c o~

N
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SYMBOL DESCRIPTION

Do not use postcards.

Do not use envelopes.

Do not copy money.

*l-' Add paper or media.

=
0 Paper jam
8]
9 Lock
3 Unlock
mJ Paper clip
ﬂ Cooling
. ID Elapsed time
.

Supply paper

1-Sided original document

Hole-punched paper
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SYMBOL DESCRIPTION

Load letterhead face up.

Load letterhead face down.

Load labels face down.

USB:

Universal Serial Bus

LAN:

Local Area Network

Telephone Line

Weight

Services Home button

This item can be recycled.

P& e ']
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Parts of the Printer

FRONT VIEW
2
1

3
1
5

1. Control Panel or User Interface 4. Bypass Tray, 100-sheets

2. Standard Output Tray 5. Tray 1, Standard 550-sheet Tray

3. Door A, Front Door
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INTERNAL PARTS

1. Door A, Front Door 4. Door C, Back Door

2. Toner Cartridge 5. Fuser Assembly
3. Imaging Unit
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REAR VIEW

1. Door C, Back Door 4, Ethernet Port
2. Main Power Outlet 5. USB Port, Type A
3. USB Port, Type B
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Getting Started

The control panel consists of a touch screen and buttons that you press to control the functions that are available
on the printer. The control panel has the following functions:

Displays the current operating status of the printer.

Provides access to print and other features.

Provides access to reference materials.

Provides access to the Tools and Setup menus.

Prompts you to load paper, replace supplies, and clear paper jams.

Displays errors and warnings.

Provides the Power/Wake button that is used to power on or off the printer. This button supports the power-
saver modes, and the button indicator pulses to indicate the power status of the printer.

1

ITEM NAME

1

Log In Button

2 3

8

DESCRIPTION

Touching the Log In button on the control panel touch screen allows
you to log in and identify yourself to the printer. To access printer
features, log in with your user credentials. If you do not know your
user name or password, contact your system administrator.

Language Button

Touching the Language button allows you to set the language that
appears on the control panel touch screen.

{_-:.'-“' Note: Sometimes this option is hidden from view. For details,
see the System Administrator Guide at www.xerox.com/
office/VLB620docs.
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ITEM
3

NAME

Reset

DESCRIPTION

Use the Reset button to reset all the apps to the default settings.

4

Power/Wake Button

This button serves several power-related functions:

e When the printer is powered off, pressing this button powers on
the printer.

e When the printer is powered on, pressing this button displays a
menu on the control panel. From this menu, you can choose to
enter Sleep Mode, restart the printer, or power off the printer.

e When the printer is powered on, but in Sleep Mode, pressing this
button wakes the printer.

The button indicator pulses to indicate the power status of the
printer:

e When the light pulses slowly, the printer is in Sleep Mode.

e When the light pulses rapidly, the printer is powering off or
waking up.

Home Button

This button provides access to the Home menu for access to printer
features, such as print and other Xerox applications.

NFC Area

Near Field Communication (NFC) is a technology that enables
devices to communicate when they are within the network range of
each other. Use the NFC area to obtain a network interface, to add
the printer to your mobile device, or to establish a TCP/IP connection
between your device and the printer.

Status Indicator

This light pulses blue or amber to indicate the printer status.
Blue:

e Pulses blue once for access-card authentication when there is a
delay in response from a remote server.

{_-:ﬂ' Note: Some card readers are not compatible with this
feature.

e Pulses blue twice slowly to indicate that a job has completed.
e Pulses blue rapidly while the printer is powering on, or to signal
detection of an Identify Printer function from AirPrint, when

applicable.

Amber:

Pulses amber to indicate an error condition or warning that requires
your attention or the attention of your system administrator. For
example, this color can indicate an out-of-toner condition, a paper
jam, or that the printer is out of paper for the current job.

Touch Screen Display

The screen displays information and provides access to printer
functions and apps, such as print and other Xerox applications.

34
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ADDITIONAL CONFIGURATIONS AND OPTIONS

1. Standard Trays 2, 3, and 4, Optional 550-sheet 4. Optional High Capacity Feeder, 2100 sheets

Trays 5. Caster Base

2. Wireless Network Adapter with Bluetooth and
Type A USB Port

6. Printer Stand

3. Productivity Kit (500+ GB Hard Disk Drive)

M Important: If your printer has a Wireless Network Adapter, that requires installation in the front USB port,
and you have a USB Card Reader, do not install the Card Reader into the USB port of the Wireless Network
Adapter. Use the rear USB port for the Card Reader. For more information, refer to the installation
instructions provided with the Wireless Network Adapter and Card Reader Optional Kits for your printer.
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PAPER TRAY OPTIONS

The paper trays that are available with the printer are:
e Standard 550-sheet Tray

e Bypass Tray

e Optional 550-sheet Trays

e Optional High Capacity Feeder

Configuring Dedicated Paper Trays

The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper tray is set to
Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type, and color.

Depending on the configuration, your printer can have up to three optional 550-sheet standard paper trays or two
optional 550-sheet standard trays with a High-capacity Feeder tray.

e The High-capacity tray is configured as Fully Adjustable tray.
e The High-capacity tray is designed to hold larger amounts of paper for fewer printing interruptions.

¥ Note: To configure tray settings, refer to the System Administrator Guide at www.xerox.com/office/

VLB620docs.

Paper Size Confirmation

The system administrator can configure the device response that appears on the control panel touch screen when
paper of the same size is loaded in a tray. For standard adjustable paper trays, select an option:

e Always Show: This option shows the paper confirmation prompt on the control panel touch screen until the
user dismisses it.

e Delayed Confirmation: This option shows the paper confirmation prompt for a specified time. At the end of
the specified time, the prompt closes, which confirms the paper that is loaded. While the prompt appears on the
control panel touch screen, you can confirm any change to the paper type, color, and size.

e Auto Confirmation: This option confirms the paper type, color, and size automatically without showing a
confirmation prompt on the control panel touch screen.

{-:'-"' Note: Xerox® does not recommend using the Auto Confirmation option unless you always load the tray
with paper of the exact same type, color, and size. To configure the Automatic Tray Confirmation Prompt,
refer to Required Paper Policies in the System Administrator Guide at www.xerox.com/office/VLB620docs.
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Power Options

POWER SAVER

To reduce standby power consumption, you can use Sleep Timeout to set the time that the printer spends idle in
Ready mode before the printer transitions to Sleep Mode.

POWERING ON THE PRINTER OR EXITING SLEEP MODE

The printer has one power switch. The power switch is the Power/Wake button on the control panel. The Power/
Wake button controls power to the printer electronic components, and when powering off, it initiates a software-
controlled shutdown procedure. The preferred method to power on and off the printer is to use the Power/Wake
button.

e To power on the printer, on the control panel, press the Power/Wake button.

g

o
l-__w"?w:i‘_"i----l__.a fﬁ

e To enter or exit Sleep mode, press the Power/Wake button.
2 Note:
e When the printer receives data from a network connected device, the printer exits Sleep Mode
automatically.

e When the printer receives data from a network print job, to reduce power consumption, only necessary
electronic components exit Sleep mode automatically. The control panel does not exit Sleep Mode.

e When the printer is in Sleep Mode, the touch screen is powered off and unresponsive. To wake the printer
manually, press the Power/Wake button.

e If Auto Power Off is enabled, the printer powers off automatically after the specified conditions are met.
To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/office/VLB620docs.

Warning: The main power outlet is at the rear side of the printer. Do not plug or unplug the power cord
while the printer is powered on.
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RESTARTING, PLACING IN SLEEP MODE, OR POWERING OFF THE PRINTER

To restart the printer, place the printer in Sleep Mode, or power off the printer:

1. At the printer control panel, press the Power/Wake button.

g

i
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2. Select an option:
e To restart the printer, touch Restart.

e To place the printer in Sleep Mode, touch Sleep.

In Sleep Mode, the touch screen goes dark and the Power/Wake button pulses.

e To power off the printer, touch Power Off. A P1lease Wait message appears as the printer powers off.

{;ﬁ' Note: It is not recommended but if required, to power off the printer immediately, press and hold the

Power/Wake button for 5 seconds.

3. If you want to power off the printer for an extended period, disconnect the printer from the main power outlet.

Warning: Do not unplug the power cord while the printer powers down.

38
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Accessing the Printer

AUTHENTICATION

Authentication is the process of confirming your identity. When the system administrator enables authentication,
the printer compares the information that you provide to another source of information, such as an LDAP directory.
The information can be a user name and password, or the information stored on a magnetic, proximity, radio
frequency identification (RFID), or smart card. If the information is valid, you are considered an authenticated user.

There are several ways to authenticate a user:

e User Name/Password - Validate on the Device: This option enables local authentication. Users prove their
identity by typing a user name and password at the control panel or in the Embedded Web Server. The printer
compares the user credentials to the information stored in the user database. If there are a limited number of
users, or you do not have access to an authentication server, use this authentication method.

e User Name/Password - Validate on the Network: This option enables network authentication. Users prove
their identity by typing a user name and password at the control panel or in the Embedded Web Server. The
printer compares the user credentials to the information stored on an authentication server.

o Convenience Authentication: If this option is enabled, a card with a magnetic strip or RFID is used. A
convenience authentication card is different from a smart card, which uses an embedded chip and typically
requires a login and password. If the optional integrated RFID reader is installed, for authentication, users place
a pre-programmed card over the RFID reader at the control panel.

o Xerox Workplace Cloud: This option enables cloud-based authentication. The printer connects directly to the
Xerox® Workplace Cloud solution. This method provides multiple options for authentication. To prove their
identity, users can use mobile authentication methods such as NFC or QR Codes, use an identification card, or
type a user name and password.

e Xerox Secure Access - Unified ID System: This option enables authentication for the Xerox Secure Access
Unified ID System. Users present a pre-programmed identification card to a card reader at the control panel.
The printer compares the user credentials to the information stored on the Xerox® Secure Access server.

o Identity Provider (IdP) - Validate on Cloud: This option enables cloud-based authentication through an
identity provider (IdP). The device establishes a secure connection with the IdP, then passes the user credentials
to the IdP for authentication.

e Smart Cards: This option enables authentication for a smart card reader. Users insert a pre-programmed
identification card in a card reader at the control panel.

o Custom Authentication: To use this authentication method, a feature installation key is required. After
entering the feature installation key, the customized authentication methods provided by Xerox are available for
configuration.

{-:'-"' Note: The system administrator can allow you to type your user name and password when Convenience
Authentication or Smart Cards is set as the primary authentication method. If the administrator configures
an alternative authentication method, and you misplace your card, you can still access the printer.

For information about configuring Authentication settings, refer to the System Administrator Guide at www.xerox.
com/office/VLB620docs.
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AUTHORIZATION

Authorization is the function of specifying the features that users are allowed to access, and the process of
approving or disapproving access. You can configure the printer to allow users to access the printer, but restrict
access to certain features, tools, and apps. For example, you can allow users to access printing but restrict access to
other Xerox apps. You can also control access to features at specific times of the day. For example, you can restrict a
group of users from printing during peak business hours.

There are two types of authorization:
e Local Authorization verifies user information on the printer to approve access.

e Network Authorization verifies user information stored externally in a network database, such as an LDAP
directory, to approve access.

For information about configuring Authorization settings, refer to the System Administrator Guide at www.xerox.
com/office/VLB620docs.

PERSONALIZATION

Personalization is the process of customizing and configuring the device information and settings for a logged-in
user.

Personalization allows logged-in users to create a personalized user experience at the local user interface.
Personalization for logged-in users is enabled by default.

Personalization allows a logged-in user to configure the following settings:

e Personalized walk-up screen: When a user logs in, the device launches their preferred app instead of the default
walk-up screen.

e Personalized home screen: A user can select their preferred apps to display in a preferred order on the home
screen.

e Personalized Adaptive Learning suggestions: Adaptive Learning personalization offers workflow-automation
suggestions to help logged-in users streamline their workflow. Personalized app workflow suggestions include
Language preference settings.

For a logged-in user, all personalized settings override the device defaults.

{-:'-"' Note: The options available are defined by the administrator. For example, if the administrator has chosen
to limit permissions for the use of an app, the individual user cannot override those permissions.

For more information about all the Personalization options, see Personalize.

{-:'-"' Note: To allow the logged-in user to personalize their local user interface experience, the System
Administrator is required to configure the device personalization policy. For information on configuring the
device policy to enable user personalization, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs.

ACCOUNTING

Accounting is used to track and record the numbers of Print jobs that the device produces for each user. The system
administrator is required to create user accounts and enable the accounting feature. After Accounting is enabled,
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provide Accounting IDs at the printer to access restricted apps. If Authentication is enabled, you are required to log
in first. Before you print documents from a computer, provide your account details in the print driver.

The system administrator can set limits to restrict the total number of jobs by type that a user can send to the
printer. The administrator can generate reports that list usage data for individual users and groups.

For details, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

LOGGING IN

Logging in is the process by which you identify yourself to the printer for authentication. If authentication is set, to
access printer features, you log in with your user credentials.

Logging In at the Control Panel
# Note:
e Before logging in for the first time at the Xerox device control panel, log in to the Embedded Web Server,
then update your password. For details, refer to Logging In Using the Embedded Web Server.
o If you do not know your user name or password, contact your system administrator.
1. At the printer control panel, press the Home button.
Touch Log In.

For User Name, use the keypad and enter your name, then touch Next.

& W N

If prompted, enter the password, then touch Done.

{-:'-"' Note: To access each app that is password-protected, repeat steps 3 and 4.
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Apps, Features, and Functions

INTRODUCTION TO APPS

Xerox Apps are a gateway to the features and functions of your device. Standard Apps are installed already on the
device and appear on the Home screen. Some Apps are installed as standard, but are hidden the first time you use
the device.

When you log in, the Apps configured for your personal account appear on the control panel.

You can download more Apps for your device from the Xerox® App Gallery. For more information, refer to Xerox®
App Gallery.

ADAPTIVE LEARNING

Adaptive Learning offers workflow-automation and suggestions to help users to streamline their workflows. When
Adaptive Learning is enabled, you can set the device defaults automatically:

Automatically Set Device Defaults: This feature is enabled by the administrator and provides customization of
default settings based on device usage by walk-up users. Options include the default walk-up screen. After this
feature is enabled, the device gathers usage data, then changes the default settings automatically to streamline
tasks.

For more information, refer to Personalize.
{':'-"' Note: The Adaptive Learning personalization feature is available to logged-in users only.

For detailed instructions on how to configure Adaptive Learning, refer to the System Administrator Guide at www.
xerox.com/office/VLB620docs.
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Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and font
information, getting started pages, and more.

The following Information Pages are available:

NAME DESCRIPTION

Basic Configuration Report The Basic Configuration Report provides printer
information, including the serial number, installed
options, network settings, port setup, tray information,
and more.

Detailed Configuration Report The Detailed Configuration Report provides
information about all of the printer settings, including
extensible services setup, security and authentication
server configuration, connectivity settings, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

PRINTING INFORMATION PAGES

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. To print an information page, touch the needed page, then touch Print.
The printer prints the selected information page.

4. To return to the Home screen, press the Home button.
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CONFIGURATION REPORTS

There are two configuration reports available, a Basic Configuration Report, and a Detailed Configuration
Report. The configuration reports provide product information, including installed options, network settings, port
setup, tray information, and more.

Printing a Configuration Report

1.
2.
3.

44

At the printer control panel, press the Home button.

Touch Device > Information Pages.

Touch Basic Configuration Report or Detailed Configuration Report, then touch Print.

The printer prints the chosen configuration report.

To return to the Home screen, press the Home button.
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The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:
e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

FINDING THE IP ADDRESS OF YOUR PRINTER

You need the IP address of your printer to do the following:

o Toinstall the print driver for a network-connected printer.

e To access the settings of your printer through the Embedded Web Server.

You can view the IP address of your printer on the control panel or on a configuration report.

{-:'-"' Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2 minutes. If
the TCP/IP address is 0.0.0.0, or begins with 169, it indicates that there is a network connectivity issue.

Viewing the IP Printer Address on the Control Panel
To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.

The IP address appears in the Network section of the About screen for Wired IPv4 Address or Wired IPv6
Address.

3. Record the IP address from the display.

4, To return to the Home screen, press the Home button.

Obtaining the Printer IP Address from a Configuration Report

To obtain the printer IP address from a configuration report:

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. Touch Basic Configuration Report or Detailed Configuration Report, then touch Print.

The printer prints the chosen configuration report. The IP address appears in the Common User Data section of
the configuration report.

4. To return to the Home screen, press the Home button.
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ACCESSING THE EMBEDDED WEB SERVER

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or
Return.

To use the Embedded Web Server, click the page required:

» Home: This page provides a description of the printer and current notifications, the status of the paper trays,
and supplies and billing information. There is a Quick Links area at the bottom of the page that provides direct
access to key functions and pages.

e Jobs: The Jobs page enables you to manage active jobs on the printer, view, print, and delete saved jobs, and
create and manage saved job folders.

e Print: This page enables you to submit print-ready files to the printer for printing. You can select options for
print jobs using this page. Only print-ready files can be submitted, for example PDF, PS, PCL, JPG, TXT, PRN, and
TIFF file formats.

e Properties: You can use the Properties tab to access and configure settings for your device. System
administrator login credentials are required to change most settings.

e Support: This page provides access to general support information and telephone numbers. You can use the
Support page to access the Remote Control Panel and send diagnostic information to Xerox.

The Embedded Web Server has a Help option that provides information about all available device features and
functions. To access Help, click the Help link displayed at the bottom of each page. Navigate to the topic required,
or use the Search function to find specific information.

For detailed instructions on how to use the Embedded Web Server to configure printer settings, refer to the System
Administrator Guide at www.xerox.com/office/VLB620docs.

LOGGING IN USING THE EMBEDDED WEB SERVER

To access certain features, tools, and apps, log in to the Embedded Web Server for your device.

{-:'-"' Note: Access to some restricted functions requires administrator rights. For more information, refer to the
System Administrator Guide at www.xerox.com/office/VLB620docs.

To log in to the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe top right area of the page, click Login.

3. Enter your User ID and password, then click Login.

4. If you are logging in for the first time, set up a password.
a. Type the old password.

b. Type anew password. To verify the password, retype it.

{-:'-"' Note: The new password must adhere to all minimum password requirements. For details, contact your
system administrator, or refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

c. Click Save. The new password is stored.
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CERTIFICATES FOR THE EMBEDDED WEB SERVER

Your device includes an HTTPS certificate. The device generates the certificate automatically during device
installation. The HTTPS certificate is used to encrypt communications between your computer and the Xerox device.

1

{-:'.

Note:

e The Embedded Web Server page for your Xerox device can display an error message that the security
certificate is not trusted. This configuration does not lessen the security of the communications between
your computer and the Xerox device.

e To eliminate the connection warning in your Web browser, you can replace the certificate with a signed
certificate from a Certificate Authority. For information on obtaining a certificate from a Certificate
Authority, contact your Internet Service Provider.

e To eliminate the connection warning in your Web browser, you can download the Xerox Root CA
certificate from the device Embedded Web Server, then install the certificate on your client.

For information on obtaining, installing, and enabling certificates, refer to the System Administrator Guide at www.
xerox.com/office/VLB620docs.

DOWNLOADING THE CONFIGURATION REPORT FROM THE EMBEDDED WEB SERVER

From the Embedded Web Server, you can download and save a copy of the Configuration Report to your computer
hard drive. Use configuration reports from multiple devices to compare software versions, configurations, and
compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

{'f-". Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. To download the Configuration Report, scroll to the bottom of the page. In the Quick Links section, click
Download Configuration Page.

{-:'-"' Note: If the Download Configuration Page option does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your computer hard
drive. To open the Configuration Report, use an XML viewer.

USING THE REMOTE CONTROL PANEL FEATURE

The Remote Control Panel feature in the Embedded Web Server allows you to access the printer control panel
remotely from a Web browser.

{-:'-"' Note: To access the Remote Control Panel, first enable the feature. For details, contact your system
administrator or refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

To access the Remote Control Panel feature:
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1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

{'f-". Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Inthe Quick Links areaq, click Remote Control Panel.
{':'-"' Note: If the Remote Control Panel option is not displayed or fails to load, contact your system administrator.

3. To restrict other users from accessing the device control panel when you are connected remotely to the device,
click Block device control panel (local user can only observe).

{-:'-"' Note: If a local user attempts to access the control panel while the device control panel is locked, the control
panel does not respond. A message appears on the control panel, confirming that the control panel is locked
and the device is being controlled remotely.

4. To enable remote access to the device control panel, click Start Remote Session. The remote control panel
sends a request to the local control panel.

e If the local control panel is inactive, the remote control panel session is activated automatically.

e Ifalocal user is active on the device, a Remote Session Request message appears on the local control
panel. The local user chooses to accept or deny the request. If the request is accepted, the remote control
panel session is activated. If the request is denied, a Request Denied message appears in the
Embedded Web Server.

{'1'-". Note: If the system administrator requests a remote session, if the request is denied, an option to override
the local session is displayed.

DOWNLOADING THE PRINT DRIVERS FROM THE EMBEDDED WEB SERVER

You can download the Print Drivers for your device from the Embedded Web Server.

1. In your computer Web browser, open the Embedded Web Server by typing the IP address of the printer.
2. Click Support > General.

3. To download the Print Drivers, at Assistance Links, click Install Print Drivers.

The Smart Start installer file is downloaded to your computer.

USING XEROX® WORKPLACE CLOUD TO MANAGE YOUR DEVICE

Xerox® Workplace Cloud is a cloud-based print solution that can remotely manage many aspects of your device.
Xerox® Workplace Cloud provides authentication, print management, cost control, and mobility workflows.

Features such as Pull Printing allow you to submit your jobs to a secure single queue from any computer or mobile
device. After you have authenticated with the networked device of your choice, you can view, modify, print, or
delete your job as needed.

Flexible authentication options enable you to release your pull print jobs securely, and access your printer apps.
Single Sign-on (SSO) authentication is provided allowing you to access all of your SSO-enabled apps without having
to perform any additional login steps.

Xerox® Workplace Cloud is easy to set up and use, and because it is hosted in the cloud, Xerox manage all updates
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and patches.

For more information about enabling Xerox® Workplace Cloud for your device, contact your system administrator or
refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

Xerox® VersaLink® B620 Printer User Guide 49


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB620&PgName=Man

Getting Started

Installation and Setup
For reference:
e Installation Guide packaged with your printer

e Online Support Assistant at www.xerox.com/office/VLB620docs

INSTALLATION AND SETUP OVERVIEW

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. Configure
the initial settings of the printer, then install the print driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using an Ethernet
cable or wireless connection. Hardware and cabling requirements vary for the different connection methods.
Routers, network hubs and switches, modems, Ethernet cables, and USB cables are not included with your printer
and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a
USB connection, and it provides access to the Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

SELECTING A LOCATION FOR THE PRINTER

A\

ﬁ"-. Caution: To avoid personal injury and damage to the printer, professional installation of the printer is
required.

1. Select a dust-free area with temperatures from 10°-32° C (50°-90° F), and relative humidity of 15-85 percent.

{-:'-"' Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause
condensation inside the printer, which directly interferes with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the
printer. Ensure that the printer is horizontal and that all four feet are in solid contact with the surface.
To find the weight for your printer configuration, refer to Physical Specifications.

3. Select a location with adequate clearance to access supplies and to provide proper ventilation.
To find the clearance requirements for your printer, refer to Clearance Requirements.

4. After you position the printer, you are ready to connect it to the power source and computer or network.

UPDATING THE PRINTER SYSTEM SOFTWARE

Before installing print driver, verify that the printer has the latest version of system software loaded. When Xerox
releases a new version of printer system software or firmware, you can update your device. To ensure a successful
software update, follow the steps provided with the software files. Printer system software is downloaded from
www.xerox.com/office/VLB620support.

Before you download and install new software, determine the current software version installed on your device.
Print a configuration report to compare the system software version with the version available for download. For
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instructions about printing a configuration report, refer to Printing a Configuration Report.

Follow the instructions provided with the software to download the files and upgrade your device. You can configure
the device to connect routinely to an FTP directory on your network to update device software automatically. You
can also update the device software manually. For more information about updating system operating software,
refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

REMOVING THE INTERNAL PACKING MATERIALS

The printer comes with internal packing materials. Remove the packing materials and install the imaging unit and
the toner cartridge correctly.

1. At the front of the printer, open Door A.
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3. Remove the packing materials, such as plastic clips, tape, and foam.

4.
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5. Close Door A.

For more information, refer to the Installation Guide of the printer.
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Connecting the Printer

SELECTING A CONNECTION METHOD

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection. The
method that you select depends on how your computer is connected to the network. A USB connection is a direct
connection and is the easiest to set up. An Ethernet connection is used to connect to a network. If you are using a
network connection, it is important to understand how your computer is connected to the network.

{-:'-"' Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs,
network switches, modems, Ethernet cables, and USB cables are not included with your printer and require a
separate purchase.

USB

If you connect the printer to one computer and do not have a network, use a USB connection. A USB
connection offers fast data speeds, but typically is not as fast as a network connection.

Network

If your computer is connected to an office network or home network, use an Ethernet cable to connect the
printer to the network. You cannot connect the printer directly to the computer. A connection through a router
or network switch is required. An Ethernet network can be used for one or more computers and supports many
printers and systems simultaneously. An Ethernet connection is typically faster than USB and allows you direct
access to the settings of the printer using the Embedded Web Server.

{-:'-"' Note: To access the Embedded Web Server, a network connection is required.

Wireless Network

If your environment includes a wireless router or wireless access point, you can connect the printer to the
network with a wireless connection. A wireless network connection provides the same access and services as a
wired connection. A wireless network connection is typically faster than USB and allows direct access to the
settings of the printer using the Embedded Web Server.

{-:'-"' Note: For your printer, to connect to a Wireless Network, a Wireless Network Adapter is required.

CONNECTING TO A COMPUTER USING A USB CABLE
To connect the printer to a computer using a USB cable, you need one of these operating systems:

e Windows 10, Windows 11, Windows Server 2012, Windows Server 2016, Windows Server 2019, and Windows
Server 2022.

e Macintosh OS version 11 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.
To connect the printer to a computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, click Cancel.
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4. Install the print driver.

For more information, refer to Installing the Print Driver Software.

CONNECTING TO A WIRED NETWORK

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is used for
one or more computers and supports many printers and systems simultaneously. An Ethernet connection provides
direct access to printer settings using the Embedded Web Server.

To connect the printer:
1. Connect the power cord to the printer, then plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the back of the printer.
Connect the other end of the cable to a correctly-configured network port.

3. Power on the printer.

For details on configuring connection settings, refer to the System Administrator Guide at www.xerox.com/office/
VLB620docs.

WIRELESS NETWORK ADAPTER WITH BLUETOOTH

The Xerox® Wireless Network Adapter enables you to use the Wireless Wizard to connect to a wireless network. The
compatibility of the Wireless Network Adapter is dependent on the device model and software version.

The Xerox® Wireless Network Adapter supports the following:
e Wi-Fi Bands: Dual Band 2.4 GHz and 5 GHz
e Network Standards:
- 802.11ac
- 802.11n
- 802.11b/a/g
e Wi-Fi Direct
e Bluetooth 5.0 to support iBeacon using Bluetooth Low Energy

For more information on the Wireless Network Adapter, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs.

Connecting to a Wireless Network

If you have purchased the Xerox® Wireless Network Adapter, you can use the Wireless Wizard to connect the device
to a wireless network. If the device is connected to a wired network, you can configure wireless settings using the
Embedded Web Server or at the control panel touch screen using the Wireless Install Wizard.
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{-:'."' Note:

e Not all Xerox® Wireless Network Adapters are compatible with all Xerox® printers. Ensure that you
purchase the correct Xerox® Wireless Network Adapter kit for your device. For more information, contact
your Xerox representative.

e For more information about installing the wireless network adapter, refer to the Xerox® Wireless Network
Adapter Kit Hardware Install and Setup instructions that are included with the kit.

e The device uses either the wireless or the wired network connection. Activating one network connection
deactivates the other network connection.

e When you switch from a wired connection to a wireless connection, the IP address of the printer
changes. For more information on IP address or host name, refer to System Administrator Guide.

For details on configuring wireless network settings, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs.

CONNECTING WITH WI-FI DIRECT

You can connect to your printer from any Wi-Fi-enabled mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct or Soft AP features. The Wi-Fi Direct feature is disabled by default on the Xerox device.

{-:'-"' Note: The Wi-Fi Direct feature is available only on printers with the optional Wireless Network Adapter
installed. After you install the Wireless Network Adapter, the Wi-Fi Direct feature is enabled by default.

Wi-Fi Direct Overview

The Wi-Fi Direct feature allows you to print from a mobile device to your printer, using one of the following
methods.

e WPS push button, for Wi-Fi Direct-enabled Android devices with the Mopria print plug-in installed.
e Soft Access Point (AP), for Apple iPhones and other mobile devices that do not support the Wi-Fi Direct function.

For information about using the Wi-Fi Direct feature on your mobile device, or connecting to the printer using the
Soft AP feature, refer the mobile device documentation from the manufacturer.

For information about configuring the Wi-Fi Direct feature on your printer, refer to the System Administrator Guide
at www.xerox.com/office/VLB620docs.

Using Wi-Fi Direct on Your Mobile Device

The Wi-Fi Direct WPS Push Button feature requires the Mopria Print Service App installed on your mobile device. The
printer does not require a wireless connection.

Installing Mopria Print Service
1. On your mobile device, go to the Google Play Store, then search for Mopria Print Service.
Install the Mopria Print Service App.

Go to Settings, then touch Printing.

&w N

Go to the notification area, then touch Mopria Print Service.
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5. To enable Mopria Print Service, touch On.
6. Exit Settings.

Your mobile device searches for Wi-Fi Direct-enabled printers that are in range of the mobile device.

Using Wi-Fi Direct on your Printer

Wi-Fi Direct is a direct wireless connection from your mobile device to the printer. The Wi-Fi Direct feature is
enabled by default when the Wi-Fi hardware is installed.

Using the Wi-Fi Direct feature does not require a wireless network connection to a printer. Contact your System
Administrator to connect your printer to a wired or wireless network.

Printing Using Wi-Fi Direct

To print a document from a Wi-Fi-enabled mobile device:

1. On the mobile device, open the document that you want to print.

In the device application, select the Print button.

If there is more than one printer in the area with Wi-Fi Direct enabled, select the required printer from the list.

Select the print settings required for the job.

v W N

Submit the job for printing.
A message appears on the mobile device.

6. Select Connect.

When the connection is made, a message appears on the printer.
7. At the printer control panel, touch OK.

The job prints.

CONNECTING WITH NEAR FIELD COMMUNICATION (NFC)

NFC Overview

when they are in close range. NFC allows you to add a printer to your Android mobile
device easily. After you add the printer, there is no need to use NFC on that printer. The
NFC feature requires installation of the Xerox Print Service app on the mobile device.

"Fﬁ Near field communication (NFC) is a technology that enables devices to communicate

Printers can communicate using NFC when they are within your mobile device range.

{-:'-"' Note: The range can vary depending on the device manufacturer. For information about the required
settings for individual mobile devices, refer the documentation supplied by the manufacturer of your mobile
device.

For details about configuring NFC on your printer, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs.
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Using NFC on your Mobile Device
The NFC feature requires installation of the Xerox Print Service app on the mobile device.

Your mobile device must use the same Wi-Fi network environment as the printer. The printer does not need to have
a wireless connection.

{.'l-"} Note: NFC supports Android 4.4 or greater devices.

Installing the Xerox Print Service Plugin

1. On your mobile device, go to the Google Play Store, then search for Xerox Print Service Plugin.
Install the Xerox Print Service Plugin app.

Go to Settings, then touch Printing.

Go to the notification pull-down bar, then touch Xerox Print Service.

To enable Xerox Print Service, touch On.

o v &~ W N

Exit Settings.

Enabling NFC on the Mobile Device

Most mobile devices have NFC disabled by default.
To enable NFC:

1. Go to Settings.

2. Go to the NFC setting, then touch On.

3. Exit Settings.

Using NFC on your Printer

The NFC chip is on the bottom right of the control panel. When NFC is enabled, you can use the NFC function.

Refer to your mobile device user documentation for the mobile device NFC chip location.

{_-:ﬂ' Note: The NFC function must be enabled before use. For NFC enable instructions, refer to the System
Administrator Guide at www.xerox.com/office/VLB620docs.

Mapping the Printer to your Mobile Device

1. Open the Xerox Print Service Plugin.
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2. At the top right side of the screen, touch the selection button, then select Add Printer.
3. Touch the NFC option.

4. Hold the mobile device over the NFC icon on the control panel.

-5
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The mobile device and the printer communicate with each other. The mobile device searches the network for the
printer. When the printer is located, it is added to the list as a mapped printer.

You can submit print jobs from your mobile device to the printer.

Printing using Xerox® Print Services

1. Open the document that you want to print. For example, a PDF or Word document.
At the top of the screen, select the Print button.

If there is more than one printer mapped for use with NFC, select the printer required.

Select the print settings required for the job.

v B W N

Submit the job for printing.

CONFIGURING AIRPRINT

AirPrint is a software feature that allows you to print documents from Apple i0S-based mobile devices and MacOS-
based devices without a print driver. AirPrint-enabled printers that use a wired or wireless connection allow you to
print or fax directly from a Mac, an iPhone, iPad, or iPod Touch. Additionally, you can use AirPrint to scan from a
wired or wireless printer to supported Apple devices.

For information about AirPrint configuration settings, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs. Alternatively, use a desktop computer to access the Embedded Web Server for your device, then
click the Help link that appears at the bottom of each page. For details, refer to Accessing the Embedded Web
Server.

CONFIGURING A DEVICE FOR UNIVERSAL PRINT

Universal Print is a cloud-based print protocol that provides a simple and secure print solution for Microsoft® 365
users. Universal Print allows administrators to manage printers without the need for on-premises print servers.
Universal Print enables users to access cloud printers without the need for print drivers.
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e When Universal Print is enabled, the configuration settings appear. The Universal Print area displays the
registration status of your device.

e When Universal Print is disabled, the configuration settings are hidden. The Universal Print area shows the status
Of£. This status is the default.

For information about configuring a device for Universal Print, refer to the System Administrator Guide at www.
xerox.com/office/VLB620docs.
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Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling the optional
features and assigning an IP address for the Ethernet network connection. Printer settings can be configured at the
printer control panel or by using the Embedded Web Server. To configure settings at the printer control panel, the
installation wizard starts the first time that you power on the printer. The wizard prompts you with a series of
questions to help configure basic printer settings.

The System Administrator can configure the following settings:
e language

e Backup & Restore Settings

e Network Connection

e Date and Time

e Measurements

e Security Settings

For more information on configuring the printer settings at the control panel or using the Embedded Web Server,
refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

CONFIGURATION WATCHDOG

Configuration Watchdog is a security feature that monitors feature settings to ensure that the device stays in the
appropriate configuration throughout day-to-day operations. The feature ensures that values remain compliant
without external device monitoring. When a watched setting changes, Configuration Watchdog detects the change
on the next manual or scheduled check. After a change is detected, Configuration Watchdog remediates the
feature to the required settings.

After remediation occurs, administrators can view the list of remediated items on the Configuration Watchdog
page.

For more information about Configuration Watchdog, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/VLB620docs.

FLEET ORCHESTRATOR

The Fleet Orchestrator feature automatically allows you to configure many devices in similar ways. After you
configure one device, you can distribute any of the configuration settings to other devices, as needed. You can set
up schedules to share configuration settings regularly and automatically.

The Fleet Orchestrator feature enables you to share the following types of configuration files:
e Clone files
e Software upgrade files

For more information about Fleet Orchestrator, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/VLB620docs.
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XEROX® EASY ASSIST APPLICATION

Xerox Easy Assist application can assist you with the initial setup procedure for a new printer. You can access and
configure the printer from your smartphone through the Xerox Easy Assist (XEA) app. To access the printer from
your smartphone, download and install the Xerox Easy Assist app on your mobile device. By installing the Xerox Easy
Assist app on your smartphone, you can setup your new printer easily, manage its configuration, view alerts
indicating supply requirements and order them, and get live troubleshooting support for your printer.

The Xerox Easy Assist App has instructions and video links that help you to unpack the printer from its shipping box.
To install the Xerox Easy Assist app on your smartphone, you need to scan a QR Code. You can find this QR Code on
the packaging box or the Installation Guide that comes with the printer. To install the Xerox Easy Assist app for the

first time, scan the QR Code with your smartphone camera.

For more information, refer to Xerox® Easy Assist (XEA) App.
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Installing the Print Driver Software

Before you install the print driver software, verify that the printer is plugged in, powered on, connected correctly,
and has a valid IP address. The IP address usually appears on the default Home screen of the control panel. If you
cannot find the IP address of your printer, refer to Finding the IP Address of Your Printer.

{-:'-"' Note: If the Software and Documentation disc is not available, download the latest drivers from www.xerox.
com/office/VLB620drivers.

After you install the print driver software, you can configure printing preferences and default settings for the print
driver. For more information, refer to Printing.

Printing settings for the device, such as Page Description Language options, are configured using the Embedded
Web Server. To configure printing settings, contact your System Administrator or refer to the System Administrator
Guide at www.xerox.com/office/VLB620docs.

OPERATING SYSTEM REQUIREMENTS

e Windows 10, Windows 11, Windows Server 2012, Windows Server 2016, Windows Server 2019, and Windows
Server 2022.

e Macintosh OS version 11 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

INSTALLING THE PRINT DRIVERS FOR A WINDOWS NETWORK PRINTER

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does
not start automatically, navigate to the drive, then double-click the Setup.exe installer file.

{-:'-"' Note: If you do not have the Software and Documentation disc, download the Smart Start installer file from
www.xerox.com or the Embedded Web Server of your printer. For more information, refer to Downloading
the Print Drivers from the Embedded Web Server.

2. Click Xerox Smart Start — Driver Installer (Recommended).
3. At the License Agreement, click Agree.

4. From the list of discovered printers, select your printer.

{-:'-"' Note: When you install print drivers for a network printer, if your printer does not appear in the list, click
Don’t See Your Printer?and then enter the IP address for your printer. To install the recommended print
driver, click Continue, then select Install.

5. Click Quick Install.
A message appears that confirms that the installation is successful.

6. To complete the installation and close the Installer window, click Done.
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INSTALLING THE WINDOWS PRINT DRIVER .ZIP FILE

You can download print drivers from Xerox.com in a .zip file, then use the Windows Add Printer Wizard to install the
print drivers on your computer.

To install the print driver from the .zip file:

1.
2.
3.

10.
11.
12.

13.
14.

Download, then extract the required .zip file to a local directory on your computer.
At your computer, open the Control Panel, then select Devices and Printers > Add a Printer.

Click The printer that I want isn’t listed, then click Add a local printer or network printer with manual
settings.

To use a previously established port, select Use an existing port, then from the list, select a Standard TCP/IP
Port.

To create a Standard TCP/IP port:

a. Select Create a New Port.

b. For Type of port, select Standard TCP/IP Port, then click Next.

¢.  Inthe Hostname or IP address field, type the printer IP address or host name.

d. To disable the feature, clear the check box for Query the printer and automatically select the driver to
use, then click Next.

Click Have Disk.

Click Browse. Browse to the extracted files in the local directory, then select the driver.inf file for your printer.
Click Open.

Select your printer model, then click Next.

If a prompt appears because the print driver was installed previously, click Use the driver that is currently
installed (recommended).

In the Printer name field, type a name for your printer.
To install the print driver, click Next.

If needed, set the printer as the default printer.

{-:'-"' Note: Before you select Share Printer, contact your system administrator.

To send a test page to the printer, click Print a test page.

Click Finish.

INSTALLING THE PRINT DRIVERS FOR A WINDOWS USB PRINTER

1.
2.
3.

64

Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
Connect the A end of the USB cable to the USB port on the computer.

If the Windows Found New Hardware Wizard appears, click Cancel.
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4. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does
not start automatically, navigate to the drive, then double-click the Setup.exe installer file.

{-:'-"' Note: If you do not have the Software and Documentation disc, download the Smart Start installer file from
www.xerox.com or the Embedded Web Server of your printer. For more information, refer to Downloading
the Print Drivers from the Embedded Web Server.

5. Click Xerox Smart Start — Driver Installer (Recommended).

6. At the License Agreement, click Agree.

7. From the list of discovered printers, select your printer, then click Quick Install.
A message appears that confirms that the installation is successful.
8. To complete the installation and close the Installer window, click Done.

INSTALLING THE PRINTER AS A WEB SERVICE ON DEVICES

Web Services on Devices (WSD) allows a client to discover and access a remote device and its associated services
across a network. WSD supports device discovery, control, and use.

Installing a WSD Printer Using the Add Device Wizard
1. At your computer, click Start, then select Printers and Scanners.
2. To add the required printer, click Add a Printer or Scanner.

3. Inthe list of available devices, select the device that you want to use, then click Next.

{-:'-"' Note: If the printer that you want to use does not appear in the list, click Cancel. To add the printer
manually, use the IP address of the printer. For details, refer to Installing the Windows Print Driver zip File.

4. Click Close.

INSTALLING THE DRIVERS AND UTILITIES FOR MACINTOSH OS (MACOS)
1. Download the latest print driver from www.xerox.com/office/VLB620support.

Open the Xerox® Print Drivers 5.xx.x.dmg or .pkg as needed for your printer.

To run Xerox® Print Drivers 5.xx.x.dmg or .pkg, double-click the appropriate file name.
When prompted, click Continue.

To accept the license agreement, click I Agree.

o v &~ W N

To accept the current installation location, click Install, or select another location for the installation files, then
click Install.

7. If prompted, enter your password, then click OK.
8. From the list of discovered printers, select your printer, then click Next.
9. If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.
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10.

11.
12.
13.

c. Select your printer in the list of discovered printers, then click Continue.

If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB cable is
connected properly.

To accept the print queue message, click OK.
Select or clear the Set Printer as Default and Print a Test Page check boxes.

Click Continue, then click Close.

Adding the Printer for MacOS

For networking, set up your printer using Bonjour® (mDNS), or for an LPD, LPR connection, connect using the IP
address of your printer. For a non-network printer, create a desktop USB connection.

For more information, go to the Online Support Assistant at: www.xerox.com/office/VLB620support.

Adding the Printer Using Bonjour

To add the printer using Bonjour®:

1.
2.

From the computer Applications folder or from the dock, open System Preferences.
Click Printers & Scanners.

The list of printers appears on the left of the window.

For the list of printers, click the Plus icon (+).

At the top of the window, click the Default icon.

Select your printer from the list, then click Add.

{-:'-"' Note: If your printer is not detected, verify that the printer is powered on and that the Ethernet cable is

connected properly.

Adding the Printer by Specifying the IP Address

To add the printer by specifying the IP address:

1.
2.

© v % N oo v & W
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From the computer Applications folder or from the dock, open System Preferences.
Click Printers & Scanners.

The list of printers appears on the left of the window.

In the list of printers, click the Plus (+) icon.

Click IP.

From the Protocol list, select the protocol.

In the Address field, enter the IP address of the printer.

In the Name field, enter a name for the printer.

From the Use list, choose Select a driver to use.

From the printer software list, select the print driver for your printer model.

Click Add.
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INSTALLING PRINT DRIVERS AND UTILITIES FOR UNIX AND LINUX PRINTING

To provide printer spooling and network print server functionality, UNIX-based printing uses LPD/LPR port 515 or Ip
to port 9100. For information about UNIX-based printing, refer to UNIX, Linux, and AS/400 Printing.

For more information on installing print drivers and utilities for UNIX and Linux, refer to www.xerox.com/office/
VLB620drivers.
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More Information

You can obtain more information about your printer from these sources:

RESOURCE LOCATION

Installation Guide

Packaged with the printer.

Getting Started guide

Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer

www.xerox.com/office/VLB620docs

Recommended Media List

United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer,
including online technical support, Online Support
Assistant, and print driver downloads.

www.xerox.com/office/VLB620support

Information Pages

Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information

In the Embedded Web Server, click Help.

Order supplies for your printer

www.xerox.com/office/supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,

and customized features to meet your individual needs.

www.xerox.com/office/businessresourcecenter

Local sales and Technical Customer Support

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/register

Xerox® Direct online store

www.direct.xerox.com/

LOCATING THE SERIAL NUMBER

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print a configuration report, or view the serial number
on the control panel or on the Embedded Web Server home page. The serial number is printed on a label that is
affixed to the printer. To view the label, open Door A.

For details on how to print a configuration report, refer to Information Pages.
To view the serial number on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.
The model, serial number, and software version is displayed.

3. Toreturn to the Home screen, press the Home button.
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Personalize Overview

This chapter provides information on how to personalize your device user interface to meet the specific demands of
your workflows.

Personalization enables individual logged-in users to work more productively, and ensures that the features and
functions displayed meet individual user needs. Personalization allows you to hide, show, and rearrange apps on the
Home screen to suit your job priorities.

The device uses the Adaptive Learning functionality to analyse the apps and features used when you are logged in
to the device. The device provides personalized workflow suggestions based on your activity. As an individual user,
you can choose the types of Adaptive Learning suggestions that you receive. You can enable or disable your
suggestion options at the device control panel.

System administrators can use the Customization feature to configure settings for all users. Customization allows
the system administrator to do the following:

e Hide, show, and rearrange apps on the Home screen
« Configure and save the default settings

For details, contact your system administrator, or refer to the System Administrator Guide at www.xerox.com/office/
VLB620docs.

{'f-". Note: Personalization settings configured by individual users override any equivalent Customization settings
configured by the system administrator.
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Personalization by the User

PERSONALIZING THE HOME SCREEN

Using the personalization options, you can show, hide, or change the display order of apps for the Home screen.

Displaying or Hiding an App on the Home screen
To display or hide an app on the Home screen for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.
4. Touch Personalize Home.
5. Todisplay an installed, but hidden app:
a. Touch the Plus (+) icon.
b. Touch the app that you want to appear on the control panel.
6. To hide an installed app:
a. For the required app, touch X.
b. Touch Hide.
7. Touch Done.

8. Verify that only the required apps appear on the Home screen.

Rearranging Apps on the Home screen
To rearrange apps on the Home screen for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Scroll to the bottom, then touch Personalize.
Touch Personalize Home.
Touch and hold the required app, then drag the app to the new location. Release the app.

Touch Done.
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Verify that the apps appear in the correct location on the Home screen.

Deleting an App from the Home Screen
To delete an app from the Home screen for the logged-in user:

1. At the printer control panel, press the Home button.
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2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.
4. Touch Personalize Home.
5. To delete an installed app:
a. For the required app, touch X.
b. At the prompt, touch Delete.
6. Touch Done.

7. Verify that only the required apps appear on the Home screen.

Removing Personalization From the Home Screen
To remove personalization from the Home screen for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.
4, Select an option:

e Remove Home Personalization: This option removes all personalization from the Home screen.

Warning: The Remove Home Personalization option removes personalization from the Home screen, and
other personalized device settings.

e Remove All Personalization: This option removes all personalization for the logged-in user, including
personalized 1-Touch apps.

{-:'-"' Note: Any customizations configured by the system administrator, including 1-Touch, EIP, Single Touch, and
Weblet apps, are not affected.

5. At the prompt, touch Remove.

Apps appear in the default location on the Home screen.

6. Touch Done.

PERSONALIZING ENTRY SCREEN DEFAULTS

Use the Entry Screen Defaults option to set the screen defaults or actions when a user logs in to the device for the
first time. You can personalize the Device Default App option. The Device Default App is the initial app that
appears to a logged-in user, or when the device is reset to default settings.

If a selected app is no longer available, a notification displays and the entry screen defaults return to the factory
default settings.
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Setting the Device Default App
To set the device default app for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch Personalize.

Touch Entry Screen Defaults.
Touch Device Default App.
Touch the required app.

Touch OK.
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REMOVING APP PERSONALIZATION USING THE CONTROL PANEL
To remove the current app personalization settings:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch the app required.
Scroll to the bottom of the feature list, then touch Personalize.

Touch Remove App Personalization.

o v &~ W

At the prompt, touch Remove.

PERSONALIZING THE LANGUAGE

A logged-in user can personalize the default language settings and the default keyboard layout.
Each time the user logs in to the device, the selected language and keyboard settings are activated.
To personalize the default language and keyboard layout:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch Log In, then touch Personalize Language.
To change the language, touch the language required.

To change the keyboard layout, touch Keyboard Layout, then touch the option required.

o v &= W

Touch Done.
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Personalization from Adaptive Learning

Adaptive Learning reacts to everyday usage of the device to streamline tasks for users and administrators. Adaptive
Learning provides personalized workflow suggestions for a logged-in user based on their use of certain applications.
An individual user can choose the types of suggestions that they receive. Individual users can enable and disable
their personalized suggestion options at the device control panel.

Adaptive Learning personalization offers workflow-automation suggestions to help logged-in users streamline their
workflow. Personalized app workflow suggestions include language preference settings.

Adaptive Learning personalization is enabled by default. When Adaptive Learning personalization is enabled, all
personalization suggestion options for logged-in users are enabled by default. When Adaptive Learning
personalization is enabled, logged-in users can manage their personalization suggestions at the control panel.

PERSONALIZED LANGUAGE SUGGESTIONS

When Adaptive Learning and Personalization are enabled, if a logged-in user selects a different language, the
device offers to change the language immediately after the user changes the current language.

To personalize the language from a suggestion screen:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

3. If the logged-in user changed the language in the previous session, a suggestion screen appears. To accept the
offer to change your default language, touch Make Default.

The default language for the logged-in user is changed.

MANAGING YOUR PERSONALIZATION SUGGESTIONS

When Adaptive Learning and Personalization are enabled, the device provides suggestions for an improved user
experience at the device.

To manage your personalization suggestions:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

3. Touch Log In, then touch Manage Suggestions.
Alternatively, you can access the Manage Suggestions option from each suggestion screen.

4. Touch Language to receive a suggestion to change the language when a different language is selected.

5. Touch OK.
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Removing All Personalizations
To remove all personalizations from the device:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.

4. Touch Remove All Personalizations.

Warning: The Remove Home Personalization option removes personalization from the Home screen, and
other personalized device settings.

5. At the prompt, touch Remove All.
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Xerox® Apps are a gateway to the features and functions of your device. There are standard Apps already installed
and displayed on the Home screen. Some Apps are installed as standard, but are hidden when you use your device
for the first time. You can show, hide, or reorder Apps on the Home screen using the settings available in the
Embedded Web Server.

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator Guide at
www.xerox.com/office/VLB620docs.

A range of Apps is available for download and installation from the Xerox® App Gallery. These apps include Xerox®
Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on compatible printers.

For more information about using the Xerox® App Gallery and downloading Apps, refer to Xerox® App Gallery.
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Xerox® App Gallery

XEROX® APP GALLERY OVERVIEW

=i Use the Xerox® App Gallery to find apps that provide new features or capabilities for

'{*— Loy ' your device. The Xerox® App Gallery provides direct access to apps that can improve
L your productivity, simplify workflows, and enhance your user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse
the App Gallery without logging in. The moving banner provides an active display of
apps, or you can scroll the full list of apps. To get more details on an app, touch the app
name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network connection.

{-:'-"' Note: If your device is configured to access the Internet through a proxy, to allow the Xerox® App Gallery
App to access the Internet, ensure that the proxy is configured correctly.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery User Guide
available at www.xerox.com/XeroxAppGallery.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

CREATING A XEROX® APP GALLERY ACCOUNT

With an App Gallery account, you have direct access to all the available Apps for your device. An App Gallery
account allows you to view and acquire Apps, install Apps on your device, and manage your Apps and licenses.

You can set up an App Gallery account using the control panel or the Xerox® App Gallery Web portal. For more
information about the Xerox® App Gallery Web portal, refer to www.xerox.com/XeroxAppGallery.

{-:'-"' Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your Xerox® App Gallery
Account.

To create an App Gallery account using the Control Panel:
1. At the printer control panel, press the Home button.
Touch Xerox App Gallery.

Touch Log In.

&= W N

Touch Create Account.
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5. Enter the information required into the appropriate fields:
e Email Address
e Confirm Email Address
e Password
e Confirm Password
e First and Last Name
e Company Name
e Country
e Payment Currency
6. Review and accept the Terms of Service and the Data Administration Terms of Service, then click OK.

7. After the account is created, a message appears that confirms that completion instructions will be sent to the
email address entered in step 5.

8. To complete the account creation process, verify your account:

a. Access the inbox for the email address provided in step 5, then open the Welcome to Xerox® App Gallery
email.

b. Click Verify Account.
A webpage opens.

c. To complete the verification process, enter the email address and password entered in step 5, then click
Log In.

A welcome message appears that confirms that the account verification process is complete.

LOGGING IN TO YOUR XEROX® APP GALLERY ACCOUNT

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps.
To log in to your App Gallery Account:

1. At the printer control panel, press the Home button.

Touch Xerox App Gallery, then select Log In.

To enter your email address, use the touch screen keypad.

To enter your password, use the touch screen keypad.

v B wWN

To log in, touch OK or Enter.

INSTALLING OR UPDATING AN APP FROM THE XEROX® APP GALLERY

Xerox® Apps add to, extend, or customize the functionality of your device. You can use the Xerox®App Gallery App
to browse and install Apps at your device control panel.

To install an App from the App Gallery:

1. At the printer control panel, press the Home button.
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Touch Xerox App Gallery, then select Log In.
To enter your email address, use the touch screen keypad.

2
3
4, To enter your password, use the touch screen keypad.
5. Touch OK or Enter.

6

Touch the App required, then touch Install. The License Agreement screen appears.

{-:'-"' Note: If the App was installed previously and a new version is available, the Install option changes to an
Update option.

7. Touch Agree. The installation process begins.
If the App does not successfully install, to attempt the installation process again, touch Install.

8. To exit the Xerox® App Gallery App, press the Home button.

Updating an App from the App Gallery

1. At the printer control panel, press the Home button.
Touch Xerox App Gallery, then select Log In.
To enter your email address, use the touch screen keypad.
To enter your password, use the touch screen keypad.

Touch OK or Enter.

Touch Agree.

2
3
4
5
6. Touch the App required, then touch Update. The License Agreement screen appears.
7
8. When the update is complete, the Update option changes to an Installed status.

9

To exit the Xerox® App Gallery App, press the Home button.

80 Xerox® VersaLink® B620 Printer User Guide



Xerox® Apps

Device

DEVICE OVERVIEW

The Device App gives you access to information about your printer, including the serial
number and model. You can view the status of the paper trays, billing and supplies
information, and print information pages.

Many Device options can be configured to meet your individual needs. For details about configuring all of the
Device settings, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

Device Options

The following device options are available:

OPTION DESCRIPTION

Admin For logged-in users, Personalization Settings provides access to the
Eﬂ Personalization Personalized Language and Manage Suggestions options. For

Settings more information about Personalization settings, refer to Personalize.

Language Pressing the Language button allows you to set the language that
@ appears on the control panel touch screen.

{;ﬁ' Note: Sometimes this option is hidden from view. For details,
refer to System Administrator Guide at www.xerox.com/office/
VLB620docs.

Accessibility Pressing Accessibility allows you to access the Invert Display Color
feature, that changes the appearance of the control panel touch
screen. For more information, refer to Accessibility.

About The About option provides an overview of your device, the device
serial number, and information about current settings.

Information Your printer has a set of information pages that you can print. These
Pages pages include configuration and font information, demonstration
pages, and more.

Notifications Use the Notifications option to see details of any current alerts or
errors on the device. A Fault History option displays fault codes and
the date that they occurred on the device.

Paper Trays Use the Paper Trays option to see the paper size, type, and color set
for each paper tray and the tray-capacity status.

Supplies Use the Supplies section to monitor the status of the components you
can replace. The supply level and estimated number of impressions or
days that remain for each unit are displayed.

LB | [ LAIE,IB@
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OPTION DESCRIPTION

Billing/Usage Use the Billing/Usage option to view the serial number and the total
number of impressions your device has made.

Tools Use the Tools option to customize settings, such as the power-save
modes, the date and time, and the control panel brightness. You can
configure settings using the device control panel or the Embedded
Web Server.

.:.'I-'} Note: For details on configuring the printer settings, refer to
System Administrator Guide at www.xerox.com/office/

VLB620docs.
Web-Based Use the Web-Based Configuration (Test Drive) tool to access device
Configuration capabilities and configuration options available on the Embedded
(Test Drive) Web Server, at the device control panel.

% Note: Some Embedded Web Server configuration options and
features are restricted. Examples of restricted options and
features are downloading and installing files, and accessing
links that redirect to external websites.

Remote Services | Use the Remote Services option to send error and usage information
&. to the Xerox support team.

{_-:.'-" Note: Your System Administrator is required to enable this
feature using the Embedded Web Server.

n Xerox Easy Assist | Use the Xerox Easy Assist app to access and configure the printer

App from your smartphone. By installing the Xerox Easy Assist app on your
smartphone, you can setup your new printer easily, manage its
configuration, view alerts indicating supply requirements and order
them, and get live troubleshooting support for your printer.

For more information, refer to Xerox® Easy Assist (XEA) App.

For details on configuring the printer settings, refer to the System Administrator Guide at www.xerox.com/office/
VLB620docs.

ACCESSIBILITY

Invert Display Color
Invert Display Color allows you to invert the colors of the control panel display.
1. At the printer control panel, press the Home button.
2. Touch Device > Accessibility.
A new window appears for Accessibility.

3. Toinvert the display color of the control panel screen, touch the Invert Display Color toggle button.
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4. Touch OK.

The inversion of the display color only applies to individual users during their session. Inversion of the display color
gets cleared when:

e The user changes it back
e The current session ends
e User does a Reset All.

To change the default settings, refer to System Administrator Guide at www .xerox.com/office/VLB620docs.

ABOUT

The About option provides an overview of your device and its current settings and status. You can view the serial
number, model number, and software version.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, getting started pages, and more.

The following Information Pages are available:

NAME DESCRIPTION

Basic Configuration Report The Basic Configuration Report provides printer
information, including the serial number, installed
options, network settings, port setup, tray information,
and more.

Detailed Configuration Report The Detailed Configuration Report provides
information about all of the printer settings, including
extensible services setup, security and authentication
server configuration, connectivity settings, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage

information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.
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NAME DESCRIPTION

PCL Font List The PCL Font List provides a printout of all PCL fonts
that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

Printing Information Pages

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. To print an information page, touch the needed page, then touch Print.
The printer prints the selected information page.

4. To return to the Home screen, press the Home button.

SUPPLY STATUS

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near their replacement time, warning alerts appear on the control
panel. You can customize the alerts that appear on the control panel and configure email alert notifications.

To check the supplies status at the control panel:

1. To view status information for the printer supplies, touch Device > Supplies.

2. To view details about a specific item, including its part number for reordering, touch the required item.
3. Toreturn to the Supplies screen, touch X.

4. To return to the Device screen, touch X.

To check the supplies status and set up alerts, use the Embedded Web Server. For details about configuring all
Device settings, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

BILLING AND USAGE COUNTERS

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:
1. At the printer control panel, press the Home button.
2. Touch Device > Billing/Usage.
The impression counts are displayed:
e Black Impressions: Total number of pages printed with no color specified.

e Total Impressions: Total number of color impressions and black impressions.
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3. To view more details, touch Usage Counters, then select an option.

e Impression Counters: This option provides the number of impressions made by the printer. The number of
impressions cannot equal the number of sheets counted, depending on the printer setup. If your printer is
set up to count large sheets as large impressions or as multiple smaller impressions, the number of
impressions can differ.

e Sheet Counters: This option provides the number of impressions made by the printer. Impressions for 2-
Sided sheets are identified as a separate line from 1-Sided sheets.

e All Usage Counters: This option provides all printer usage information.

4. After viewing the usage readings, to return to the Home screen, press the Home button.

REMOTE SERVICES

You can use the Remote Services option to send error and usage information to the Xerox support team to help
them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the System
Administrator Guide at www.xerox.com/office/VLB620docs.

XEROX® EASY ASSIST (XEA) APP

Xerox Easy Assist app allows you to access and configure the printer from your smartphone. To access the printer
from your smartphone, download and install the Xerox Easy Assist app on your mobile device. By installing the
Xerox Easy Assist app on your smartphone, you can setup your new printer easily, manage its configuration, view
alerts indicating supply requirements and order them, and get live troubleshooting support for your printer.

To install the Xerox Easy Assist app on your smartphone, you need to scan a QR Code or search the app in the Apple
App Store or Google Play Store. There are two types of XEA QR Codes:

e QR Code to acquire the XEA app: This QR Code is for the initial installation of the app. To install the Xerox Easy
Assist app for the first time, you are required to scan this QR Code using your smartphone camera. You can find
this QR Code on the packaging box or the Installation Guide that comes with the printer. Check the following
locations for the XEA QR Code:

—  Printer packaging box

Installation Guide

Device Install Wizard

—  Help materials
For more information, refer to Prior to Installing the Printer: Initial Setup with Xerox® Easy Assist (XEA) App.

¢ QR Code to connect the mobile device to the printer: This QR Code is to setup a wireless network connection
between the smartphone and the printer. For example, connection to Wi-Fi Direct. You can find this QR Code at
the printer control panel or in the device Install Wizard. The QR Code provides all key information to connect
your smartphone and the printer without manually entering any technical information. To connect to the
printer, scan this QR Code within the Xerox Easy Assist app. For more information, refer to After Initial
Installation: Connecting to the Xerox® Easy Assist App from the Control Panel.

Primary features of Xerox Easy Assist app are:
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Set Up a New Printer

If you have the QR Code or IP Address available, you can set up a new Xerox printer with the help of Xerox Easy
Assist app. On My Printers screen in the app, touch the + icon, then touch Set Up a New Printer. Follow the
instructions from the app.

For more information, refer to Adding Multiple Printers to the Xerox Easy Assist App.

Printer Status

The status displays the printer information, such as readiness of the printer, toner level, and paper tray status for
each tray. You can order parts and supplies through the Xerox Easy Assist app. If the toner level appears to be
low, to order a new toner, select the Toner icon, then touch Reorder.

Alerts

The Xerox Easy Assist app can notify you of any errors or problems in the printer. To view the error statement,
touch the Bell icon.

Print

You can perform a print job through the Xerox Easy Assist app. In the app, select your printer, then touch Print.
Select the document that you need to print from your mobile device, confirm the print settings, then touch
Print.

Device Settings

You can view and edit your printer settings from the Device Settings tab. If you have not setup a password
during the initial setup, to view or edit existing printer settings, you need to set up the password.

Support

You can request support and find solutions for printer-related problems through the Xerox Easy Assist app. In the
app, select your printer, then touch Support. It connects you to Xerox’s Support Agent Live Chatbot.

Set Up Computer

You can download Print and Scan Drivers for your printer through Xerox Easy Assist app. In the app, select your
printer, then touch Set Up Computer. In the Email field, type your registered email address, then touch the +

icon to add your email. To download and install the Print and Scan Drivers, the app sends a Quick Link to your

email address.

Print Test Page

To confirm that all settings are correct, you can print a test page. In the app, select your printer, then touch
Print Test Page.

Remove a Printer

You can remove a printer from the Xerox Easy Assist app. On your app, select a printer from My Printers page,
then swipe left and touch Remove.

Prior to Installing the Printer: Initial Setup with Xerox® Easy Assist (XEA) App
To complete the initial setup and install the Xerox Easy Assist app for the first time, do the following:

1. Forinitial setup when the printer is powered on for the first time, the initial setup wizard appears. At the printer
control panel, do the following:
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a. Select your Language, then touch Next.
The Xerox Easy Assist Mobile App screen appears.
b. To use your mobile device to set up and manage your printer, touch Yes.
Get the App screen appears to confirm the type of your mobile device. Choose any one option:
e i0S: To install the Xerox Easy Assist app for your iPhone, select this option.
e Android: To install the Xerox Easy Assist app for your Android mobile device, select this option.

e I have the App: If you have already installed Xerox Easy Assist app on your mobile device, select this
option.

2. If you have selected iOS or Android option, a screen appears to help you download the app. At the control
panel, touch Show QR Code option.

A screen appears with the QR Code. To install the app, scan the QR Code with your smartphone camera.
3. Download and install the Xerox Easy Assist app on your smartphone:

e For Android phones: Go to Google Play Store, then search for Xerox Easy Assist app.

e ForiOS or iPhones: Go to Apple App Store, then search for Xerox Easy Assist app.

4. When you install the app for the first time on your smartphone, for End-User License Agreement (EULA), touch
I Agree.

{-:'-"' Note: The Xerox Easy Assist App has instructions that help you to unpack the printer from its packaging box.
To watch a helpful video on how to unpack your printer, scan the QR Code on the packaging box or the
Installation Guide that came with your printer, using your smartphone camera. Accept the End-User License
Agreement (EULA), then follow the instructions that appear on the app.

5. Follow the instructions that appear on the app. To connect your smartphone with the printer, touch Connect
To My Printer.

6. At the printer control panel, to connect to the app, touch Show QR Code option. The second or connect—-QR
Code appears.

~

Scan the QR Code through the Xerox Easy Assist app. Follow the instructions that appear on the app.

When the connection is configured, your smartphone and the printer share the same wireless network,
temporarily.

8. With the support of Xerox Easy Assist app, complete the general settings and register the printer on the
network.
General settings include Admin Password, Connectivity, Measurements, Sound, Power Saver settings, and more.

{-:'-"' Note: Ensure that your smartphone is connected to the same Wireless or wired network as the printer and
they can communicate after the setup is complete.

9. To complete the initial setup in the app, type the necessary information for your printer, then touch Complete
Setup.

The Welcome screen appears.
When the initial setup is complete, with the Xerox Easy Assist app, you can perform the following:
e Setting up a new printer

e Checking the printer status and order supplies
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Downloading Print and Scan Drivers
Printing
Getting troubleshooting support

Removing a printer from the XEA app My Printers list

For Xerox Easy Assist app features, refer to Xerox® Easy Assist (XEA) App.

After Initial Installation: Connecting to the Xerox® Easy Assist App from the Control Panel

For a printer that is already installed and does not require initial installation setup, to use the features of the XEA
app, connect the printer to Xerox Easy Assist app. By accessing Xerox Easy Assist (XEA) app through your
smartphone, you can setup additional printers, manage its configuration, view alerts indicating supply requirements
and order them, and get live troubleshooting support for your printer. You can find the QR Code and connect to the
XEA app from the printer control panel:

1.
2.

9.
10.

88

At the control panel Home screen, touch Device.

From Device options, touch the icon for Xerox Easy Assist App.

The Xerox Easy Assist App screen appears with a display of main features Setup, Manage, and Print.
Select from the following options:

e Get Started: Select this option to connect and add the printer to the XEA app.

e Close: Select this option to return to the Device screen.

To add the printer to the app, touch Get Started.

Get the App screen appears on the printer control panel.

Touch any one option:

e Back: To return to the initial XEA app screen, select this option.

e I Have the App: When you have the XEA app installed on your smartphone, select this option.
e Android: To install the XEA app from Google Play Store, select this option.

e i0S: To install the XEA app from Apple App Store, select this option.

If you have the XEA app installed on your smartphone already, then touch I Have the App.
Connect to Xerox Easy Assist Mobile App screen appears with a QR Code.

To connect the printer to the app, scan the QR Code through the XEA app, then follow the instructions that
appear on your smartphone and the control panel.

To view the Wireless network information, touch Manual Entry. The Wi-Fi Direct information appear on the
control panel touchscreen. To connect the printer to the app, you can type the Wi-Fi Direct information
manually on the XEA app.

{-:'-"' Note: If the printer and mobile device cannot communicate, ensure that they are on the same network.

To return to the Connect to Xerox Easy Assist Mobile App screen, touch Close.

To return to the Xerox Easy Assist App main screen, touch Back.
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Adding Multiple Printers to the Xerox Easy Assist App

If your printer is already set up on your network and the Initial Setup Wizard is complete, through the XEA app, you
can include additional printers directly to the list of My Printers. To add printers that are on the network, open the
XEA app Home page. On the My Printers screen, touch the + icon, then refer to the following options:

e Setting Up a New Printer: To set up a new printer from your smartphone XEA app, at the Add Printer screen,
select Set Up a New Printer. Follow the instructions that appear on the printer control panel and your mobile
device.

e Adding an Existing Printer: To add an existing printer from the network, select any one from the options:

— QR Code: To scan the printer QR Code with the XEA app scanner, touch QR Code. To find the QR Code of
the printer, refer to After Initial Installation: Connecting to the Xerox® Easy Assist App from the Control
Panel.

— IP Address: To connect to the printer by typing the IP Address manually, touch IP Address. Type the IP
Address of the printer, then touch OK. To find the IP Address of the printer, refer to Finding the IP Address
of Your Printer.

e Finding the Nearby Network Printers: When your smartphone is connected to the same wireless or wired
network as the printer, to find nearby printers, select Printers Around Me. The app looks for nearby printers on
the network:

— If the app finds the printer, you can select and add the printer directly.

— If the app is unable to find the printer you are looking for, then you can add the printer by typing its IP
address.

{':'-". Note: If the printer and mobile device cannot communicate, ensure that they are on the same network.
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Jobs

JOBS OVERVIEW

You can use Jobs to view current jobs, print saved and secure jobs, and view details
about completed jobs. You can pause, delete, print, or view job progress or job details for
a selected job.

JOB OPTIONS

The following job options are available:

OPTION DESCRIPTION

Interrupt Button | When enabled by the System Administrator, pressing the Interrupt
E button allows you to pause the current job to run a more urgent job.

{_-:.'-" Note: Sometimes this option is hidden from view. To enable
the Interrupt function, refer to the System Administrator Guide
at www.xerox.com/office/VLB620docs.

Pause Button Pressing the Pause button allows you to temporarily pause an active
n print job. The job pauses with the option to resume printing or to
delete the job.

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can
interrupt, pause, or delete jobs that are printing. You can also view job progress or job details for a selected job.

A print job can be held by the printer when it is unable to complete the job. For example, if the printer needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. When you
send a Secure Print job, the job is held until you release it by entering a passcode at the control panel. For more
details, refer to Managing Special Job Types.

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs. For more
details, refer to Managing Jobs using the Embedded Web Server.

Interrupting Printing

System Administrators can allow users to interrupt active print jobs. For details about Interrupt Printing
Enablement, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

1. At the printer control panel, press the Home button.
2. Touch Jobs.

A list with active jobs, that are queued for the printer, appears.
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3. At the control panel, touch the Interrupt button. The printer continues to print while it determines the best
place to pause the spooled print job.

4. Printing stops to allow the printer to complete another job.

5. To resume printing, touch the Interrupt button again.

Pausing or Deleting a Print Job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
A list with active jobs, that are queued for the printer, appears.
3. To pause a job that is printing, touch the Pause button on the control panel.
4, Select a task.
e To resume the print job, touch Resume.
e To delete the print job, touch Delete. At the prompt, touch Delete.

5. To return to the Home screen, press the Home button.

Printing a Job Held for Resources

When a job is held for resources, a status message and a pop-up alert appear on the control panel, as default. From
the Embedded Web Server, the system administrator can configure whether only a status message appears or both
status message and a pop-up alert appear on the control panel.

1. If the pop-up alert is disabled by the system administrator, to view the held jobs, do the following:
a. At the printer control panel, press the Home button.
b. Touch Jobs.
A list with active jobs, that are queued for the printer, appears.

2. When the pop-up alert is enabled, if a job is held for resources, a pop-up alert appears on the control panel. On
the pop-up alert, touch View Active Jobs.

A list with active jobs, that are queued for the printer, appears.
3. From the jobs list, touch the held job name. The following options appear:

« Print On Alternate Paper: To choose an alternative paper source to enable the job to print, touch Print On
Alternate Paper. Select a paper tray, then touch OK.

e Delete: To delete the print job, touch Delete. At the prompt, touch Delete.
e Job Progress: To view the progress, touch Job Progress.

e Job Details: To view the details, touch Job Details. At the prompt, you can view the Job Settings and
Required Resources.
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4. To print the job, replenish the resources required. The job resumes automatically when the required or alternate
resources are available.

{'f-". Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about
the Print On Alternate Paper option, refer to the System Administrator Guide at www.xerox.com/office/
VLB620docs.

5. Toreturn to the Home screen, press the Home button.

MANAGING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents that are sent to the printer and stored there for future use. All users can print or delete a
Saved Job.

At the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server, in
the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.

Printing using Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e For Macintosh, in the Print window, in the print options list, click Xerox Features.
3. For Job Type, select Saved Job.
a. Type ajob name or select a name from the list.
b. Type a folder name or select a name from the list.
c. Toadd a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.
4. Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Printing, Deleting, Moving, or Copying a Saved Job in the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe Embedded Web Server, click Home.
3. Click Jobs.
4. Click the Saved Jobs tab.
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For the job that you want to process, select the check box.

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print

1.

In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

For Job Type, select Secure Print.

Type the passcode, confirm the passcode, then click OK.

Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print Job

1.

&-ow N

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Secure Jobs.

Do one of the following:

e If you submitted a single Secure Print job, touch the folder, then touch the job. Enter the passcode number,
then touch OK. The job prints automatically.

e If you submitted multiple Secure Print jobs, touch the folder, enter the passcode number, then touch OK.
Select an option:

e To print a single Secure Print job, touch the job required.
e To print all the jobs in the folder, touch Print All

e To delete a single Secure Print job, touch the Trash icon. At the prompt, touch Delete.

Xerox® VersaLink® B620 Printer User Guide 93



Xerox® Apps

e To delete all the jobs in the folder, touch Delete All.
{-:'-"' Note: After a Secure Print job prints, the printer deletes it automatically.

5. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.
After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Sample Set
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

{-:'-"' Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

4. Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.
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MANAGING JOBS USING THE EMBEDDED WEB SERVER

In the Embedded Web Server Active Jobs list, you can view a list of active jobs and delete print jobs. You can use
the Embedded Web Server to submit jobs for printing at the device. You can use the Job Submission feature to print
.ps, .pdf, .pcl, and .xps files without installing a print driver. You can select jobs for printing from your local computer
hard drive, mass storage devices, or a network drive.

Saved jobs are documents sent to the printer and stored there for future use. Any saved jobs appear on the Saved
Jobs page. Use the Saved Jobs page to view, print, and delete saved jobs, and create and manage folders in which
they are stored.

To manage jobs using the Embedded Web Server:

1.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Jobs.

Click the job name.

From the menu, select an option.

e To pause the print job, click Pause, then click Go.

e To delete the print job, click Delete, then click Go. At the prompt, click OK.

To return to the Home screen, click Home.

Submitting Jobs for Printing using the Embedded Web Server

1.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.

Click Print.

For File Name, click Browse or Choose File, then do one of the following steps.

¢ Navigate to the file, then select it.

e Type the path to the file that you want to select.

In the Printing areq, for Copies, select Auto, or enter the number of copies to print.

For Job Type, select an option:

e Normal Print: This option prints a job immediately.

e Secure Print: This option prints a job after you enter your passcode at the printer control panel.

e Sample Set or Proof Print: These options print one copy of a multiple-copy print job. The device holds the
remaining copies in memory until you release them for printing at the control panel.

e Save Job for Reprint: This option saves a print job in a folder on the print server for future printing. You can
specify a job name and folder.

e Delay Print: This option prints a job at a specified time up to 24 hours from the original job submission.

As needed, for Paper Selection, select paper size, color, type, and tray.
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8. As needed, select job options.
e 2-Sided Printing
e Collate
e Orientation

e Output Destination
2~ Note: The available options vary by device.

9. If Accounting is enabled, enter your User ID and Account ID.

10. Click Submit Job.

Reprinting Saved Jobs using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

o v &~ w N

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.
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Print From

PRINT FROM OVERVIEW

You can use the Print From App to print jobs from various sources. You can print jobs
stored in a print-ready format from a USB stick. You can print saved jobs and jobs stored

in a mailbox.

To create a print-ready file, when you print your documents from programs such as
Microsoft Word, select the print to file option. Check with your specific publishing
application for options to create print-ready files.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs.

If authentication or accounting is enabled on your device, to access features, enter your login details.

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
{;ﬁ" Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1. Insert the USB Flash drive into the USB port on the printer.
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2. At the USB Drive Detected screen, touch Print from USB.

Warning: To avoid loss of data or printer malfunction, do not touch the flash drive or the printer in the
area shown while actively printing, reading, or writing from the memory device.
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{ﬁ-} Note: If the Print from USB feature does not appear, enable the feature or contact your system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

3. To select a file for printing, browse the file, then touch the check box. If multiple files require printing, browse
each file, then select the check box for each file.

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e Toremove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
Adjust the feature settings as needed.
Touch Print.

When you are finished, remove the USB Flash drive.

o 0 N o

To return to the Home screen, press the Home button.

PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

Touch Saved Jobs, then touch the name of the folder that contains the saved job.
Touch the name of the saved job that you want to print.

Select the options for paper supply, quantity, 2-sided printing, and finishing.

v W N

Touch Print.

{i} Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.
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6. To print another saved job, touch the current job name, then touch Remove. Touch Add Document, touch
Saved Jobs, then navigate to the job required.

7. To return to the Home screen, press the Home button.
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@PrintByXerox

@PRINTBYXEROX OVERVIEW

You can use the Xerox® @PrintByXerox App to print email attachments and documents sent
to your printer from mobile devices.

When your Xerox device is connected to the Internet, the @PrintByXerox App works with
Xerox® Workplace Cloud for simple email-based printing.

{'1"!'. Note: The @PrintByXerox App is free to use. For more advanced workflows, use Xerox® Workplace Cloud. The

Xerox® Workplace Cloud software requires a specific licence. For details, refer to the Xerox® @PrintByXerox
App Quick Start Guide available at www.xerox.com/XeroxAppGallery.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs.

If authentication or accounting is enabled on your device, to access features, enter your login details.

PRINTING WITH THE @PRINTBYXEROX APP

1.

100
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Send an email with an attachment that contains a supported file type to Print@printbyxerox.com.
First-time users receive a response email with a user ID and password.

At the Xerox device control panel, press the Home button.

Touch @PrintByXerox.

Enter your email address, then touch OK.

On the enter password screen, enter your password using the touch screen keypad, then touch OK.
Select the documents that you want to print.

To modify print settings, touch Print Settings, then touch OK.

To release your print jobs, touch Print.

e ASubmitting Jobs to Print message and the conversion state appear.

e When the documents begin to print, a green check mark appears.
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Xerox® Connect for XMPie

XEROX® CONNECT FOR XMPIE APP OVERVIEW

The Xerox® Connect for XMPie App, provides instant access to 50 or more templates. With
one touch, you can create personalized content from your printer.

Use the Xerox® Connect for XMPie App for free access to templates, with the ability to
personalize them for immediate printing.

To configure the Connect for XMPie App on your printer, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/VLB620docs.

To use the Connect for XMPie App from the Home screen, touch Connect for XMPie, The main screen displays
Featured Products and Product Categories. You can browse the categories for the products that you want to create.
Follow the instructions on screen to create a job with customized fields. You can preview and print as needed. For
more information on XMPie, go to www.support.xerox.com and in the Search box, type XMPie.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.
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Printing Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected to an active
network. Ensure that you have the correct print driver software installed on your computer. For details, refer to
Installing the Print Driver Software.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and type.

3. Access the print settings in your software application. For most software applications, for Windows, press CTRL
+P, or for Macintosh, press CMD+P.

4. Select your printer.

5. To access the print driver settings, for Windows, select Printer Properties, Print Options, or Preferences. For
Macintosh, select Xerox Features. The name of the option can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.
7. To send the job to the printer, click Print.

8. If you selected a special job type, for example Secure Print or Sample Print, your job is held at the printer and
requires further action to print. To manage jobs at the printer, use the Jobs app.

For further information on managing print jobs, refer to Managing Jobs.
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Selecting Printing Options

Printing options, also called print driver software options, are specified as Printing preferences in Windows and
Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality.
Printing options that you set from Printing preferences within the Devices and Printers window become the default
setting. Printing options that you set within the software application are temporary. The application and the
computer do not save the settings after the application is closed.

{_-:.'-“' Note: For Windows 10 and later, Printing options can be set from Printing preferences within the Printers &
scanners setting.

PRINT DRIVER HELP

Xerox® print driver software Help information is usually available from the Printing Preferences window. To see the
help, click the Help (?) button in the bottom-left corner of the Printing Preferences window.

Information about Printing Preferences appears in the Help window. From this window, you can select by topic or
use the search field. In the search field, enter the topic or function required.

WINDOWS PRINTING OPTIONS

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings that are specified in the
Printing Preferences window. You can specify your most common printing options and save the options for reuse so
that you do not have to change the settings each time that you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing
Preferences.
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1. On your computer, navigate to the list of printers:
e For Windows Server 2012 and later, click Start > Settings > Printers.
e For Windows 10, click Start > Settings > Devices > Printers & scanners.

e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

_:-"'" Note: If you are using a custom Start menu application, the application can change the navigation path to
your list of printers.

2. For your printer, select Printing preferences:
e For Windows Server 2012 and later, right-click the icon for your printer, then click Printing preferences.
e For Windows 10, click the icon for your printer, then click Manage > Printing preferences.
e For Windows 11 and later, click the icon for your printer, then click Printing preferences.

3. Inthe Printing Preferences window, click a tab, then select the options. To save the settings, click OK.

¥ Note: For more information about Windows print driver options, click the Help button (?) in the Printing

Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before sending the job
to the printer.

1. With the document open in your software application, access the print settings. For most software applications,
click File > Print or press CTRL+P for Windows.

2. To open the Printing Preferences window, select your printer, then click the Printer Properties, Print Options,
or Preferences button. The title of the button can vary, depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.
4. To save your selections and close the Printing Preferences window, click OK.

5. To send the job to the printer, click Print.

Selecting Printing Defaults in Windows for a Shared Network Printer
1. On your computer, navigate to the list of printers:
e For Windows Server 2012 and later, click Start > Settings > Printers.
e For Windows 10, click Start > Settings > Devices > Printers & scanners.

e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

_i-""' Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
Personalize. Select Control Panel Home > Devices and Printers.

2. For your printer, select Printer properties:
e For Windows Server 2012 and later, right-click the icon for your printer, then click Printing properties.
e For Windows 10, click the icon for your printer, then click Manage > Printer properties.

e For Windows 11 and later, click the icon for your printer, then click Printing preferences.
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In the printer Properties dialog box, click the Advanced tab.
On the Advanced tab, click Printing Defaults.

On the print driver tabs, make your selections as needed, then click Apply.

o v &~ W

To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs. After you save a set of
print options, they are available for selection from the Saved Settings or Presets list, or the 1-Touch areq, if
available.

To save a set of printing options:

1. With the document open in your application, click File > Print.

To open the Printing Preferences window, select your printer, then click Properties or Preferences.
In the Printing Properties window, click the tabs, then select the required settings.

In the Printing Properties window, click Saved Settings or Presets, then click Save As.

v & WwWN

Type a name for the saved setting or preset, then choose preset options, if available:
e Choose an icon for the preset.

e To enable the preset as 1-Touch, select 1-Touch Preset.

e To share the preset in all print drivers, select Show this Preset in All Drivers.

6. Click OK.

7. To print with these settings:

e From the Saved Settings or Presets list, select the name of the preset.

e For a 1-Touch preset, click 1-Touch, then click the required 1-Touch preset.
MACINTOSH PRINTING OPTIONS

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.

2. Select your printer.

3. In the Print window, in the print options list, click Xerox Features.
" Note: To see all printing options, click Show Details.

4. Select any other required printing options from the lists.

5. To send the job to the printer, click Print.
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Saving a Set of Commonly Used Printing Options for Macintosh
You can define and save a set of options, so that you can apply them to future print jobs.
To save a set of printing options:
1. With the document open in your application, click File > Print.
2. Select your printer from the Printers list.
3. Select the required printing options from the lists in the Print dialog box.
27 Note: To see all printing options, click Show Details.
4. Click Presets > Save Current Settings as Preset.
5. Type a name for the printing options. To save the set of options in the Presets list, click OK.

6. To print using these options, select the name from the Presets list.

UNIX, LINUX, AND AS/400 PRINTING

To provide printer spooling and network print server functionality, UNIX-based printing uses LPD/LPR port 515 or Ip
to port 9100. Xerox printers can communicate using either protocol.

Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in UNIX and
Linux environments.

Xerox® Printer Manager allows you to:

e Configure and check the status of network connected printers.

e Set up a printer on your network and monitor the operation of the printer once installed.
e Perform maintenance checks and view supplies status at any time.

e Provide a common look and feel across the many different suppliers of UNIX and Linux operating systems.

Installing Xerox® Printer Manager
Before you begin, ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install Xerox® Printer Manager:
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1. Download the appropriate package for your operating system. To locate print drivers for your printer, go to
www.xerox.com/office/VLB620drivers. The files available are:

e XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm for the IBM PowerPC family.
o XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz to support HP Itanium workstations.
e XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm to support RPM-based 32-bit Linux environments.
o XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.deb to support Debian-based 32-bit Linux environments.
o XeroxOfficev5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm to support RPM-based 64-bit Linux environments.
o XeroxOfficev5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb to support Debian-based 64-bit Linux environments.
e XeroxOSDPkg-Sun0Si386-x.xx.xxx.xxxx.pkg.gz for Sun Solaris x86 systems.
e XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg.gz for Sun Solaris SPARC systems.
2. Toinstall the custom print driver, log in as root, then type the appropriate command for your system:
e AIX: rpm -U XeroxOSDPkg-AIXpOWEeIrpPC—X.XX . XXX . XXXX . rpm

e HPUX: swinstall -s XeroxOSDPkg-HPUXia64-x.xxX.xxXx.xxxx.depot.gz \*

Solaris, x86 based: pkgadd —d XeroxOSDPkg-Sun0Si386-x.xX.XxX.XxXxX.pkg

Solaris, SPARC based: pkgadd -d Xerox0OSDPkg-SunOSsparc—x.xX.XxX.XxXx.pkg
The installation creates a Xerox directory in /opt/Xerox/prtsys.

3. Toinstall the Xerox® Office Standard Driver on Linux platform, log in as root, then type the appropriate
command for your system:

e Linux, RPM based: rpm -U XeroxOfficev5Pkg-Linuxi686-x.Xx.XxXX.xXXXX.rpm
e Linux, Debian based: dpkg -1 XeroxOfficev5Pkg-Linuxi686-x.xXx.xXx.xXxX.deb

The installation creates a XeroxOffice directory in /opt/XeroxOffice/prtsys.

Launching Xerox® Printer Manager
To launch Xerox® Printer Manager:

1. From your computer, access a command window. At the command prompt, log in as root, then type
xeroxofficeprtmgr.

2. Press Enter or Return.

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common UNIX Printing
System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate drivers for your
printer, go to www.xerox.com/support/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for installing and
building CUPS are contained in the CUPS Software Administrators Manual, written and copyrighted by Easy
Software Products. For complete information on CUPS printing capabilities, refer to the CUPS Software Users
Manual available from www.cups.org/documentation.php.
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Installing the PPD File on the Workstation

1. On the Xerox Support website, from the Drivers and Downloads page, download the Xerox® PPD for CUPS
(Common UNIX Printing System).

2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location of the
folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD file.

Adding the Printer
1. Verify that the CUPS (Common UNIX Printing System) daemon is running.
Open a Web browser, type http://localhost:631/admin, then press Enter or Return.

For User ID, type root. For password, type the root password.

&~ W N

Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type 1p ~dprinter filename, then press Enter.

2. To print to a specific printer in Berkeley, type 1pr -Pprinter filename, then press Enter.

AS/400

Xerox provides Work Station Customization Object (WSCO) files to support IBM i V6R1 or later. A Work Station
Customization Object is a lookup table that the host print transform (HPT) uses to translate AS/400 commands to
the equivalent PCL code that is specific to a particular printer. A WSCO file can modify many print features,
including: paper input tray, 2-sided printing, characters per inch, lines per inch, orientation, fonts, and margins.

The XTOOLS library provides a source WSCO file for each supported Xerox® printer or device. The library and
installation instructions are available from www.support.xerox.com.

To install the XTOOLS library, select the downloadable files for the IBM AS/400 operating system, unzip the
downloaded XTOOLSxxxx . zip file, then follow the instructions to install the library. Download and install the
library only once.

7 Note:
e The host print transform works only on AFPDS and SCS files. To use the WSCO for printing, convert IPDS-
formatted printer files to AFPDS files.

e Administrator credentials with IOSYSCFG permissions are required to create a device description or a
remote queue.

e For details on AS/400, refer to the IBM AS/400 Printing V, (Red Book), available on the IBM website.

Installing the WSCO Library and Setting Up Print Queues

For detailed instructions on installing the WSCO library and setting up print queues, refer to the installation
instructions that are included with the library.
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MOBILE PRINTING OPTIONS

This printer can print from i0S and Android mobile devices.

Printing Using Wi-Fi Direct

To print a document from a Wi-Fi-enabled mobile device:

1. On the mobile device, open the document that you want to print.

In the device application, select the Print button.

If there is more than one printer in the area with Wi-Fi Direct enabled, select the required printer from the list.

Select the print settings required for the job.

v & WwWN

Submit the job for printing.
A message appears on the mobile device.
6. Select Connect.
When the connection is made, a message appears on the printer.
7. At the printer control panel, touch OK.

The job prints.

Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint® for your printer,
refer to Configuring AirPrint.

To print with AirPrint®:
1. Open the email, photograph, webpage, or document that you want to print.
Tap the Action icon.

Tap Print.

&ow N

Select your printer, then set the printer options.
Tap Print.

For more information on configuring and using AirPrint®, refer to the System Administrator Guide at www.xerox.
com/office/VLB620docs.

Printing with Universal Print

To allow users to access the device, the Azure® administrator needs to share the printer in the Azure® portal. After
the printer is shared, the Add Printer feature enables an authorized user to discover the device in Windows 10 or
later. The device appears as the cloud printer in the discovered printers list. To enable Universal Print for your printer,
refer to Configuring a Device for Universal Print.
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1. To add a printer in Windows® Operating System, do the following:
e For Windows 10, click Settings > Printers & scanners > Add a printer or scanner.

e For Windows 11 and later, click Settings > Bluetooth & devices > Printers & scanners > Add a printer or
scanner.

2. Select the cloud printer in the list of discovered printers, then click Add device.

{-:'-"' Note: When a print job is submitted to Universal Print, it is queued in the cloud until the printer fetches the
job. The printer checks for jobs after the polling interval elapses, or when you initiate the Check For Jobs
Now function.

Printing from a Mopria-Enabled Mobile Device

Mopria is a software feature that enables users to print from mobile devices without requiring a print driver. You can
use Mopria to print from your mobile device to Mopria-enabled printers.

= Note:
e Mopria and all of its required protocols are enabled by default.

e Ensure that you have the latest version of the Mopria Print Service software installed on your mobile
device. You can obtain a free download of the software from the Google Play Store.

e To connect the printer to Wi-Fi or Wi-Fi Direct, purchase and install the Xerox Wireless Network Adapter.
For more information, refer to the Xerox® Dual Band Wireless Kit Hardware Install and Setup instructions
that are included with the kit.

e To use Wi-Fi Direct, in the Embedded Web Server, enable the Wi-Fi Direct feature. For details on
configuring Wi-Fi Direct, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

e To configure the Wireless settings, ensure that devices are connected to the same wireless network as the
printer.

e The name and location of your printer appears in a list of Mopria-enabled printers on connected devices.

To print using Moprig, follow the directions that are provided with your mobile device.
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Print Jobs

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can pause,
delete, print, or view job progress or job details for a selected job. When you send a secure print job, the job is held
until you release it by typing a passcode at the control panel. For details, refer to Printing Special Job Types

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs.

Pausing, Promoting, or Deleting a Job Waiting to Print

1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the required print job.

3. Select atask.

&

Note: If you do not make a selection, the job automatically resumes after the set timeout period.

To pause the print job, touch Hold. To resume the print job, touch Release.
To delete the print job, touch Delete. At the prompt, touch Delete.

To move the job to the top of the list, touch Promote.

To view the status of the job, touch Job Progress.

To view information about the job, touch Job Details, then touch Job Settings or Required Resources.

4. To return to the Home screen, press the Home button.

&

Note:

e The system administrator can restrict users from deleting jobs. If a system administrator restricts job
deletion, you can view the jobs, but you cannot delete them.

e Only the user that sent the job, or the system administrator, can delete a Secure Print job.

Printing a Job Held for Resources

When a job is held for resources, a status message and a pop-up alert appear on the control panel, as default. From
the Embedded Web Server, the system administrator can configure whether only a status message appears or both
status message and a pop-up alert appear on the control panel.

1. If the pop-up alert is disabled by the system administrator, to view the held jobs, do the following:

a.

b.

At the printer control panel, press the Home button.
Touch Jobs.

A list with active jobs, that are queued for the printer, appears.

2. When the pop-up alert is enabled, if a job is held for resources, a pop-up alert appears on the control panel. On
the pop-up alert, touch View Active Jobs.

A list with active jobs, that are queued for the printer, appears.

Xerox® Versalink® B620 Printer User Guide 113



Printing

3. From the jobs list, touch the held job hame. The following options appear:

e Print On Alternate Paper: To choose an alternative paper source to enable the job to print, touch Print On
Alternate Paper. Select a paper tray, then touch OK.

e Delete: To delete the print job, touch Delete. At the prompt, touch Delete.
e Job Progress: To view the progress, touch Job Progress.

e Job Detadils: To view the details, touch Job Details. At the prompt, you can view the Job Settings and
Required Resources.

4. To print the job, replenish the resources required. The job resumes automatically when the required or alternate
resources are available.

{':'-". Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about
the Print On Alternate Paper option, refer to the System Administrator Guide at www.xerox.com/office/
VLB620docs.

5. Toreturn to the Home screen, press the Home button.

PRINTING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents that are sent to the printer and stored there for future use. All users can print or delete a
Saved Job.

At the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server, in
the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.

Printing using Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e For Macintosh, in the Print window, in the print options list, click Xerox Features.
3. For Job Type, select Saved Job.
a. Type ajob name or select a name from the list.
b. Type a folder name or select a name from the list.
c. To add a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.
4. Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.
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Print, Delete, Move, or Copy a Saved Job in the Embedded Web Server

1.

o v &~ W N

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.

Click Jobs.

Click the Saved Jobs tab.

For the job that you want to process, select the check box.

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print

1.

In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

For Job Type, select Secure Print.

Type the passcode, confirm the passcode, then click OK.

Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print Job

1.
2.
3.

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Secure Jobs.
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4. Do one of the following:

e If you submitted a single Secure Print job, touch the folder, then touch the job. Enter the passcode number,
then touch OK. The job prints automatically.

e If you submitted multiple Secure Print jobs, touch the folder, enter the passcode number, then touch OK.
Select an option:

e To print a single Secure Print job, touch the job required.
e To print all the jobs in the folder, touch Print All
e To delete a single Secure Print job, touch the Trash icon. At the prompt, touch Delete.

e To delete all the jobs in the folder, touch Delete All.
{-:'-"' Note: After a Secure Print job prints, the printer deletes it automatically.

5. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.
After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Sample Set

1. At the printer control panel, press the Home button.
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2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

{-:'-"' Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

4, Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.

Xerox® Versalink® B620 Printer User Guide 117



Printing

Printing Features

SELECTING PAPER OPTIONS FOR PRINTING

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on
the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the
desired paper.

e To locate paper options in Windows, in the print driver, click the Printing Options tab.

e To locate paper options on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Paper/Output.

Select By Tray

Use Select By Tray to print from a specific tray without specifying paper attributes in the print driver or at the printer
control panel. This option prints the job from the selected tray, even when more than one tray contains the correct
paper for the job.

The following options are available:

e Automatically Select: This option prints from any tray that is loaded with the size and type of paper that is
required for the print job.

e Tray X: This option prints from the selected tray.

o Bypass Tray: This option prints from the manual-feed tray. The printer prompts you to remove any other paper
from the tray and load the paper that is required for your job.

{-:'-"' Note: To prevent paper jams, load the trays with the correct size and type of paper for the print job.

Scaling

Scaling reduces or enlarges the original document to match the selected output paper size.

e For Windows, the scale options are on the Printing Options tab, in the Paper field.

e For Macintosh, the scale options are in the Print window. To view more printing options, click Show Details.
“ Note: Not all options described are supported on all printers. Some options apply only to a specific printer

model, configuration, operating system, or print driver type.

The following scaling options are available:

o Fit to New Paper Size: This option scales the document to fit the new paper size.

e Change Document Size: Use this setting to match the paper size selected in your application. This option does
not change the size of the page image printed on the output paper.

e Automatically Scale: This option scales the document to fit the selected Output Paper Size. The scaling
amount appears in the percentage box below the sample image.

e No Scaling: This option does not change the size of the page image printed on the output paper,and 100%
appears in the percentage box. If the original document size is larger than the output size, the page image is
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cropped. If the original document size is smaller than the output size, extra space appears around the page
image.

e Manually Scale: This option scales the document by the amount entered in the percentage box below the
preview image.

PRINTING ON BOTH SIDES OF THE PAPER

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses
the settings for portrait or landscape orientation from the application for printing the document.

{-:'-"' Note: Ensure that the paper size and weight are supported. For more information, refer to Supported Paper.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings
override the application page orientation settings.

e 1-Sided Print: This option prints on one side of the media. Use this option when printing on envelopes, labels,
or other media that cannot be printed on both sides.

e 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long edge of the
paper. The following illustrations show the result for documents with portrait and landscape orientations,
respectively:

1] B

e 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print to allow
binding on the short edge of the paper. The following illustrations show the result for documents with portrait
and landscape orientations, respectively:

2 13

{':'"'. Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Selecting Printing Options.

PRINT QUALITY

The Windows PostScript (PS) print driver, PCL, and the Macintosh print drivers provide the highest print-quality
modes:

e High Resolution: This print-quality mode prints halftones at 1200 x 1200 dpi, 1-bit depth.
e Enhanced: This print-quality mode prints halftones at 600 x 600 dpi, 8-bit depth.
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IMAGE OPTIONS

Image options controls how the printer uses lightness and contrast to produce your document. The Windows
PostScript print driver and the Macintosh print drivers provide the widest range of controls on the Image Options
tab.

¢ To locate Image Options in Windows, in the print driver, click the Image Options tab.

e To locate Image Options on Macintosh, in the Print window, in the print options list, click Xerox Features.
Within Xerox Features, in the options list, click Image Options.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in your printed
job.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

PRINTING MULTIPLE PAGES TO A SINGLE SHEET

When printing a multiple-page document, you can print more than one page on a single sheet of paper.
Toprint 1, 2, 4,6, 9, or 16 pages per side, on the Page Layout tab, select Pages Per Sheet.

e To locate Pages Per Sheet in Windows, on the Document Options tab, click Page Layout.

e To locate Pages Per Sheet on Macintosh, in the Print window, in the print options list, click Layout.

1 L]

To print a border around each page, select Page Borders.

PRINTING BOOKLET LAYOUT

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets from any
paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four-page images per sheet of paper, two-page
images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create
the booklet.

e To locate booklet creation in Windows, on the Document Options tab, click Page Layout.

e To locate booklet creation on Macintosh, in the Print window, in the print options list, click Xerox Features.
Within Xerox Features, in the options list, click Booklet Layout.
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When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.
e QGutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).

e Creep: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the
thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can
select a value from 0 to 1 point.

GUTTER CREEP

.. N s =
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{.'i-'} Note: To print a border around each page, select Page Borders.

USING SPECIAL PAGES
The Special Pages options control how covers, inserts, and exception pages are added to your printed document.
e To locate Special Pages in Windows, on the Document Options tab, click Special Pages.

e To locate Special Pages on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Special Pages.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages that are
different from the source used for the body of a document. For example, you can use your company letterhead for
the first page of a document. You can use heavyweight paper for the first and last pages of a report. You can use
any applicable paper tray as the source for printing cover pages.

In the Covers window, the following options are available:

e No Covers or Disabled: This option does not print cover pages. No cover pages are added to the document.
e Front Only: This option allows you to add a blank or printed front cover to your job.

e Back Only: This option allows you to add a blank or printed back cover to your job.

e Front and Back: Same: This option adds a front and back cover to your job, and applies the same printing and
paper settings for both covers.

e Front and Back: Different: This option adds a front and back cover to your job, and allows you to select
different printing and paper settings for each cover.

After you make a selection for printing the cover pages, you can select the paper for the front and back covers by
size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two, or both sides of the
cover pages.
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Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated pages within
a document. The addition of an insert after designated pages within a document separates sections, or acts as a
marker or placeholder. Ensure that you specify the paper to use for the insert pages.

In the Inserts window, you can set the location, characteristics, and paper settings for the insert pages:
o Inserts: This option allows you to select where to place the insert.
e Quantity: Use this option to specify the number of pages to insert at each location.

e Pages: Use this option to specify where to place the inserts within the job. Separate individual pages or page
ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and
11,type 1, 6, 9-11.

e Paper Settings: This option allows you to select the paper size, color, and type to use for the insert pages. To
use the same paper size, color, or type as the main body of the job, select Use Job Setting.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences, such as
page size, page type, and page color. You can change the side of the paper on which to print as your job requires. A
print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special paper, and
the remainder of the pages printed 2-sided on regular paper. You can use exception pages to print the job.

In the Exceptions window, you can set the location, characteristics, and paper settings for the exception pages:

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate individual
pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages
1,6,9,10,and 11, type 1, 6, 9-11.

e Paper Settings: Allows you to select the paper size, color, and type to use for the exception pages. To print
exception pages on the same paper size, color, or type as the main body of the job, select Use Job Setting.

e 2-Sided Printing: Allows you to select 2-sided printing options for the exception pages. Available options are:
— 1-Sided Print: Prints the exception pages on one side only.

—  2-Sided Print: Prints the exception pages on both sides of the paper and flips the pages on the long edge.
You can bind the job on the long edge of the pages.

— 2-Sided Print, Flip on Short Edge: Prints the exception pages on both sides of the paper and flips the
pages on the short edge. You can bind the job on the short edge of the pages.

— Use Job Setting: Prints the job using the same 2-Sided Printing setting that is selected for the main body
of the job.

¥ Note: Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected

results.
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PRINTING ANNOTATIONS FOR WINDOWS

An annotation is special-purpose text or an image that you can print across one or more pages. You can preview
annotations in the Annotations Preview pane.

The annotations setup for your print job
# Note:

e This feature is available only on a Windows computer printing to a network printer.

e Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

appears in the Annotations summary list. From this list, you can select an annotation to edit or delete.
To print an annotation:

1. Inthe print driver, click the Document Options tab.

2. Click the Annotations tab.

3. Toadd a text annotation, click Add Comment. Enter the text in the field, select the required settings, then click
OK.

4. For a date or time stamp, click Add Time Stamp. Specify the date and time option, select the required settings,
then click OK.

5. To add a picture annotation, click Add Picture. To locate the picture, click the Browse icon. Select the required
settings, then click OK.

6. For each annotation, the following options are available:
e To specify the font, click the Font button.

e For a picture annotation, select the scaling option that specifies the size of the picture in relation to the
original image. Use the arrows to scale the image in increments of 1%.

o To define the angle of the annotation on the page, specify the position option. Or, to rotate the annotation
left or right by increments of 1, use the arrows.

e To define the location of the annotation on the page, specify the position option. Or, to move the
annotation in each direction in increments of 1, use the arrows.

e To adjust the transparency of the annotation, move the slider. To increase transparency, move the slider to
the right, or to decrease transparency, move the slider to the left.

e For Layering, select an option:
— Print in Background: This option prints the annotation behind the text and graphics in the document.
— Print in Foreground: This option prints the annotation over the text and graphics in the document.
e For Pages, select the pages to print the annotation:
— Print on All Pages: This option prints the annotation on all pages of your document.
— Print on Page 1 Only: This option prints the annotation only on the first page of the document.
7. To save the annotation, click the Save Annotation icon.

8. To load a previously saved annotation, click the Load Annotation icon.
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9. Click OK.

PRINTING WATERMARKS FOR WINDOWS

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word
like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

# Note:

e This feature is available only on a Windows computer printing to a network printer.

e Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

e Watermarks are not supported for some print drivers when booklet is selected or when more than one
page is printed on a sheet of paper.

To print a watermark:
1. Inthe print driver, click the Document Options tab.
2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a
customized watermark. You can also manage watermarks from this menu.

4. Under Text, select an option:
e Text: Enter the text in the field, then specify the font.
e Time Stamp: Specify the date and time options, then specify the font.
e Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.

e Select the scaling option that specifies the size of the picture in relation to the original image. Use the
arrows to scale the image in increments of 1%.

o To define the angle of the image on the page, specify the position option, or to rotate the image left or
right by increments of 1, use the arrows.

e To define the location of the image on the page, specify the position option, or to move the image in each
direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark.
e Print in Background prints the watermark behind the text and graphics in the document.

e Blend: This option combines the watermark with the text and graphics in the document. A blended
watermark is translucent, so you can see both the watermark and the document content.

e Print in Foreground prints the watermark over the text and graphics in the document.
7. Click Pages, then select the pages to print the watermark:

e Print on All Pages prints the watermark on all pages of your document.

e Print on Page 1 Only prints the watermark only on the first page of the document.

8. If you select a picture as a watermark, specify the lightness settings for the image.
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9. Click OK.

ORIENTATION
Orientation allows you to select the direction that the page prints.

e To locate orientation options in Windows, on the Document Options tab, click Orientation.

{-:'-"' Note: The orientation setting in your application print dialog box can override the orientation options in the
print driver.

e To locate orientation options on Macintosh, in the Print window, click Show Details.
The following options are available:

e Portrait: Orients the paper so that the text and images print across the short dimension of the paper.

e Landscape: Orients the paper so that the text and images print across the long dimension of the paper.

X

¢ Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long bottom
side up.

{'1'"'. Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto Rotate check
box.

ADVANCED PRINTING OPTIONS

You can use the Advanced option or tab to set advanced printing options. Advanced printing selections apply to all
jobs that you print with the print driver.

{-:'-"' Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

Job Identification

You can use the Job ID feature to change the job identification setting for your print job. You can print the job
identification on a separate banner page or on the pages of your document.

The following options are available:
e Disable Job ID: This option directs the printer not to print a banner page.
o Print ID on a Banner Page: This option prints the job identification on a banner page.

e Print ID in Margins - First Page Only: This option prints the job identification on the first page of the
document in the top-left margin.
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e Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on every page of
the document.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.

Job Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen with the
name of the job and the name of the printer where it was printed.

{-:'-"' Note: This feature is only available on a Windows computer that is printing to a network printer.

The following options are available:
» Notify for Completed Jobs: This option provides a notification when the job has completed.

» Notify for Completed, but Altered Jobs: This option provides a notification on all jobs that completed with
restrictions.

* Notify for Failed or Canceled Jobs: This option provides notification of all jobs that failed to print or were
canceled.

e Play Alert Tone: This option sounds an alert tone when a notification appears.

Document Encryption for Windows Print Jobs

You can select encryption for your print job. The print file is encrypted before it is transmitted to the printer. The
print file is decrypted before it is printed.

This feature is available only when Document Encryption is set to Manually Encrypt Documents in the printer
properties of the printer. For details, refer to Setting Encryption Defaults in Windows.

{-:'-"' Note: This feature is available on a Windows computer that is printing to a network printer. It applies to the
PostScript and PCL print drivers.

Setting Encryption Defaults in Windows

1. Navigate to the list of printers on your computer:

For Windows Server 2012 and later, click Start > Settings > Printers.

For Windows 10, click the Windows Start > Settings > Devices > Printers & Scanners.

e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

{-:'-"' Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
Personalize. Select Control Panel Home > Devices and Printers.

2. For your printer, select Printing properties:
e For Windows Server 2012 and later, right-click the icon for your printer, then click Printer properties.
e For Windows 10, click the icon for your printer, then click Manage > Printer properties.

e For Windows 11 and later, click the icon for your printer, then click Printing preferences.
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3. Inthe Printer Properties dialog box, click the Administration tab.

4. For Configurations, click Document Encryption, then select an option:
e Disabled: This option disables encryption for all documents that you send to the printer.
e Encrypt All Documents: This option encrypts all documents that you send to the printer.

e Manually Encrypt Documents: This option allows you to set encryption for specific jobs that you send to
the printer.

{-:'-"' Note: Manually Encrypt Documents is the default printer setting.

5. Click Apply.

6. To save the settings, click OK.
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Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported by the
printer. For details, refer to Supported Paper.

DEFINING CUSTOM PAPER SIZES

To print on custom paper sizes, define the custom width and length of the paper in the print driver software and on
the printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the
tray. Setting the wrong size can cause a printer error. Print driver settings override control panel settings when you
print using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver
Custom-size paper settings are saved in the print driver and are available for you to select in all your applications.
For details on supported paper sizes for each tray, refer to Supported Paper.

For further details about creating and saving custom paper sizes in the print driver, click the Help (?) button in the
bottom-left corner of the printer settings window.

Creating and Saving Custom Sizes for the Windows V3 Print Driver
1. Inthe print driver, click the Printing Options tab.
For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > New.

In the New Custom Paper Size window, enter the height and width of the new size.

& W N

To specify the units of measurement, at the bottom of the window, click Measurements, then select Inches or
Millimeters.

5. Tosave, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for the Windows V4 Print Driver

1. From Windows Control Panel, select Devices and Printers.

2. Select the printer, then click Print server properties.
3. On the Forms tab, for Create a new form, click the check box.
4. For Form name, type a name for the new paper size.
5. Inthe Form description (measurements) areq, enter the settings:
e For Units, select Metric or English.
e For Paper size, enter measurements for Width and Height.
e For Printer area margins, enter measurements for Left, Right, Top, and Bottom.
{-:'-"' Note: Ensure that the measurements that you specify are within the supported ranges for the device.
6. Click OK.

The new paper size is added to the paper size list.
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Creating and Saving Custom Sizes for Macintosh

1. Inthe application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign ( +).
Double-click Untitled, then type a name for the new custom size.

Enter the height and width of the new custom size.

o v &~ W N

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User Defined
margins, set the top, bottom, right, and left margins.

7. To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from Fully Adjustable Trays and Bypass Tray. The High-Capacity Feeder (HCF)
supports only five paper sizes, it does not support custom-size paper. If 550-sheet standard trays are set to Fully
Adjustable mode, you can print custom-size paper from Trays 1-4, considering Tray 4 is not a HCF. The Bypass tray
is always set to Adjustable mode. Custom-size paper settings are saved in the print driver and are available for you
to select in all your applications.

{-:'-"' Note: To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Paper Tray
Settings.

1. Open the paper tray, then load the custom-size paper.
Close the tray.
At the control panel, to define the new paper size, touch Size, then touch Custom.

In the Custom Paper Size window, enter the height and width of the new paper size, then touch OK.

v W N

To confirm the settings, touch Confirm.

PRINTING ON CUSTOM-SIZE PAPER

{':'-". Note: Before you print on custom-size paper, define the custom width and length of the paper in the print
driver software and on the printer control panel. For more information, refer to Defining Custom Paper Sizes.

Printing on Custom-Size Paper from the Windows V3 Print Driver

{-:'-"' Note: Before you print on custom-size paper, define the custom size in the Printer Properties. For details, refer
to Creating and Saving Custom Sizes for the Windows V3 Print Driver.

1. Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select the required custom paper size and type.

Select any other required options, then click OK.

o v & W N

In the Print dialog box, click Print.

Xerox® VersalLink® B620 Printer User Guide 129



Printing

Printing on Custom-Size Paper from the Windows V4 Print Driver

{-:'-"' Note: Before you print on custom-size paper, define and save the custom paper size as a Form. For details,
refer to Creating and Saving Custom Sizes for the Windows V4 Print Driver.

1. Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select Other Size.

To select a custom paper size, select Fit to New Paper Size, then select the custom paper size.

Select any other required options, then click OK.

N o v W N

In the Print dialog box, click Print.

Printing on Custom-Size Paper from Macintosh

1. Load the custom-size paper. For details, refer to Loading Paper.
In the application, click File > Print.

From the Paper Size list, select the custom paper size.

Click Print.

&ow N

130 Xerox® VersaLink® B620 Printer User Guide



Printing

Print From

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
{_-:.'ﬁ" Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:
1. Insert the USB Flash drive into the USB port on the printer.
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2. At the USB Drive Detected screen, touch Print from USB.

Warning: To avoid loss of data or printer malfunction, do not touch the flash drive or the printer in the
area shown while actively printing, reading, or writing from the memory device.

A

{if Note: If the Print from USB feature does not appear, enable the feature or contact your system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/office/VLB620docs.

3. To select afile for printing, browse the file, then touch the check box. If multiple files require printing, browse
each file, then select the check box for each file.

Xerox® VersaLink® B620 Printer User Guide 131



https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB620&PgName=Man

Printing

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e To remove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
Adjust the feature settings as needed.
Touch Print.

When you are finished, remove the USB Flash drive.

o N oo

To return to the Home screen, press the Home button.

PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

Touch Saved Jobs, then touch the name of the folder that contains the saved job.
Touch the name of the saved job that you want to print.

Select the options for paper supply, quantity, 2-sided printing, and finishing.

v W N

Touch Print.

{'1'-". Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.

6. To print another saved job, touch the current job name, then touch Remove. Touch Add Document, touch
Saved Jobs, then navigate to the job required.

7. To return to the Home screen, press the Home button.

PRINTING FROM THE EMBEDDED WEB SERVER

You can print various file types, such as .txt, .pdf, .ps, and .pcl files directly from the Embedded Web Server without
the need of another application or the print driver. You can store files on a local computer hard drive, mass storage
device, or network drive.

To print from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

{':'-". Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Inthe Embedded Web Server, click the Print tab.

3. To select the file from a local network or remote location, for File Name, click Browse. Select the file, then click
Open.
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4. For Printing, select the required options for the job.
e Normal Print prints a job immediately.
e Secure Print prints a job after you enter your passcode at the printer control panel.

e Sample Set, or proof print, prints one copy of a multiple-copy print job and holds the remaining copies at
the printer.

e Save Job for Reprint saves a print job in a folder on the print server for future printing. You can specify a
job name and folder.

Delay Print prints a job at a specified time up to 24 hours from the original job submission.
5. Ifaccounting is enabled, enter your User ID and account information.

6. Click Submit Job.

{'f-". Note: To ensure that the job was sent to the queue, wait for the job submission confirmation message to
appear before you close this page.
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Paper and Media Overview
The highest configuration of Xerox® Versalink® B620 Single Function Printer can have up to five paper trays:

o Tray 1: Adjustable Standard 550-sheet paper tray. Tray 1 can be configured as dedicated or adjustable paper
tray for loading a range of paper sizes.

e Trays 2, 3, and 4: Optional 550-sheet paper trays. For multiple 550-sheet tray configuration, Trays 2, 3, and 4
can be configured as dedicated or adjustable paper trays that are similar to Tray 1.

e Bypass Tray: The 100-sheet Bypass Tray is located above Tray 1. The Bypass Tray is an adjustable paper tray
and cannot be set to Dedicated mode. You can load all types of media in Bypass Tray in small amounts.

e High-Capacity Tray: The printer can have a single 2100-sheet high-capacity paper tray. It can be Tray 2, 3, or 4
but must be the bottom tray in the stack. The High-Capacity Tray can be configured as dedicated or adjustable
paper tray. It can hold A4 (210 x 297 mm, 8.3 x 11.7 in.), Letter (216 x 279 mm, 8.5x 11in.), 8.5 x 13 in. (216 x
330 mm), 8.5 x 13.4in. (216 x 340 mm), and Legal (216 x 356 mm, 8.5 x 14 in.) size paper.

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-printed paper,
cardstock, labels, and envelopes. Ensure that you use the correct media for the tray that you are loading. Bypass
Tray is only for loading small amounts of standard and custom paper. For details on supported paper types and
weights, refer to Supported Paper Types and Weights.

.".-!h"'- Caution: 2-Sided Printing is not allowed for paper types, such as Envelopes and Labels. It can cause
misfeeds and other print problems.

Labels inside each tray show the correct orientation for loading certain types of media. The MAX label shows the
maximum fill line for the tray.
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Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid
jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

RECOMMENDED MEDIA
A list of paper and media recommended for your printer is available at:
e www.xerox.com/rmlna Recommended Media List (United States)

e www.xerox.com/rmleu Recommended Media List (Europe)

ORDERING PAPER

To order paper and other media, contact your local reseller or go to www.xerox.com/office/supplies.

GENERAL PAPER LOADING GUIDELINES

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

PAPER THAT CAN DAMAGE YOUR PRINTER

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer.
Do not use the following:

e Rough or porous paper

e Inkjet paper

e Glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media
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Warning: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

PAPER STORAGE GUIDELINES
Storing your paper and other media properly contributes to optimum print quality.

e Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and
visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.

e Reduce the exposure of paper to strong lights for long periods of time.

e Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
e Store paper flat, either on pallets, cartons, shelves, or in cabinets.

e Avoid food or drinks in the area where paper is stored or handled.

e Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in
the original packaging. The paper wrapper protects the paper from moisture loss or gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are
ready to use it. Keep unused media in the bag and reseal it for protection.

PAPER CHARACTERISTICS

The following paper characteristics affect print quality and reliability. Consider these factors before printing on
them.

Weight

Trays can feed paper of varying weights. Paper lighter than 60 g/m2 (16 |b.) may not be stiff enough to feed
properly, and may cause jams.

Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur
after the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in
hot, humid, cold, or dry conditions can contribute to paper curling before printing and can cause feeding problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If paper is too
smooth, it can cause paper feeding or print quality issues. We recommend the use of paper with 50 Sheffield
points.

Moisture Content

The amount of moisture in paper affects both print quality and the printer ability to feed the paper correctly. Leave
paper in its original wrapper until you use it. Exposure of paper to moisture changes can degrade its performance.
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Before printing, store paper in its original wrapper in the same environment as the printer for 24—48 hours. The
environment in which the paper is stored must be the same as the printer. Extend the time by several days if the
storage or transportation environment is significantly different from printer environment. Thick paper may also
require a longer conditioning period.

Grain Direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.

Fiber Content

Most high-quality xerographic paper is made from 100 % chemically treated pulped wood. This content provides
the paper with a high degree of stability, resulting in fewer paper feeding problems and better print quality. Paper
containing fibers such as cotton can negatively affect paper handling.

SUPPORTED PAPER TYPES AND WEIGHTS

STANDARD OPTIONAL 550- HIGH-

MEDIA TYPE AND 550-SHEET BYPASS SHEET TRAY CAPACITY 2-SIDED

WEIGHT TRAY (TRAY 2, 3, AND | TRAY (TRAY 2, | PRINTING

TRAY (TRAY 1) 4) 3. OR 4)

Plain ,"|I'

(75-90 g/m2)

Hole Punched
(75-90 g/m2)

Letterhead
(75-105 g/m?2)

Lightweight
Cardstock

R
R B
R
“ =
R B

(120-176 g/m2)

Cardstock

-

(177-200 g/m?2)

Recycled
(75-90 g/m2)

Bond
(75-105 g/m2)

Labels

R S e
W
e e
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STANDARD OPTIONAL 550- HIGH-

MEDIA TYPE AND 550-SHEET BYPASS SHEET TRAY CAPACITY 2-SIDED

WEIGHT TRAY (TRAY 2, 3, AND | TRAY (TRAY 2, | PRINTING

TRAY (TRAY 1) 4) 3, OR 4)

(75-180 g/m2)

Pre-Printed
(75-90 g/m2)

Envelope

(60-105 g/m2)

Lightweight
(60-74 g/m2)

Custom 1-7

S S e
T
e e .

(75-90 g/m2)

Weight Range 60-200 g/m?2 60-200 g/m2 | 60-200 g/m? 60-205 g/m?2 60-200 g/m2

{.‘i-"F Note: Do not use envelopes, labels, glossy, and coated media for 2-sided printing.

{;ﬁ" Note: Pre-cut tabs are not supported.

SUPPORTED STANDARD AND CUSTOM PAPER SIZES

STANDARD OPTIONAL HIGH-

MEDIA SIZE AND 550-SHEET CAPACITY 2-SIDED

-SHEET
MEASUREMENTS 2508 BYPASS TRAY TRAY (TRAY 2, | TRAY (TRAY | PRINTING
TRAY (TRAY 1) 3, 4) 2.3, OR 4)

3x5in. ,"|I'

(76 x 127 mm)

Postcard (4.25 x 5.5 ,.‘|I'
in.)

(108 x 138 mm)

Postcard (4 x 6 in.) o o o v

(102 x 152 mm)

5x7in. '-.l"l '-.l"l ~|I|I' '-.l"l

(127 x 178 mm)

A6 (105 x 148 mm) ,.‘|I' ,.‘|I' t,|'|l ,.‘|I'
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MEDIA SIZE AND z.f‘l;gNSDH':IE$ BYPASS TRAY (S)EJI;)H'\IEAIEI:I' EI}-\?’:CITY 2-SIDED

MEASUREMENTS TRAY (TRAY 1) TRAY (TRAY 2, | TRAY (TRAY | PRINTING
3, 4) 2, 3, OR 4)

(4.1 x5.8in.)

A5 (148 x 210 mm) ,"|I' ,"|I' t,|'|l ,"|I'

(5.8x8.3in.)

A5(210x 148 mm) | f o o o

(8.3x5.8in.)*

St(;tement (5.5x8.5 ,"|I' ,"|I' HI'II ,"|I'

in.

(140 x 216 mm)

B5 (176 x 250 mm) ,"|I' ,"|I' HI'II ,"|I'

(6.9x9.8in.)

JIS B5 (182 x 257 ,'|||II ,'|||II HI'II ,'|||II

mm)

(7.2x10.7in.)

Executive (7.25 x 10.5 ,.‘|l' .,lllII ;‘I'I '-.|'II

in.)

(184 x 267 mm)

8x10in.
(203 x 254 mm)

Letter (8.5x 11in.)
(216 x 279 mm)

A4 (210 x 297 mm)
(8.3x11.7in.)

215x 315 mm
(8.5x12.41in.)

8.5x13in.
(216 x 330 mm)

8.5x13.4in.
(216 x 340 mm)

Legal (8.5 x 14in.)

R e . T
R e . T
R I e T
R e . T
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MEDIA SIZE AND

MEASUREMENTS

STANDARD
550-SHEET
TRAY (TRAY 1)

BYPASS TRAY

OPTIONAL HIGH-
550-SHEET CAPACITY 2-SIDED
TRAY (TRAY 2, | TRAY (TRAY | PRINTING

(216 x 356 mm)

3,4) 2, 3,0R 4)

C5 Envelope (162 x
229 mm)

(6.4x9in.)

C6 Envelope (114 x
162 mm)

(4.5x6.41n.)

DL Envelope (110 x
220 mm)

(4.3 x8.6in.)

Envelope (6 x 9 in.)
(152 x 228 mm)

Monarch Envelope
(3.9x7.5in.)

(98 x 190 mm)

No. 9 Envelope (3.9 x
89in.)

(98 x 225 mm)

No. 10 Envelope (4.1
X 9.5in.)

(105 x 241 mm)

Custom

98-216 x 148-
356 mm

(3.8-8.5x 5.8-14
in.)

76-216x 127-
356 mm

(2.9-8.5 x 5-
14in.)

98-216 x 148— 98-216 x
356 mm 148-356
(3.8-8.5 x 5.8— mm
14in.) (3.8-8.5 x
5.8-14 in.)

{_-;i‘ Note: An asterisk (*) next to a value indicates the Long Edge Feed. For A5, the recommended orientation

for loading the paper is Long Edge Feed (LEF).
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Configuring Paper Tray Settings

CONFIGURING DEDICATED PAPER TRAYS

The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper tray is set to
Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type, and color.

Depending on the configuration, your printer can have up to three optional 550-sheet standard paper trays or two
optional 550-sheet standard trays with a High-capacity Feeder tray.

e The High-capacity tray is configured as Fully Adjustable tray.
e The High-capacity tray is designed to hold larger amounts of paper for fewer printing interruptions.

“#  Note: To configure tray settings, refer to the System Administrator Guide at www.xerox.com/office/

VLB620docs.

PAPER SIZE CONFIRMATION

The system administrator can configure the device response that appears on the control panel touch screen when
paper of the same size is loaded in a tray. For standard adjustable paper trays, select an option:

e Always Show: This option shows the paper confirmation prompt on the control panel touch screen until the
user dismisses it.

e Delayed Confirmation: This option shows the paper confirmation prompt for a specified time. At the end of
the specified time, the prompt closes, which confirms the paper that is loaded. While the prompt appears on the
control panel touch screen, you can confirm any change to the paper type, color, and size.

e Auto Confirmation: This option confirms the paper type, color, and size automatically without showing a
confirmation prompt on the control panel touch screen.

{-:'-"' Note: Xerox® does not recommend using the Auto Confirmation option unless you always load the tray
with paper of the exact same type, color, and size. To configure the Automatic Tray Confirmation Prompt,
refer to Required Paper Policies in the System Administrator Guide at www.xerox.com/office/VLB620docs.

CHANGING PAPER SIZE, TYPE, AND COLOR

When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that you load the tray.
When you close the tray, the control panel prompts you to set the paper size, type, and color of paper loaded.

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, type, and
color. If you move the guides to load a different paper size, the control panel displays an error message.

To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Paper Tray Settings.
To set the paper size, type, or color when a tray is set to Fully Adjustable:

1. Open the paper tray, then load the required paper.

2. Close the tray.
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3. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.
e To select a new paper type, touch Type.
e To select a new paper color, touch Color.

4. To confirm the settings, touch Confirm.

To set the paper size, type, or color when a tray is set to Dedicated, refer to Configuring Dedicated Paper Trays.
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Loading Paper

LOADING PAPER IN STANDARD TRAYS 1-4

The system administrator can set 550-sheet standard trays, Trays 1-4, to Fully Adjustable mode or Dedicated
mode. Each time a tray is opened and closed, the paper settings appear on the control panel.

e When trays are configured as Fully Adjustable, you can confirm or change the media settings. The paper guides
automatically detect the size of paper that is loaded.

e When trays are configured as Dedicated, the control panel displays the media settings for the tray. A warning
message appears on the control panel when the wrong media is loaded in the tray, or when the paper guides
are set incorrectly.

{-:'-"' Note: Only the system administrator can change the media settings for a dedicated tray. For details on how
to configure tray settings, refer to Configuring Paper Tray Settings.

When the paper in the tray is in short supply, or when a tray is empty, a warning message appears on the control
panel.

Do the following to load paper in Trays 1-4, where:
e Tray 1: Standard 550-sheet Tray
e Trays 2-4: Optional 550-sheet Trays

1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.
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3. To move out the length or width paper guides, pinch the guide locks, then slide out the length or width paper
guides.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. The
procedure separates any sheets that are stuck together and reduces the possibility of jams.

Warning: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to
use it.

5. Load the paper in the tray. For short-edge feed, insert letterhead and pre-printed paper face up with the top
edge toward the front.

Long-edge feed is the recommended orientation for A5 (148 x 210 mm, 5.8 x 8.3 in.) paper.

Warning: Do not load the paper above the maximum fill line. Overfilling the tray can cause paper jams.
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6. To fit the paper, adjust the length and width paper guides. Pinch the guide locks, then slide the paper guides in
until they touch the paper.

7. Slide the tray back into the printer.

T T

A

|7

8. At the control panel, select the correct paper size, type, and color.
e If letterhead paper is loaded in the printer, for type, select Letterhead.

o If pre-printed paper is loaded in the printer, for type, select Pre-printed.

9. To confirm the settings, touch Confirm.

{_-;ﬂ' Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Dedicated
Paper Trays.
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ADJUSTING THE PAPER GUIDES IN THE 550-SHEET ADJUSTABLE TRAYS

You can adjust the paper guides in Trays 1-4 to accommodate standard or custom paper sizes. In the standard
position, the guides move into the supported standard paper settings. You can use the Paper Size Preference feature
to set the preferred paper size to imperial or metric. Paper size options that use the selected units setting appear at
the top of the Paper Selection list on the Print tab and User Interface. You can select from the following options of
different measurement units:

e Inches: This option sets the paper-size preference to inches and displays Imperial sizes first.

e Metric: This option sets the paper-size preference to millimeters and displays Metric sizes first.
To set a custom size in the control panel, you can set the dimensions in the following increments:
e 0.1in., if the measurement unit is set to Inches or

e 1 mm, if the measurement unit is set to Metric

To move the paper guides from the standard to the custom paper-size position:

1. Pull out the tray until it stops.

2. Remove any paper from the tray. Pinch the guide levers, then move the length or width guides outward until
they stop.

148 Xerox® VersaLink® B620 Printer User Guide



Paper and Media

3. Load the custom-size paper in the tray.

4,

LOADING PAPER IN THE BYPASS TRAY
The Bypass Tray supports the widest variety of media types. The tray is intended primarily for small-quantity jobs

that use special media.
The Bypass Tray is located above Tray 1. To load paper in the Bypass Tray:

1. Open the Bypass Tray. If the tray is loaded with paper, remove any paper that is of different size or type.

{_-:i‘ Note: For larger paper sizes, pull out the extension tray.
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2. Move the width guides to the right edge of the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. The
procedure separates any sheets that are stuck together and reduces the possibility of paper jams.

Warning: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to
use it.

4. Load the paper in the Bypass Tray.

150 Xerox® VersaLink® B620 Printer User Guide



Paper and Media

a. For short-edge feed printing, load letterhead and pre-printed paper face down with the top edge toward
the feed direction of the paper.

Long-edge feed is the recommended orientation for A5 (148 x 210 mm, 5.8 x 8.3 in.) paper.

Warning: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

b. For hole-punched paper, load the paper short-edge feed with the holes at the right side of the paper.
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6. At the control panel, select the correct paper size, type, and color.
e If letterhead paper is loaded in the printer, for type, select Letterhead.
e If pre-printed paper is loaded in the printer, for type, select Pre-printed.

7. To confirm the settings, touch Confirm.

LOADING PAPER IN 2100-SHEET HIGH CAPACITY FEEDER TRAY

The control panel displays a warning message when the paper in the tray is in short supply or when the tray is
empty.

If your printer has a 2100-sheet High Capacity Feeder, it can be configured as dedicated or adjustable paper tray.
The printer can have a single 2100-sheet high-capacity paper tray. It can be Tray 2, 3, or 4 but must be the bottom
tray in the stack.

To load paper in the High Capacity Feeder paper tray:

1. Pull out the tray until it stops.

2. Pull up, then slide the width guide to the correct position for A4, Legal, Letter, Folio, or Oficio-size paper.

e B e i
-Gk
=51l 7 A
o aa e gt r -
—_ [ - ‘?_ o
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3. Squeeze, then slide the length guide to the position for A4, Legal, Letter, Folio, or Oficio-size paper until it clicks
into place.

e M-

ol

4. Before you load the paper into the trays, fan the edges of the paper. The procedure separates any sheets of
paper that are stuck together and reduces the possibility of paper jams.

{_-;ﬂ' Note: To avoid paper jams and misfeeds, do not remove paper from the packaging until necessary.

5. Load the paper in the High Capacity Feeder tray.
a. Place letterhead or pre-printed paper face up with the top edge toward the front.
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b. Place hole-punched paper with the holes at the right side of the tray.

- -L—L""/-I/"

Warning: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Slide the tray back into the printer.

{_-:.'-" Note: Press down the paper stack while pushing the tray back into the printer.

7. At the control panel, select the correct size, type, and color.

8. To confirm the settings, touch Confirm.
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Printing on Special Paper

To order paper or other media, contact your local reseller or go to www.xerox.com/office/supplies.
For reference:

www.xerox.com/rmlna: Recommended Media List (United States)

www.xerox.com/rmleu: Recommended Media List (Europe)

ENVELOPES

You can print envelopes from the following trays:
e Standard Trays 1-4

e Bypass Tray

High Capacity Feeder does not support envelopes.

Guidelines for Printing Envelopes
e Use only paper envelopes.
e Do not use envelopes with windows or metal clasps.

e Print quality depends on the quality and construction of the envelopes. If you do not get the desired results, try
another envelope brand.

e Maintain constant temperatures and relative humidity.

e Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality
and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.

e Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of the
envelopes.

e In the print driver software, select Envelope as the paper type.
e Do not use padded envelopes. Use envelopes that lie flat on a surface.
e Do not use envelopes with heat-activated glue.

e Do not use envelopes with press-and-seal flaps.

Loading Envelopes in Standard Trays 1-4
For supported envelope sizes, refer to Supported Paper.

To load envelopes in Standard Trays 1-4, do the following:
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1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.

3. To move out the length or width paper guides, pinch the guide locks, then slide out the length or width paper
guides.
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5. Load envelopes in the tray. For envelopes with the flap on a long edge, load envelopes with the flaps on the top
and closed. Keep the flaps toward the left.

6. Move the width paper guides from the edges of the tray to fit the envelopes.
7. Slide the tray back into the printer.

8. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set to Envelope.

{;ﬁ' Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Dedicated
Paper Trays.

9. To confirm the settings, touch Confirm.

10. To return to the Home screen, press the Home button.

Loading Envelopes in the Bypass Tray
For supported envelope sizes, refer to Supported Paper.
To load envelopes in the Bypass Tray:

1. Open the Bypass Tray.
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2. Move the width guides to the right edge of the tray.

[ r:[;.:#a B
) f’ - rltt'rf-]::_.]i
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{.'i-'} Note: If you do not load envelopes in the Bypass Tray right after they are removed from the packaging, they
can bulge. To avoid jams, flatten the envelopes.

3. Load envelopes in the tray. For envelopes with the flap on a long edge, load envelopes with the flaps face down
and closed. Keep the flaps toward the left.

.:.'I-'} Note: An envelope such as 6 x 9 in. (152 x 228 mm), with the flap on the short edge, insert the envelope
with the flap toward the feed direction.

4. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set to Envelope.

5. To confirm the settings, touch Confirm.
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6. To return to the Home screen, press the Home button.

LABELS

You can print labels from the following trays:

Standard Trays 1-4
Bypass Tray

High Capacity Feeder does not support labels.

Guidelines for Printing Labels

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until
ready to use. Return any unused sheets of labels to the original packaging and reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in
extreme conditions can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the
printer.

In the print driver software, select Label as the paper type.

Before loading labels, remove all other paper from the tray.

Warning: Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet.
It could damage the printer.

Loading Labels

To load labels in Standard Trays 1-4 and Bypass Tray:
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1. Pull out the tray until it stops.

2. Ensure that the paper guides are set in the correct position for the size of labels you are loading.

3. Remove any paper that is a different size or type.

4. To move out the length or width paper guide, release the guide lock, then slide out the length or width paper
guide.

5. Load the labels in any of the trays:
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a. Load the labels in the Standard Trays 1-4 and adjust the length and width paper guides to fit the labels.
For short-edge feed, insert labels face down with the bottom edge toward the front of the tray.
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b. To load the labels in the Bypass Tray, open the flap of the Bypass Tray.

Load the labels face up in the Bypass Tray with the bottom edge toward the feed direction of the tray.
Adjust the length and width paper guides to fit the labels.

6. Slide the tray back into the printer.

7. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set to Labels.

{;ﬁ" Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Dedicated
Paper Trays.

8. To confirm the settings, touch Confirm.

9. To return to the Home screen, press the Home button.
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General Precautions

,I'?H Caution:

Internal parts of the printer can be hot. Use caution when doors and covers are open.
Keep all cleaning materials out of the reach of children.

Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain
explosive mixtures and are not suitable for use in electrical applications. Use of pressurized spray
cleaners increases the risk of fire and explosion.

Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any
parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not
described in the documentation supplied with your printer.

Warning:

When cleaning your printer, do not use organic or strong chemical solvents or aerosol cleaners. Do not
pour fluids directly into any area. Use supplies and cleaning materials only as directed in this
documentation.

Do not place anything on top of the printer.

Do not leave the covers and doors open for any length of time, especially in well-lighted places.
Do not open covers and doors during printing.

Do not tilt the printer while it is in use.

Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

CLEANING THE PRINTER EXTERIOR

Regular cleaning keeps the touch screen, control panel, and exterior areas of the printer free from dust and dirt.

1. To avoid activating buttons and menus when cleaning the printer, press the Power/Wake button, then touch
Sleep.

3. Toreturn the printer to Ready mode, press the Power/Wake button.

4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior areas of your
printer.
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Supplies

CONSUMABLES

Consumable supplies are printer supplies that become depleted during the operation of the printer. Consumable
supply for this printer includes Genuine Xerox® Black Toner Cartridge.

= Note:
e Each consumable includes installation instructions. To replace consumables, refer to the instructions
included with the consumable supply.

¢ Only install new toner cartridges in your printer. If a used toner cartridge is installed, then the toner
remaining amount displayed can be inaccurate.

e To ensure print quality, the toner cartridge is designed to cease functioning at a predetermined point.

e You can use Xerox Easy Assist (XEA) app to check the status of supplies and order them. For more
information, refer to Xerox® Easy Assist (XEA) App.

Warning: Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability.
Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for
specific use with this printer.

ROUTINE MAINTENANCE ITEMS

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer-replaceable parts.

{-:'-"' Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e Imaging Unit

e Standard Paper Tray Feed Roller Assembly

e Bypass Tray Feed Roller Assembly

e Transfer Roller Assembly
ORDERING SUPPLIES

When to Order Supplies

A warning appears on the control panel when supplies near the replacement time. Verify that you have
replacements on hand. To avoid interruptions to your printing, order these items when the messages first appear on
the control panel. An error message appears on the control panel when supplies require replacement.

Order supplies from your local reseller or go to www.xerox.com/office/supplies.
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Warning: Use of non-Xerox supplies is not recommended. The Xerox Warranty or Service Agreement do
not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or
the use of Xerox supplies not specified for this printer.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near their replacement time, warning alerts appear at the control
panel.

You can customize the alerts that appear at the control panel and configure email alert notifications using the
Embedded Web Server.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System Administrator
Guide at www.xerox.com/office/VLB620docs.

To check the supplies status at the control panel:

1. At the printer control panel, press the Home button.

To view status information for the printer supplies, touch Device > Supplies.

To view details about a specific supply item, touch the item required.

To return to the Supplies screen, touch X.

To view more details, touch Other Supplies. Scroll through the list, then select an option.
To return to the Supplies screen, touch X.

To print the Supplies Report, touch Print Supplies Report.

o N oo v W N

To return to the Device screen, touch X.

TONER CARTRIDGES

£ Caution:

e When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with
clothes, skin, eyes, and mouth. Do not inhale the toner dust.

» Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child
spit out the toner, and rinse out their mouth with water. Consult a physician immediately.

_.-'?'-._ Caution: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric
sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner, contact
your local Xerox representative.

_.-'?'-._ Caution: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch
fire and cause burn injuries or an explosion.
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Replacing the Toner Cartridge

When it is time to replace the toner cartridge, the printer displays a message on the control panel.
{;ﬁ" Note: Each toner cartridge includes installation instructions.

To replace a toner cartridge:

Warning: Do not perform this procedure when the printer is copying or printing.

1. Open the front door A of the printer.

e -
7

o
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2. Firmly grip the cartridge handle, then remove the used toner cartridge from the printer.

3. Unpack the new toner cartridge, then shake it to redistribute the toner.
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4. Insert the new toner cartridge.

IMAGING UNIT

Replacing the Imaging Unit

When it is time to replace the imaging unit, the printer displays a message appears on the control panel.

Warning: Do not perform this procedure when the printer is copying or printing.

To replace the imaging unit:
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1. Open the front door A of the printer.

3. Remove the used imaging unit from the printer.
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4. Unpack the new black imaging unit, then to redistribute the toner, shake it three times.

i Caution: Do not expose the photoconductor unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

Warning: Do not touch the shiny photoconductor drum under the imaging unit. Doing so may affect the
quality of future print jobs.

5. Insert the new imaging unit straight into the printer.
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6. Insert the toner cartridge back into the printer.

7. Close the front door A.

PAPER TRAY FEED ROLLER ASSEMBLY

Replacing the Tray 1 Feed Roller
To replace the feed roller in the standard paper trays:
1. Power off the printer, then unplug the power cord from the electrical outlet.

2. Remove Tray 1 from the printer.
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3. To release the feed roller, press both ends of the feed roller as shown, then remove it from the printer.

4,

5.

6. Connect the power cord to the electrical outlet, then power on the printer.

i Caution: To avoid the risk of fire or electrical shock, connect the power cord to an appropriately rated
and properly grounded electrical outlet that is near the product and easily accessible.

Bypass Tray Feed Roller Assembly

Replacing the Feed Roller in the Bypass Tray
To replace the feed roller in the bypass tray:

1. Power off the printer, then unplug the power cord from the power supply.
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2. Open the bypass tray.

3. Torelease the feed roller, rotate the left end of the feed roller clockwise, as shown, then remove it from the
bypass tray.

4. Unpack and insert the new feed roller in the bypass tray.
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5. Close the bypass tray.

6. Connect the power cord to the power supply, then power on the printer.

i Caution: To avoid the risk of fire or electrical shock, connect the power cord to an appropriately rated
and properly grounded electrical outlet that is near the product and easily accessible.

Separator Pad

Replacing the Separator Pad
To replace the separator pad:

1. Pull out any standard paper tray from the printer.

2. To remove the separator pad, do the following:
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a. Release the separator pad.

3. Unpack and insert the new separator pad.
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4. Close the paper tray.

TRANSFER ROLLER ASSEMBLY

Replacing the Transfer Roller

When the transfer roller needs to be replaced, a message appears on the control panel.

Warning: Do not perform this procedure when the printer is copying or printing.

To replace the transfer roller:

1. Open the front door A.
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2. Remove the toner cartridge from the printer.

3. Remove the imaging unit from the printer.

4.  Remove the used transfer roller.

& Caution: The inside of the printer might be hot. To reduce the risk of injury from a hot component, allow
the surface of the printer to cool down before touching.
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5. Unpack and insert the new transfer roller. Refer to the installation instructions in the Transfer Roller
Maintenance Kit.

6. Insert the imaging unit straight into the printer.

7. Insert the toner cartridge back into the printer.
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8. Close Door A.

RECYCLING SUPPLIES
For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa.

Supplies include a prepaid return label. Use it to return the used components in their original boxes for recycling.

RESETTING SUPPLY LIFE COUNTERS
You must reset the supply life counters when you replace some supplies.
1. At the printer control panel, press the Home button.

2. Touch the Log In button, enter the system administrator login information, then touch Done. For details, refer
to the System Administrator Guide at www.xerox.com/office/VLB620docs.

Touch Device > Tools > Device Settings > Supplies.

Touch Supply Counter Reset.

To select an item to reset, touch the supply item in the list, then touch Reset Counter.
On the confirmation screen, touch Reset.

To return to the Tools screen, touch X, then touch X again.

To return to the Home screen, press the Home button.

© 0 N o & W

Touch the Log In button, then touch Logout.
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Managing the Printer

VIEWING THE METER READING

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

{-:'-"' Note: If you provide regular billing information for your device, you can use the Remote Services Upload
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox
automatically so that you do not have to collect the readings manually. Refer to the System Administrator
Guide for further information.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

Touch Device > Billing/Usage.

To view more details, touch Usage Counters, then select an option.

After viewing the usage readings, to return to the Device screen touch X, then touch X again.

v W N

To return to the Home screen, press the Home button.

PRINTING THE BILLING SUMMARY REPORT

The Billing Summary Report provides information about the device and a detailed listing of the billing meters and
sheet counts.

To print the Billing Summary Report:
1. At the printer control panel, press the Home button.
Touch Device > Information Pages.

Touch Billing Summary, then touch Print.

& W N

To return to the Home screen, press the Home button.
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Moving the Printer

Always power off the printer and wait for the printer to shut down. To power off the printer, verify that there are
no jobs in the queue, then press the secondary power switch. After the touch screen goes dark, wait 10 seconds,
then power off the main power switch. For details, refer to Power Options.

Disconnect the power cord from the back of the printer.

To avoid spilling toner, keep the printer level.

{-:'-"' Note: When moving the printer over a long distance, remove the toner cartridges to prevent toner from

spilling. Package the printer into a box.

Warning: Failure to repackage the printer properly for shipment can result in damage not covered by the
Xerox® Warranty or Service Agreement. The Xerox® Warranty or Service Agreement do not cover damage
to the printer caused by improper moving.
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General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply
restarting the printer.

RESTARTING THE PRINTER

The printer has one power switch. The power switch is the Power/Wake button on the control panel. The Power/
Woake button controls power to the printer electronic components, and when powered off, initiates a software-
controlled shutdown. The preferred method to power on and off the printer is to use the Power/Wake button.

To operate the printer, power on the switches:
1. Power on the main power switch that connects the printer to the power outlet.

2. At the control panel, press the Power/Wake button.

3. Torestart the printer:

a. At the control panel, press the Power/Wake button, then touch Restart. A message appears on the control
panel that warns you that the printer is restarting.

b. If the printer does not restart after several minutes, power off the main power switch. To restart the printer,
power on the main switch, then press the Power/Wake button on the control panel.

If restarting the printer does not resolve the issue, see the table in this chapter that best describes the problem.

PRINTER DOES NOT POWER ON

PROBABLE CAUSES SOLUTIONS

The power switch is not switched on. e Check that the printer is connected to a power
outlet.

e At the printer control panel, press the Power/Wake
button. For details, refer to Power Options.

The power cord is not plugged into the outlet correctly. | Power off the printer, then plug the power cord into the
outlet securely. Use the bracket provided with the
printer to secure the power cord in place.
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PROBABLE CAUSES SOLUTIONS

Something is wrong with the outlet connected to the
printer.

e Plug another electrical appliance into the outlet
and check if it operates properly.

e Try a different outlet.

The printer is connected to an outlet with a voltage or
frequency that does not match the printer
specifications.

Use a power source with the specifications listed in the
Electrical Specifications.

Warning: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. Do not use a
power strip. If necessary, contact a licensed electrician to install a properly grounded outlet.

PRINTER RESETS OR POWERS OFF FREQUENTLY

PROBABLE CAUSES SOLUTIONS

The power cord is not plugged into the outlet correctly.

Power off the printer. Confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer.

A system error occurred.

Power off the printer, then power on again. If the error
persists, contact your Xerox representative.

The printer is connected to an uninterruptible power
supply (UPS), extension cord, or power strip.

Only use an extension cord designed to handle the
electrical current capacity of the printer. For details,
refer to Electrical Specifications.

A network configuration problem exists.

Unplug the network cable. If the problem is not
resolved, contact your system administrator to
reconfigure your network installation.

The printer is connected to an outlet with a voltage or
frequency that does not match the printer
specifications.

Use a power source with the specifications listed in
Electrical Specifications.

PRINTER DOES NOT PRINT

PROBABLE CAUSES ‘ SOLUTIONS

The printer is in Power Saver mode.

On the control panel, press the Power/Wake button.

There is a printer error.

If the Status LED is blinking amber, there is an error.To
clear the error, follow the instructions on the control
panel. If the error persists, contact your Xerox
representative.

The paper tray is empty.

Load paper into the tray.

The printer toner cartridge is empty.

Replace the toner cartridge.
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PROBABLE CAUSES SOLUTIONS

All control panel indicators are off.

Power off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer. If the error persists, contact your
Xerox representative.

The printer is busy.

e [f the Status LED is flashing blue, check if a previous
print job is the problem.

1 At your computer, use the printer properties to
delete all print jobs in the print queue.

2 At the control panel, touch Jobs, then delete all
pending print jobs.

e Load the paper in the tray.

e [f the Status LED does not flash once after you
send a print job, check the connection between the
printer and the computer. Power off the printer,
then power on.

The printer cable is disconnected.

If the Status LED does not flash once after you send a
print job, check the connection between the printer
and the computer.

There is a wireless or network connectivity issue.

To test the printer, print an Information Page, such as
the Basic Configuration Report. If the page prints, there
could be a wireless or network connectivity issue.

Contact your system administrator or refer to the
System Administrator Guide at www.xerox.com/office/
VLB620docs.

Incorrect print driver.

Check that you have the latest print driver installed. For
details, go to www.xerox.com/office/VLB620support.

PRINTING TAKES TOO LONG

PROBABLE CAUSES SOLUTIONS

The printer is set to print on a paper type that requires
slower printing.

Certain paper type, like heavyweight paper takes more
time to print. Ensure that the print driver and control
panel are set to the proper paper type.

The printer is in Power Saver mode.

Wait. It takes time for printing to start after the printer
exits Power Saver mode.
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PROBABLE CAUSES SOLUTIONS

The way the printer was installed on the network could | o

Determine if a print spooler or a computer sharing
be an issue.

the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the speed of the printer, print multiple
copies of an information page, such as a demo
page. If the page prints at the rated speed of the
printer, there could be a network or printer
installation issue. For additional help, contact the
system administrator.

The job is complex. Wait. No action needed.
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DOCUMENT FAILS TO PRINT

PROBABLE CAUSES SOLUTIONS

Selected tray has wrong paper size loaded, or paper
type or color is not available.

To view the Job Status for a failed print on the touch
screen:

1 At the printer control panel, press the Home
button.

Touch Jobs.

3 From the jobs list, touch the held job name. The
resources required for the job appear on the control
panel.

4 Do one of the following:

e To print the job, replenish the resources
required. The job resumes automatically when
the required resources are available. If the job
does not print automatically, touch Resume.

e To choose an alternative paper source to enable
the job to print, touch the name of held job,
then touch Print On Alternate Paper. Select a
paper tray, then touch OK.

e To delete the print job, touch Delete. At the
prompt, touch Delete.

2% Note: The Print On Alternate Paper
option is enabled using the Embedded
Web Server. For details about the Print On
Alternate Paper option, refer to the System
Administrator Guide at www.xerox.com/
office/VLB620docs.

5 To return to the Home screen, press the Home
button.

Incorrect network settings.

To reset network settings, contact your system
administrator or refer to the System Administrator
Guide at www.xerox.com/office/VLB620docs.

The way the printer was installed on the network could
be an issue.

e Ensure that the printer is connected to the network.

e Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the printer, print an information page, such
as the Basic Configuration Report. If the page
prints, there could be a network or printer
installation issue. For help, contact your system
administrator.

Application and print driver have conflicting tray
selections.

For details, see Document Prints from Wrong Tray.
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DOCUMENT PRINTS FROM WRONG TRAY

Troubleshooting

PROBABLE CAUSES SOLUTIONS

Application and print driver have conflicting tray
selections.

Check the tray selected in the print driver.

2 Access the page setup or printer settings of the
application from which you are printing.

3 Set the paper source to match the tray selected in
the print driver or set the paper source to
Automatically Select.

4 Check that you have the latest print driver installed.
For details, go to www.xerox.com/office/
VLB620support.

{;ﬁ" Note: To have the print driver select the tray, set
the tray used as the paper source to Auto
Selection Enabled.

EMPTY OR PARTIALLY PRINTED DOCUMENT

PROBABLE CAUSES

SOLUTIONS

Packaging materials are not removed from the toner
cartridge.

1 Ensure to remove the packaging materials from the
toner cartridge.

2 Ensure that there is enough toner.

PRINTER IS MAKING UNUSUAL NOISES

PROBABLE CAUSES SOLUTIONS

One of the trays is not installed correctly.

Open and close the tray from which you are printing.

There is an obstruction or debris inside the printer.

Power off the printer and remove the obstruction or
debris. If you cannot remove the obstruction, contact
your Xerox® service representative.

The printer beeps at each touch on the control panel.

Check the Alerts setting. For details, refer to the System
Administrator Guide at www.xerox.com/office/
VLB620docs.
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AUTOMATIC 2-SIDED PRINTING PROBLEMS

PROBABLE CAUSES SOLUTIONS

Unsupported or incorrect paper.

Ensure that you are using the correct paper. Do not use
envelopes, or labels for automatic 2-sided printing. For
details, see Supported Paper.

Incorrect setting.

On the print driver Printing Options tab, select 2-Sided
Print.

DATE AND TIME ARE INCORRECT

PROBABLE CAUSES SOLUTIONS

The Date and Time Setup is set to Manual (NTP
Disabled).

To change the Date and Time to Automatic, in the
Embedded Web Server, enable NTP. For details, refer to
the System Administrator Guide at www.xerox.com/
office/VLB620docs.

The time zone, date, or time is set incorrectly.

Set the time zone, date, and time manually. For details,
refer to the System Administrator Guide at www.xerox.
com/office/VLB620docs.
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WIRELESS NETWORK ADAPTER PROBLEMS

PROBABLE CAUSES SOLUTIONS

The device does not recognize the Wireless Network « Ensure that the Wireless Network Adapter is

Adapter. installed in an active USB port. For details, refer to
the System Administrator Guide at www.xerox.com/
office/VLB620docs.

o If extension cable is used, ensure that it is attached
to the Wireless Network Adapter correctly.

e Ensure that the correct Wireless Network Adapter is
installed. The compatibility of the Wireless Network
Adapter is dependent on the device model and
software version.

Degradation in performance has occurred. Check the wireless signal strength for the Wireless

Network Adapter. For details, refer to the System

Administrator Guide at www.xerox.com/office/

VLB620docs. If the wireless signal strength is low, do

the following:

e Place the wireless router or Access Point (AP) in a
centralized location.

e Position the Wireless Network Adapter closer to the
AP, and ensure that the wireless router or AP is
located away from walls or large metal objects.

e Remove any physical obstructions between the AP
and the Wireless Network Adapter, and ensure that
the adapter is positioned away from walls or large
metal objects.

e Position the Wireless Network Adapter on the Xerox
device in direct view of the wireless router or AP.

e If applicable, consider upgrading the wireless router
or AP to a high-gain antenna that transmits the
wireless signals in one direction only.
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Paper Jams

LOCATING PAPER JAMS

f?"-. Caution: Parts that are near the fuser are hot. To prevent personal injury, never touch an area that has a
Caution label. Power off the printer immediately, then wait 40 minutes for the fuser to cool. After the
printer has cooled, try to remove the jammed paper. If the error on the control panel remains, contact
your Xerox representative.

Warning: Do not attempt to clear any paper jams using tools or instruments. This action can damage
the printer permanently.

The following illustration shows where paper jams can occur along the paper path:

1. Door C, Back Door 4. Door A, Front Door
2. Standard 550-sheet Paper Trays 1-4 5. Center Output Tray
3. Bypass Tray

MINIMIZING PAPER JAMS

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper types can
cause jams. If supported paper is jamming frequently in one areq, clean that area of the paper path. To avoid
damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same direction it
normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do not reload
paper that has jammed.
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The following can cause paper jams:

e Using damaged paper.

e Using unsupported paper.

e Loading paper incorrectly.

e Overfilling the tray.

e Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

e Use only supported paper. For details, refer to Supported Paper.
e Follow proper paper handling and loading techniques.

e Always use clean, undamaged paper.

e Avoid paper that is curled, torn, moist, creased, or folded.

e To separate the sheets before loading into the tray, fan the paper.
e Observe the paper tray fill line; never overfill the tray.

e Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted can cause
poor print quality, misfeeds, skewed prints, and printer damage.

e After loading the trays, select the correct paper type and size on the control panel.
e Store paper in a dry location.

e Use only Xerox paper designed for the printer.

Avoid the following:

e Polyester coated paper that is designed especially for inkjet printers.

e Highly glossy or coated paper, when they are not supported.

e Paper that is folded, wrinkled, or excessively curled.

e Loading more than one type, size, or weight of paper in a tray at the same time.

e Overfilling the paper trays.

e Allowing the output tray to overfill.

CLEARING PAPER JAMS

To clear jams, watch the video and follow the instructions on the control panel. To resolve the error that appears on
the control panel, remove all paper from the areas shown. If the error does not clear, check the jam areas again to
ensure that all paper has been removed. Ensure that all levers, covers, and doors have been closed correctly.

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same
direction it normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do
not reload paper that has jammed.

{-:'-"' Note: Do not touch the printed side of the paper when removing it. The printed side of jammed pages could
smudge, and the toner could stick to your hands. Avoid spilling any toner inside the printer.
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.-"T"'- Caution: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some
toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin,
wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with
cool water and consult a doctor.

Paper Tray Jams

If a jam occurs in the paper tray areas, a message appears to indicate the areas or paper tray that requires clearing.
To clear the jam, follow the instructions on the touch screen to locate the jammed paper, then clear the jam. When
removing jammed paper from the device, remove the paper in the direction it was feeding, and take care not to
leave any remnants of paper in the device.

After the paper tray jam has been cleared, the device continues printing the job from where the job stopped.

If further paper tray jams are experienced, try to load fresh paper in the paper tray. The paper could have excessive
curl, excessive moisture, or be damaged.

For more information about paper jam causes and potential solutions, refer to Paper Misfeeds and Paper Size Jams.

Clearing Jams at Standard Trays 1-4
To clear the paper jams at Standard Trays 1-4:

1. Before you remove any tray from the printer, view the paper jam message on the control panel. Remove the
jam that is shown on the control panel, then remove other paper jams.

2. Pull out the tray until it stops.

3.
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4. If the paper is torn, remove the tray completely, then check inside the printer for torn pieces of paper.
5. Reload the tray with undamaged paper, then push the tray in until it stops.
6. At the control panel, if a prompt appears, select the correct paper size, type, and color.

e To select a new paper size, touch Size.

e To select a new paper type, touch Type.

e Toselect a new paper color, touch Color.

e To confirm the settings, touch Confirm.

{_-:ﬂ' Note: To configure settings when the prompt is displayed, update the Required Paper Policies in
Embedded Web Server. For details, refer to the System Administrator Guide at www xerox.com/office/

VLB620docs.

7. Toreturn to the Home screen, press the Home button.

Clearing Jams at Bypass Tray
To clear the paper jams at Bypass Tray:

1. Remove the jammed paper from the tray. Ensure that the paper feed entrance, where the tray connects to the
printer, is clear.

2. If the paper is torn, check inside the printer for torn pieces of paper.
3. Fan the paper that you removed and ensure that all four corners of the paper are aligned.

4. Insert the paper into Bypass Tray. Ensure that the leading edge of the paper touches the paper feed entrance.
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5. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.
e To select a new paper type, touch Type.
e To select a new paper color, touch Color.

6. To confirm the settings, touch Confirm.

Clearing Jams at Door A
To clear paper jams from inside the printer front door, Door A, do the following:

1. Open Door A.

2. Remove the toner cartridge.
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3. Remove the imaging unit.

Warning: Do not expose the imaging unit to direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

Warning: Do not touch the shiny photoconductor drum under the imaging unit. Doing so may affect the
quality of future print jobs.

4. Pull out Tray 1, then remove the jammed paper.

{_-:i‘ Note: Ensure that all paper fragments are removed.

5. Insert Tray 1 back into the printer.
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6. Insert the imaging unit back into the printer.

7. Insert the toner cartridge back into the printer.

8. Close Door A.

Clearing Jams at Door C

To clear the paper jams from inside the printer rear door, Door C, do the following:
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1. Open Door C.

Caution: The inside of the printer might be hot. To reduce the risk of injury from a hot component, allow
the surface of the printer to cool down before touching.

3. Remove the jammed paper that is present below the fuser assembly.
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4. Remove jammed paper from the Door C cover.

Clearing Jams at the Output Tray

At the Output Tray, remove the jammed paper.

J:;;i” Note: Ensure that all paper fragments are removed.
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Multiple Sheets Pulled Together

Troubleshooting

PROBABLE CAUSES SOLUTIONS

The paper tray is too full.

Remove some of the paper. Do not load paper past fill
line.

The edges of the paper are not even.

Remove the paper, align the edges, and then reload it.

The paper is moist from humidity.

Remove the paper from the tray, and replace it with
new dry paper.

Too much static electricity is present.

Try a new ream of paper

Using unsupported paper.

Use only Xerox approved paper. For details, refer to
Supported Paper.

Humidity is too high for coated paper.

Feed paper one sheet at a time.

Paper Misfeeds and Paper Size Jams

PROBABLE CAUSES ‘ SOLUTIONS

The paper is not correctly positioned in the tray.

e Remove the misfed paper and reposition it properly
in the tray.

e Adjust the paper guides in the tray to match the
size of the paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past the
fill line.

The paper guides are not correctly adjusted to the
paper size.

1 Remove the paper.

2 Adjust the paper guides in the tray to match the
size of the paper.

3 Replace the paper.

The tray contains warped or wrinkled paper.

Remove the paper, smooth it out, and reload it. If it still
misfeeds, do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry
paper.

Using paper of the wrong size, thickness, or type.

Use only Xerox approved paper. For details, refer to
Supported Paper.
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Label and Envelope Misfeeds

PROBABLE CAUSES SOLUTIONS

The label sheet is facing the wrong way in the tray.

Load label sheets according to the instructions from
the manufacturer.

Load labels face down in standard Trays 1-4 and
Bypass Tray.

For loading labels with correct orientation, refer to
Labels.

{.'i-'-F Note: Do not load labels in the High Capacity
Feeder Tray.

Envelopes are loaded incorrectly or in the wrong tray.

Use standard Trays 1-4 and Bypass Tray to print
envelopes.

For loading envelopes with correct orientation, refer to
Envelopes.

Envelopes are loaded incorrectly in Bypass Tray.

To load envelopes in Bypass Tray:

e For envelopes with the flap on a long edge, load
envelopes with the flaps face down and closed.
Keep the flaps toward the left.

e For envelopes with the self-seal or non-adhesive
flap on a short edge, load envelopes with the flaps
face down and closed. Insert the envelopes with the
flaps toward the feed direction.

e For the custom-size envelopes, when the flap is on
the short edge and the long edge is longer than
216 mm (8.5 in.), load envelopes with the flaps
face down and closed. Insert the envelope with the
flap toward the feed direction. For custom-size
envelopes, define the custom size on the control
panel.

{_-:.'-“" Note: Unless the long edge is longer than 216
mm (8.5 in.) or the short edge is less than the
minimum width of the feeder, the flap of the
envelop should always be to the left.

Paper Jam Message Stays On

PROBABLE CAUSES SOLUTIONS

Some paper remains jammed in the printer.

Recheck the media path and make sure that you have
removed all of the jammed paper.

One of the printer door is open.

Check the doors on the printer. Close any door that is
open.
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{_-:.'ﬁ" Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

PROBABLE CAUSES SOLUTIONS

Using paper of the wrong size, thickness, or type. Use paper of the correct size, thickness, or type. For
details, see Supported Paper.

Paper type is set incorrectly in the print driver. Ensure that the paper type is set correctly in the driver
and that the paper is loaded in the correct tray. For
details, see Supported Paper.

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For
details, refer to Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.
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Print Problems

IDENTIFYING PRINT PROBLEMS

Problems with the output quality of your printer can be print-related. A quick test can help you to identify where a
problem exists.

To identify if a problem is print-related, do the following:
1. Print the Getting Started guide:
a. At the printer control panel, press the Home button.
b. Touch Device, then touch Information Pages.
c. Touch Getting Started, then touch Print.
d. To return to the Home screen, press the Home button.
2. Check the quality of the printed output.

3. If the print quality appears poor, the problem is print-related. For possible solutions, refer to Print-Quality
Problems and Solutions.

{':'-". Note: Ensure that the packaging materials are removed from the toner cartridge.

PRINT-QUALITY PROBLEMS

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/
VLB620support.

Warning: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

{-:'-"' Note: To ensure consistent print quality, the toner cartridges for many devices are designed to cease
functioning at a predetermined point.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use
paper designed for your printer, and set the paper type correctly. Follow the guidelines in this section to maintain
optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. For details, refer to Environmental
Specifications.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best
print quality and to avoid jams:
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e Use only Xerox approved paper. For details, refer to Supported Paper.

e Use only dry, undamaged paper.

Warning: Some paper and other media types can cause poor output quality, increased paper jams,
or damage your printer. Do not use the following:

Rough or porous paper

Inkjet paper

Glossy or coated paper

Paper that has been photocopied

Paper that has been folded or wrinkled

Paper with cutouts or perforations

Stapled paper

Envelopes with windows, metal clasps, side seams, or adhesives with release strips
Padded envelopes

Plastic media

Iron-on transfer paper

e Ensure the paper type selected in your print driver matches the paper type on which you are printing.

e If you have the same size paper loaded in more than one tray, let the printer select the proper tray according to
media and tray priority.

e Do not load more than one type, size, or weight of paper in the tray at a time.

o Store your paper and other media properly for optimum print quality. For details, refer to Paper Storage
Guidelines.

Solving Print-Quality Problems

Your printer is designed to produce high-quality prints consistently. If you observe print-quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/
VLB620support.

Warning: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

{-:'-"' Note: To enhance the print quality, the toner cartridges for many models are designed to cease functioning
at a predetermined point.

Printing the Troubleshooting Print-Quality Pages

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch Information Pages.
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4. To print procedures on resolving print-quality problems, touch Troubleshooting Print Quality Page, then
touch Print.

5. Compare your print-quality problems to the examples on the pages.

Eliminating the Paper or Media as the Problem

Damaged or unsupported paper or media can cause print-quality problems even when the printer, application, and
print driver are working perfectly. Use the following guidelines to eliminate the paper as the source of the print-
quality problem:

e Make sure that the printer supports the paper or media.

e Make sure that the printer is loaded with undamaged, dry paper.

e If the condition of the paper or media is in doubt, replace it with new paper or medic.

e Make sure that you have the proper tray selected in the print driver and from the control panel.

e Make sure that you have the correct paper type selected in the print driver and in the control panel of the
printer.

Isolating the Problem to the Printer or to the Application

When you are sure that the paper is supported and in good condition, use the following steps to isolate the
problem:

1. From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see Printing the
Troubleshooting Print-Quality Pages.

o If the pages printed properly, the printer is working properly and the print-quality problem is an application,
print driver, or print server problem.

o If the pages still have print-quality problems, the problem is in the printer.

2. If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print
Server.

3. If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems in the
Printer.

Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server

If the printer is printing properly from the control panel but you still have print-quality problems, the application,
print driver, or print server could be the cause.

To isolate the problem:
1. Print a similar document from another application and look for the same print-quality problems.

2. If the document has the same print-quality problem, it is probably a print driver or print server problem. Check
the print driver used for the print job.

a. Navigate to the list of printers on your computer:
e For Windows Server 2012 and later, click Start > Settings > Printers.

e For Windows 10, click Start > Settings > Devices > Printers & scanners.
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e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

{-:'-"' Note: If you are using a custom Start menu application, the application can change the navigation path to
your list of printers.

b. Click on the name of the printer, then select Printer properties:
e For Windows Server 2012 and later, right-click the icon for your printer, then click Printing properties.
e For Windows 10, click the icon for your printer, then click Manage > Printer properties.
e For Windows 11 and later, click the icon for your printer, then click Printing preferences.

c. Verify the following for your printer:
e Ensure that the model name in the middle of the driver matches the model name of the printer.
e If the names do not match, install the proper print driver for the printer.

3. If the problem persists, delete then reinstall the print driver.

4. If the document printed without a print-quality problem, the application is probably the cause. Restart your
printer, restart the application, then print the document again. For more information, refer to Power Options.

5. If the problem still persists, ensure that you are not printing through a print server. If the problem persists, for
online support information, go to www.xerox.com/office/VLB620support.

Troubleshooting Print-Quality Problems in the Printer

If you have print-quality problems when printing a Graphics Demo Page or the Basic Configuration Report from the
control panel, the problem is in the printer.

To find the source of the problem:

1. At the control panel, print the Troubleshooting Print Quality Page. For details, refer to Printing the
Troubleshooting Print-Quality Pages.

2. If the prints are too light to see print details, verify the following:
e The printer is loaded with undamaged, dry supported paper.
e The toner level of the toner cartridge is not too low.

3. Compare the print-quality problems in your document to each of the examples on the Troubleshooting Print
Quality Page.

If you find a match on the Troubleshooting Print Quality Page, look in the Solutions column for the action to take to
resolve the problem.

If the problem persists, for online support information, go to www.xerox.com/office/VLB620support.

Print-Quality Problems and Solutions

Use the following table to find solutions to print-quality problems. When the print quality is poor, to correct the
problem, select the closest symptom from the following table and refer to the corresponding solution.

{-:'-"' Note: At the printer control panel, press the Home button. Touch Device > Information Pages >
Troubleshooting Print Quality Page > Print.
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SYMPTOM SOLUTIONS

The output is too light.

.,
",

To check the toner level, check the control panel, or
use the print driver or the Embedded Web Server. If
the toner cartridge is near empty, replace it. For
details, refer to Replacing the Toner Cartridge.
Verify that the toner cartridge is approved for use in
this printer, and replace the toner cartridge, as
needed. For best results, use a Genuine Xerox toner
cartridge.

Replace the paper with a recommended size and
type, and confirm that your printer and print driver
settings are correct.

Verify that the paper is dry and that supported
paper is used. If not, change the paper.

Change the paper type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper, then change the Other Type setting.

Verify the Print Quality setting in the print driver. In
the print driver, on the Printing Options tab, ensure
that the Print Quality is set to Standard.

Change the Darken Image setting. For details, refer

to the System Administrator Guide at www xerox.
com/office/VLB620docs.

Toner smears or the print rubs off.

The output has stains on the back side.

- -
E

ABC | .
DEF | .

Change the paper type settings in the print driver.
For example, change Plain to Lightweight
Cardstock. In the print driver, on the Printing
Options tab, select Paper, then change the Other
Type setting.

Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

Verify that the printer is plugged in to an outlet
that is providing the correct voltage and power.
Review the electrical specification of the printer
with an electrician, if necessary. For details, refer to
Electrical Specifications.

Check the toner level. To check the toner level,
check the control panel, or use the print driver or
the Embedded Web Server. For details, refer to
Supply Status. If the toner cartridge is near empty,
replace it. For details, refer to Replacing the Toner
Cartridge.

Random spots appear on the output, or the image is
blurry.

Ensure that the toner cartridge is installed correctly.

If you used a non-genuine brand toner cartridge,
install a Genuine Xerox toner cartridge.

208

Xerox® VersaLink® B620 Printer User Guide


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB620&PgName=Man
https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB620&PgName=Man

Troubleshooting

SYMPTOM SOLUTIONS

ABC
DEF

Use the Rough paper type setting, or try a paper
with a smoother surface.

Ensure that the humidity in the room is within
specifications. For details, refer to Relative Humidity.

Replace the toner cartridge.

The output is blank.

.,
-,

Power off the printer, then power on again.
Remove, then re-install the toner cartridge.
Replace the toner cartridge.

If the error persists, contact your Xerox
representative.

.,
-,

B

3

Black or white streaks appear on the output.

Replace the toner cartridge.

If the error persists, contact your Xerox
representative.

The output has a mottled appearance.

Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

Ensure that the humidity in the room is within
specifications. For details, refer to Relative Humidity.

Choose a different paper type at the control panel,
in the application, and in the print driver.

Replace the paper.

If the error persists, contact your Xerox
representative.

Ghosting appears on the printed output.

Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

Change the Paper Type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper, then change the Other Type setting.
Check the percentage of remaining life for the
transfer roller. For details, refer to Supply Status.
When the percentage of remaining life is less than
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SYMPTOM

I,
-,

SOLUTIONS

20 percent, replace the transfer roller. For details,
refer to Replacing the Transfer Roller.

e Replace the toner cartridge. For details, refer to
Replacing the Toner Cartridge.

e If the error persists, contact your Xerox
representative.

Auger marks appear on the printed output.

e To check the toner level, check the control panel, or
use the print driver or the Embedded Web Server.
For details, refer to Supply Status. If the toner
cartridge is near empty, replace it.

o Verify that the toner cartridge is approved for use in
this printer, and replace the toner cartridge, as
needed. For best results, use a Genuine Xerox toner
cartridge.

e Replace the toner cartridge. For details, refer to
Replacing the Toner Cartridge.

e If the error persists, contact your Xerox
representative.

The output print is wrinkled or stained.

e Verify that the paper is the correct size, type, and
weight for the printer and that the paper is loaded
properly. If not, change the paper.

e Try a new ream of paper.

e Change the Paper Type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper then change the Other Type setting.

Envelopes are wrinkled or creased when printed.

Verify that the crease is within 30mm (1.2 in.) of the

four edges of the envelope.

e If yes, the printer is printing as expected. Your
printer is not faulty.

e If not, take the following actions:

—  Ensure that only C5 envelopes are loaded in
Bypass Tray.

—  Ensure that envelopes are loaded properly in
Bypass Tray. For details, refer to Loading
Envelopes in the Bypass Tray.

—  Follow the guidelines for printing on envelopes.
For details, refer to Guidelines for Printing
Envelopes.
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SYMPTOM SOLUTIONS

The top margin is incorrect.

[™
"oy

ABC
DEF

e Ensure that the paper is loaded properly.

e Ensure that the margins are set correctly in the
application that you are using.

The printed surface of the paper is bumpy.

ABC'
DEF,

Clean the fuser rollers:
1 Print a solid image over the entire surface of one
sheet of paper.

2 Load the printed sheet into the tray with the
printed side face down.

3 To remove debris from the fuser rollers, pint five
blank pages.

Vertical White Lines or Streaks - Process lines or streaks
appear in your output.

1 Print the test pages to identify the problem.

{_-;ﬂ" Note: To print procedures on resolving
print-quality problems, at the control panel,
press the Home button, then touch Device
> Information Pages > Troubleshooting
Print Quality Page > Print.

2 To inspect for possible contamination causing the
process line streak, remove and reinsert the
imaging unit. For more information, refer to
Maintenance.

a Remove the toner cartridge, then remove
the imaging unit from the printer.

b Insert the imaging unit, then insert the toner
cartridge in the printer.

Warning: Do not expose the imaging
unit to direct light for more than 10
minutes. Extended exposure to light may
cause print quality problems.

Warning: Do not touch the
photoconductor drum. Doing so may

affect the quality of future print jobs.
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SYMPTOM SOLUTIONS

3 If the problem persists, contact your local Xerox
representative. The imaging unit may need to be
replaced due to permanent damage.

Toner Darkness Control

Your printer is designed to produce consistently high-quality prints. If you observe quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/
VLB620support.

Warning: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

SYMPTOMS SOLUTIONS

Toner Darkness Control Perform the Toner Darkness Control routine:

1 At the printer control panel, touch Device > Tools.

2 Touch Device Settings > General > Toner
Darkness Control.

3 At the Toner Darkness page, make darkness
adjustments as required, then touch OK.

If the problem persists, for online support information, go to www.xerox.com/office/VLB620support.
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Getting Help

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality.

VIEWING ERROR AND ALERT MESSAGES ON THE CONTROL PANEL

When an error or warning condition occurs, the printer alerts you of the problem. A message appears on the control
panel and the LED status light on the control panel flashes amber or red. Alerts inform you about printer conditions,
such as low supplies or open doors that require your attention. Error messages warn you about printer conditions
that prevent the printer from printing or degrade printing performance. If more than one condition occurs, only one
appears on the control panel.

To view a complete list of active error and alert messages:
1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Faults & Alerts, Alerts, or Faults.

To view details, touch a fault or alert.

To exit the Notifications screen, touch X.

N oo v W N

To return to the Home screen, press the Home button.

VIEWING THE ERROR HISTORY ON THE CONTROL PANEL

When errors occur on the device, they are logged into an error history file by date, time, and associated fault code.
You can use this list to identify trends and resolve problems.

To view the error history:

1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Fault History.

To exit, touch X.

To exit the Notifications screen, touch X.

N o v &~ w N

To return to the Home screen, press the Home button.

SUPPORT LOGS
Use the Support Logs feature only if a Xerox service representative instructs you to do so.

Log files are text files of recent device activity that are created and stored in the device in an encrypted format. A
Xerox service representative can interpret the files to troubleshoot network problems.

{-:'-"' Note: Support logs can include screenshots that are taken at the device control panel.
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To capture a screenshot at the control panel, press the Power button, then touch the lower-left corner of the screen.
After the screenshot is taken, the file name of the image appears on the screen. The file name includes the date,
time, and serial number of the device.

{':'-"' Note: The device can capture most screens. When pop-up windows are displayed, the device sometimes
captures the underlying screen only.

The screenshot images are stored with the log files. The device can store up to three screenshots for a maximum of
7 days. After 7 days, the files are deleted. If more than three screenshots are taken, the older files are deleted.

The Enhanced Logging feature enables the device to capture additional logs for specific functions or activities. A
Xerox service representative can use the additional logs to investigate non-repeatable or intermittent device issues.

{-:'-"' Note: The device supports enhanced logging for a maximum of three features at a time and also supports
increased data analysis.

For information about configuring support log settings, refer to the System Administrator Guide at www.xerox.com/
office/VLB620docs.

THE EMBEDDED WEB SERVER

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:

e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

ONLINE SUPPORT ASSISTANT

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your
printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and
more.

To access the Online Support Assistant, go to www.xerox.com/office/VLB620support.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, getting started pages, and more.

The following Information Pages are available:
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NAME DESCRIPTION

Basic Configuration Report The Basic Configuration Report provides printer
information, including the serial number, installed
options, network settings, port setup, tray information,
and more.

Detailed Configuration Report The Detailed Configuration Report provides

information about all of the printer settings, including
extensible services setup, security and authentication
server configuration, connectivity settings, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

Printing Information Pages

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. To print an information page, touch the needed page, then touch Print.
The printer prints the selected information page.

4. To return to the Home screen, press the Home button.

MORE INFORMATION

You can obtain more information about your printer from these sources:
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RESOURCE LOCATION

Installation Guide Packaged with the printer.

Getting Started guide Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer www.xerox.com/office/VLB620docs

Recommended Media List United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer, www.xerox.com/office/VLB620support
including online technical support, Online Support
Assistant, and print driver downloads.

Information Pages Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information In the Embedded Web Server, click Help.
Order supplies for your printer www.xerox.com/office/supplies
A resource for tools and information, including www.xerox.com/office/businessresourcecenter

interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual needs.

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts
Printer registration www.xerox.com/register
Xerox® Direct online store www.direct.xerox.com/

Locating the Serial Number

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print a configuration report, or view the serial number
on the control panel or on the Embedded Web Server home page. The serial number is printed on a label that is
affixed to the printer. To view the label, open Door A.

For details on how to print a configuration report, refer to Information Pages.
To view the serial number on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.
The model, serial number, and software version is displayed.

3. Toreturn to the Home screen, press the Home button.
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Specifications

Printer Configurations and Options

STANDARD FEATURES

The printer provides the following features:

e Print from USB mass storage devices

e Print speed up to 61 ppm for A4 (210 x 297 mm) and 65 ppm for Letter (8.5x 11 in.)
e 1200 x 1200 dpi imaging quality

e Print document sizes up to Legal (215.9 x 355.6 mm, 8.5 x 14in.)

e Automatic 2-sided printing

e Color touch screen control panel

e Tray 1, Standard 550-sheet Tray

e Optional Trays 2—4 each with 550-sheet capacities

e Optional High-Capacity Feeder Tray with total 2100-sheet capacity
e 2-GByte DDR4 system memory

¢ Internal 32-GByte embedded Multi-Media Card (eMMC)

e Ethernet 10/100/1000Base-TX

e High-Speed USB 2.0 direct print

e Adobe® PostScript® and PCL® fonts and support

e Xerox® Global Print Driver and Xerox® Pull Print Driver support

e Automated supplies replenishment and management using Xerox® MeterAssistant®, Xerox® SuppliesAssistant®,
and Maintenance Assistant

e Remote driver installation

e Remote Control Panel, Backup and Restore, and Configuration Cloning
e Bonjour device discovery

e Xerox® Standard Accounting

e Encrypted Secure Print

e Xerox® Extensible Interface Platform

e Xerox® Earth Smart Driver settings

e Embedded Web Server

e Support for mobile printing, mobile printing connectivity, and mobile apps
e Support for Xerox® Easy Assist App

e Support for Xerox® App Gallery

e Support for NFC printing

e Support for Mopria

218 Xerox® VersaLink® B620 Printer User Guide



Support for AirPrint

OPTIONS AND UPGRADES

I-\._-'

Xerox Secure Access Unified ID System
CAC and PIV Card Reader Enablement Kit
Xerox® Network Accounting Enablement
Productivity Kit (500+ GB Hard Disk Drive)
RFID Card Reader Kit

SIPRNet Enablement Kit

Software for Unicode print

Specifications

Wireless Dual Band Network Adapter with Bluetooth which provides wireless network connectivity, Wi-Fi Direct
connectivity, and iBeacon for AirPrint discovery.

{_-:ﬂ‘ Note: For AirPrint® discovery, the connection is made through Bluetooth low energy beacon.

-

Important: If your printer has a Wireless Network Adapter, that requires installation in the front USB port,

and you have a USB Card Reader, do not install the Card Reader into the USB port of the Wireless Network
Adapter. Use the rear USB port for the Card Reader. For more information, refer to the installation
instructions provided with the Wireless Network Adapter and Card Reader Optional Kits for your printer.

FINISHING OPTIONS

OUTPUT DEVICE

Center Tray

CAPACITY
550 sheets

SIZES
All supported sizes

For information on
supported sizes,
refer to Supported
Paper.

WEIGHTS

All supported
weights

For information on
supported weights,
refer to Supported
Paper.

FINISHING
OPTIONS

Not Applicable

{if Note: Sheet quantities for tray capacities and finishing options are based on 75 g/m2. Quantities are
reduced for heavier media and must be within the specified weight range.
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Specifications

Physical Specifications

BASE CONFIGURATION

e Width: 42.8 cm (16.8 in.)
e Depth: 51 cm (20.1in.)

e Height: 44.5cm (17.51in.)
e Weight: < 25.4 kg (56 |b.)
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Specifications

BASE CONFIGURATION WITH 3-OPTIONAL STANDARD TRAY MODULES AND CASTER BASE

|- - 2.8 cm
(16.8i0M) ™

e Width: 42.8 cm (16.8 in.)
e Depth:69.3cm (27.3in.)
e Height: 90.1 cm (35.41in.)
e Weight:i< 51.9 kg (114.4 1b.)

{;ﬁ' Note: Caster Base is optional for Standard 550-sheet Tray configuration.
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Specifications

BASE CONFIGURATION WITH HIGH CAPACITY FEEDER AND CASTER BASE

w42 B cm
(168 i)™

e Width: 42.8 cm (16.8 in.)
e Depth:69.3cm (27.3in.)
e Height: 92.1 cm (36.3in.)
e Weight: < 51kg (112.41b.)

{;ﬁ' Note: Caster Base is required for High Capacity Feeder Tray configurations.
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Specifications

BASE CONFIGURATION WITH OPTIONAL STANDARD TRAY AND HIGH CAPACITY FEEDER WITH
CASTER BASE

44 0 0m
r_(1 6.8 i)~

GERR A
[£7.30m,)
4

e
e Width: 42.8 cm (16.8 in.)

e Depth: 69.3cm (27.3in.)

e Height: 114.1 cm (44.9in.)

e Weight: < 69.6 kg (153.4 |b.)

{_-:.'-“' Note: Caster Base is required for High Capacity Feeder Tray configurations.
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Specifications

CONFIGURATION WITH OPTIONAL TRAYS AND PRINTER STAND

11050
(4330

# A E2ETn)
<463 o -

"-- -~
(18.2in.) __".,',‘.'-":’j_-___"{-

e Width: 46.3 cm (18.2in.)

e Depth: 71.4cm (28.1 in.)

e Height: 110.5 cm (43.3in.)
e Weight: < 58.8 kg (129.6 |b.)

7 Note: The weight of the printer stand is 14.8 kg (32.7 Ib.).
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Specifications

Clearance Requirements

BASE CONFIGURATION
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Installation Space

e Width: 58.0 cm (22.8 in.)
e Depth: 106.8 cm (42.1 in.)
e Height: 52.1 cm (20.5in.)
Clearance

e Front: 40.6 cm (16.0in.)

e Rear:15.2cm (6.0in.)

e left: 7.6 cm (3.0in.)

e Right: 7.6 cm (3.0in.)
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Specifications

BASE CONFIGURATION WITH 3-OPTIONAL STANDARD TRAY MODULES AND CASTER BASE
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Installation Space

e Width: 58.0cm (22.8 in.)
e Depth: 106.8 cm (42.1 in.)
e Height: 90.1 cm (35.41in.)
Clearance

e Front: 40.6 cm (16.0 in.)

e Rear:15.2cm (6.0in.)

e Left: 7.6 cm (3.01in.)

e Right: 7.6 cm (3.0in.)

{;ﬁ' Note: Caster Base is optional for Standard 550-sheet Tray configuration.
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BASE CONFIGURATION WITH HIGH CAPACITY FEEDER AND CASTER BASE
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Installation Space

e Width: 58.0cm (22.8 in.)
e Depth: 106.8 cm (42.1 in.)
e Height: 92.1 cm (36.3in.)
Clearance

e Front: 40.6 cm (16.0in.)

e Rear: 15.2cm (6.0 in.)

e Lleft: 7.6 cm (3.0in.)

e Right: 7.6 cm (3.0in.)

{;ﬁ' Note: Caster Base is required for High Capacity Feeder Tray configurations.
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Specifications

BASE CONFIGURATION WITH OPTIONAL STANDARD TRAY AND HIGH CAPACITY FEEDER WITH

CASTER BASE

CTTTeNE
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Installation Space

e Width: 58.0 cm (22.8 in.)

Depth: 106.8 cm (42.1 in.)
Height: 114.1 cm (44.9 in.)

Clearance

Front: 40.6 cm (16.0 in.)
Rear: 15.2 cm (6.0 in.)
Left: 7.6 cm (3.0 in.)
Right: 7.6 cm (3.0 in.)

{_-:.'? Note: Caster Base is required for High Capacity Feeder Tray configurations.
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Specifications

CONFIGURATION WITH OPTIONAL TRAYS AND PRINTER STAND
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Installation Space

e Width: 86.4 cm (34.0 in.)

e Depth: 113.8 cm (44.8 in.)
e Height: 125.7 cm (49.4in.)
Clearance

e Front: 40.6 cm (16.0in.)

e Rear:15.2cm (6.0in.)

e left: 7.6 cm (3.0in.)

e Right: 7.6 cm (3.0in.)
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Specifications

Environmental Specifications

TEMPERATURE

Operating: 10-32°C (50-90°F)

RELATIVE HUMIDITY

Operating: 15% — 80% (non-condensing)

ELEVATION

For optimum performance, use the printer at elevations below 2896 m (9500 ft.).
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Specifications

Electrical Specifications

POWER SUPPLY

VOLTAGE FREQUENCY CURRENT REQUIRED
65 prints per minute 100-110 VAC +/-10% 50Hz +/- 3 Hz 11.0A
60 Hz +/- 3 Hz
115-127 VAC +/-10% 50 Hz +/- 3 Hz 9.8 A
60 Hz +/- 3 Hz
220-240 VAC +/-10% 50 Hz +/- 3 Hz 49 A
60 Hz +/- 3 Hz
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Specifications

Performance Specifications

PRINTING RESOLUTION

Maximum Resolution: 1200 x 1200 dpi

PRINT SPEED

Xerox reports maximum speed for continuous printing using short-edge feed on 75 g/m2 paper from any tray:
e 61 ppm for A4 (210 x 297 mm, 8.27 x 11.69in.)

e 65 ppm for Letter (216 x 279 mm, 8.5x 11in.)

Several factors affect print speed:

e Paper orientation: Most paper sizes are loaded short-edge feed. For faster print speeds when using A5 (148 x
210 mm, 5.8 x 8.3 in.), load the paper long-edge feed.

e Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the faster print speeds.
o Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.
o Paper type: Plain prints faster than any other media type.

You can achieve the rated print speed when you print on Plain, Letter or A4 paper, using short-edge feed. The print
speed can be significantly slower when you print on narrow media, such as:

e Envelopes that are less than 210 mm wide, when an A4 fuser is installed

e Envelopes that are less than 216 mm wide, when a Letter fuser is installed.
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Specifications

Environmental, Health and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact:
e United States and Canada, only: 1-800-ASK-XEROX (1-800-275-9376)

e Web address: Environmental Health & Sustainability - Xerox

e Email request (world-wide): EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.
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Regulatory Information

This appendix contains:

BASIC REGUIAEIONS .. e e e et 236
SAfEtY GOt ICALION. ...ttt e 243
Material Safety DAta SNEETS ... ... 244
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to
mitigate interference caused or received by this printer in a typical office environment.

Changes or modifications to this device not specifically approved by Xerox® Corporation can void the authority of
the user to operate this equipment.

UNITED STATES FCC REGULATIONS

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15
of the Federal Communications Commission (FCC) Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy. If the equipment is not installed and used in accordance
with the instruction manual, it may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference. Users are required to correct the interference
at their own expense.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate
this equipment.

To maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with
non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception.

Warning: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Xerox® VersaLink® B620 Printers

Xerox® VersalLink® B620 Printers comply with Part 15 of the FCC rules. Operation is subject to the following two
conditions:

e The devices are not used to cause harmful interference.

e The devices must accept any interference received, including any interference that can cause an undesired
operation.

Responsible Party: Xerox Corporation
Address: 800 Phillips Road, Webster, NY 14580

Internet contact information: www.xerox.com/en-us/about/ehs.

REGULATORY INFORMATION FOR 2.4-GHZ AND 5-GHZ WIRELESS NETWORK ADAPTERS

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with the
requirements specified in FCC Part 15, Industry Canada RSS-210, and European Council Directive 2014/53/EU.
Radio Frequency (RF) output power of this device will not exceed 20 dBm in either frequency band.

Operation of this device is subject to the following two conditions:
1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may cause undesired operation.
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Regulatory Information

Changes or modifications to this device not specifically approved by the Xerox Corporation can void the authority of
the user to operate this equipment.

LASER NOTICE

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, Chapter I, Subchapter J for Class
I (1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC
60825-1: 2014.

Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is
never any human access to laser radiation above a Class I level during normal operation, user maintenance, or
prescribed service conditions. The printer has a non-serviceable printhead assembly that contains a laser with the
following specifications:

Class: I11b (3b) AlGaAs
Nominal output power (milliwatts): 25

Wavelength (nanometers): 755-800

CANADA
This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.
Cet appareil numérique de la classe A est conforme & la norme NMB-003 et NMB-001 du Canada.

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with the
requirements specified in Industry Canada RSS-210.

Ce produit contient un module émetteur radio LAN sans fil de 2,4 GHz et 5 GHz conforme aux exigences spécifiées
dans la réglementation Industrie du Canada RSS-210.

This device complies with Industry Canada’s licence-exempt RSSs. Operation is subject to the following two
conditions:

1. This device may not cause interference, and

2. This device must accept any interference, including interference that may cause undesired operation of the
device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence.
L’exploitation est autorisée aux deux conditions suivantes:

1. lU'appareil ne doit pas produire de brouillage, et

2. l'utilisateur de 'appareil doit accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible
d’en compromettre le fonctionnement.

There are operational restrictions for License-Exempt Local Area Network (LE-LAN) devices: the device for operation
in the band 5150-5250 MHz is only for indoor use to reduce the potential for harmful interference to co-channel
mobile satellite systems.

Il'y a des restrictions opérationnelles pour dispositifs de réseaux locaux exempts de licence (RL-EL): les dispositifs
fonctionnant dans la bande 5 150-5 250 MHz sont réservés uniquement pour une utilisation & l'intérieur afin de
réduire les risques de brouillage préjudiciable aux systémes de satellites mobiles utilisant les mémes canaux.
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Regulatory Information

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and
your body.

Cet émetteur ne doit pas étre Co-placé ou ne fonctionnant en méme temps qu’aucune autre antenne ou émetteur.
Cet équipement devrait étre installé et actionné avec une distance minimum de 20 centimétres entre le radiateur et
votre corps.

EUROPEAN UNION AND EUROPEAN ECONOMIC AREA COMPLIANCE

c E The CE mark applied to this product indicates compliance to applicable EU Directives

The full text of the EU Declaration of Conformity is located at www.xerox.com/en-us/about/ehs.

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module.
Radio Frequency (RF) output power of this device will not exceed 20 dBm in either frequency band.

Hereby, Xerox declares that the radio equipment model Versalink® B620 and C620 Printers are in compliance with
Directive 2014/53/EU.

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the
environment.

Warning:

e Changes or modifications to this equipment not specifically approved by the Xerox Corporation may
void the user's authority to operate this equipment.

e External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the
operation of this Xerox device. If external radiation from ISM equipment interferes with this device,
contact your Xerox representative for assistance.

e Thisis aclass A product. In a domestic environment, this product can cause radio frequency
interference, in which case the user can be required to take adequate measures.

e To ensure compliance with European Union regulations, use shielded interface cables.

European Union Lot 4 Imaging Equipment Agreement

Xerox® has agreed to design criteria for energy efficiency and environmental performance of our products that are
in scope of the European Union (EU) Energy Related Products Directive, specifically the Lot 4 - Imaging Equipment.

In scope products include Household and Office equipment that meet the following criteria:
e Standard monochrome format products with a maximum speed less than 66 A4 images per minute.

e Standard color format products with a maximum speed less than 51 A4 images per minute.
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TO LEARN MORE ABOUT GOTO

e Power Consumption and Activation Times | User Documentation or Systems Administrators Guide

 Default Energy Saver Settings www.xerox.com/office/VLB620docs

e Benefits of purchasing ENERGY STAR® www.energystar.gov
qualified products

 Environmental Benefits of Duplex Printing | Www.xerox.com/en-us/about/ehs

e Benefits of using lighter paper weights (60
g/m2) and Recyclability

e Cartridge disposal and treatment

e Xerox participation in sustainability
initiatives

European Union Lot 19 Ecodesign Directive

Per European Commission Ecodesign Directive, the light source contained within this product or its components is
intended to be used for Image Capture or Image Projection only, and is not intended for use in other applications.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and
purchase of energy-efficient models, which help to reduce environmental impact. Details on
the ENERGY STAR program and models qualified to ENERGY STAR can be found at the
following website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States,
European Union, Japanese governments, and the office equipment industry to promote
energy-efficient copiers, printers, fax, multifunction printers, personal computers, and
monitors. Reducing product energy consumption helps combat smog, acid rain, and long-
term changes to the climate by decreasing the emissions that result from generating
electricity.

For more information on energy or other related topics, go to www.xerox.com/environment or www.xerox.com/
environment_europe.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed
and configured to enable you to reduce your electricity usage.

To reduce energy consumption, your device is configured to use Energy Saver modes. After the last print, the device
transitions to Ready mode. In Ready mode, the device can print again immediately. If the device is not used for a
specified period, the device transitions to Sleep mode. To reduce power consumption, only essential functions
remain active in Sleep mode. The device takes longer to produce the first print after it exits Sleep Mode, than it
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Regulatory Information

takes to print in Ready mode. This delay is the result of the printer that wakes up and is typical of most imaging
devices on the market.

To save power, you can configure Energy Saver modes. The following options are available:

e Job Activated: The device wakes when it detects activity. To set the delay before the device enters Sleep Mode,
enter the number of minutes.

¢ Sleep and wake up at scheduled times: The device wakes and sleeps according to a schedule that you
specify.

o Auto Power Off: To allow the device to power off after a period of time in Sleep Mode, select Auto Power Off.
To set the delay before the printer powers off from the Sleep Mode setting, enter the number of hours.

To change the Energy Saver mode settings, refer to the User Guide at www.xerox.com/office/VLB620docs. For
further assistance, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System Administrator
Guide at www.xerox.com/office/VLB620docs.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/environment or www.
xerox.com/environment_europe.

{-:'-"' Note: Changing the default Energy Saver activation times can result in an overall higher energy consumption
of the device. Before you turn off Energy Saver modes or set a long activation time, consider the increase in
device power consumption.

Default Energy Saver Settings

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging Equipment. The
transition time from Ready mode to Sleep mode can be set from 0-60 or 0-120 minutes, depending on the printer
model. The default value is set to 0 minutes. The maximum transition time from Ready mode to Sleep mode can
take up to 120 minutes, depending on the printer model and system configuration.

To change the Energy Saver settings, or enable Auto Standby capability, contact your system administrator or refer
to System Administrator Guide at www.xerox.com/office/VLB620docs.

EPEAT

This device is registered in the EPEAT directory for meeting the ecolabel properties. Included is the factory defaulted
Sleep mode enablement. In Sleep mode the printer uses less than 1 Watt of power.

To learn more about Xerox participation in sustainability initiatives, go to https://www.xerox.com/en-us/about/ehs or
www.xerox.co.uk/about-xerox/environment/engb.html.

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on
both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your
paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40
ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto enabled, during the
setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided
printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the
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Regulatory Information

environmental impact of your work. However, should you require simplex/1-sided printing, you may change the
print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship
scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m2), which contains
less raw material and thus saves resources per print, may be used in certain applications. We encourage you to
check if this is suitable for your printing needs.

EURASIAN ECONOMIC COMMUNITY CERTIFICATION

The EAC mark applied to this product indicates certification for use on the markets of the Member
States of the Customs Union.

GERMANY

Germany - Blue Angel

- RAL, the German Institute for Quality Assurance and Labeling, has awarded the
@ following configuration of this device the Blue Angel Environmental Label:
,ﬁ Network printer with automatic 2-sided printing and USB or network connectivity.

This label distinguishes it as a device that satisfies Blue Angel criteria for
environmental acceptability in terms of device design, manufacture, and operation.
For more information, go to www.blauer-engel.de.

Blendschutz

Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um
storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren
Gesichtsfeld platziert werden.

Ldrmemission

Maschinenlarminformations-Verordnung 3. GPSGV: Der hochste Schalldruckpegel betrdgt 70 dB(A) oder weniger
gemdp EN ISO 7779.

Importeur

Xerox GmbH
HellersbergstraBe 2-4
41460 Neuss
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Deutschland

TURKEY ROHS REGULATION
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”

UKRAINE ROHS COMPLIANCE

O6nagHaHHA BiANOBILAEBUMOraM TeXHIYHOMO PernameHTy LoJ0 OBMeKEHHS

BUKOPWCTCAHHS [lefAKnX Hebe3neuHux peYoBMH B €/1EKTPUUYHOMY TA €N1EKTPOHHOMY

obnaaHaHi, 3aTBepAXeHoro noctaHosoto KabiHeTy MiHicTpis Ykpainu Big 3 rpyaHa 2008 Ne 1057

The equipment complies with requirements of the Technical Regulation, approved by the Resolution of Cabinet of
Ministry of Ukraine as of December 3, 2008, in terms of restrictions for the use of certain dangerous substances in
electrical and electronic equipment.
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Safety Certification

This device is compliant with IEC and EN product safety standards certified by a National Regulatory Test
Laboratory (NRTL).
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Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to:

e Web address: Xerox Safety Documents and Compliance Information
e United States and Canada, only: 1-800-ASK-XEROX (1-800-275-9376)

e Other markets, send an email request to: EHS-Europe@xerox.com
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Recycling and Disposal

This appendix contains:
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Recycling and Disposal

All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury,
perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The
presence of these materials is fully consistent with global regulations applicable at the time that the product was
placed on the market.

For recycling and disposal information, contact your local authorities.

Perchlorate Material: This product may contain one or more Perchlorate-containing devices, such as batteries.
Special handling may apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.

BATTERY REMOVAL

Batteries should only be replaced by a manufacturer-approved service facility.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-
XEROX) to determine if this Xerox product is part of the program.

For more information about Xerox environmental programs, visit www.xerox.com/environment.

For recycling and disposal information, contact your local authorities.
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Recycling and Disposal

European Union

b EE

_.-"'

, i y i3
[ — i

These symbols indicate that this product is not to be disposed of with your household waste, according to the
Waste Electrical and Electronic Equipment (WEEE) Directive (2012/19/EU), the Battery Directive (2006/66/EC) and
national legislation implementing those Directives.

If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery Directive, this
indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) is present in this battery or accumulator at
a concentration above an applicable threshold specified in the Battery Directive.

Some equipment may be used in both a domestic/household and a professional/business application. Private
households within European Union may return used electrical and electronic equipment to designated collection
facilities free of charge. For more information about collection and recycling of old products and batteries, contact
your local municipality, your waste disposal service or the point of sale where you purchased the items. In some
member states, when you purchase new equipment, your local retailer may be required to take back your old
equipment free of charge. For more information, contact your retailer.

Business Users in the European Union, in accordance with European legislation, end of life electrical and electronic
equipment subject to disposal must be managed within agreed procedures. If you wish to discard electrical and
electronic equipment, contact your dealer or supplier, local reseller or Xerox representative for end of life take-back
information prior to disposal.

Improper handling of this type of waste could have a possible impact on the environment and human health due
to potentially hazardous substances that are generally associated with EEE. Your cooperation in the correct disposal
of this product will contribute to the effective usage of natural resources.

DISPOSAL OUTSIDE OF THE EUROPEAN UNION

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local
authorities or dealer and ask for the correct method of disposal.
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Recycling and Disposal

Other Countries

Please contact your local waste management authority to request disposal guidance.
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This appendix contains:
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Apps Features

FEATURE

@

2-Sided Printing

DESCRIPTION

You can use the 2-sided options to set the device
to print one or both sides of a document. For
Print jobs, you can specify 1-sided or 2-sided
output.

PRINT FROM

v

iy

Collation

You can collate multiple-page print jobs
automatically. For example, when you are
making three 1-sided copies of a six-page
document, the copies are printed in this order:

1,2,3,4,56;1,2,3,4,56;1,2,3,4,5,6.

*

Quantity

Use this option to enter the number of required
print copies.

Paper Supply

Use Paper Supply to specify the size, type and
color of the paper required, or the paper tray to
use. If Auto is selected, the printer chooses the
paper tray based on the original document size
and the selected settings.

Image Scale &

Image Scale & Placement allows you to modify

to adjust the image on the page automatically.

o
‘Ej; Placement the location of the image on the page. You can
shift the printed image along the X and Y axes
of each sheet of paper.
Auto Use Image Scale & Placement > Auto setting ,'|||"

BN

Fit to Page; Center;

Smart Rotate

Use Image Scale & Placement > Fit to Page;
Center; Smart Rotate setting to adjust the
image on the center of the page.

4

Fill Entire Page;
Center; Smart

Use Image Scale & Placement > Fill Entire
Page; Center; Smart Rotate setting to adjust

from Image Scale & Placement > More >
Center.

Rotate the image to fill the entire page.
reees Scale Image Access additional image adjustment settings '-."II
! from Image Scale & Placement > More >
Scale Image.
Center Access additional image adjustment settings ,.|||"

QO

Smart Rotate

Access additional image adjustment settings
from Image Scale & Placement > More >
Smart Rotate.
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